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Getting Started

Introduction
QuickScore Elite is software for composing music — a powerful and
integrated scoring and sequencing program together in one package.

There are eight different ways to view and edit your music, each contained
in a separate window.

• The Score Editor displays music and allows it to be edited in standard
music notation.

• The Piano Roll Editor displays music in piano roll format.
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• The Controller Editor lets you enter and edit continuous data like
controllers, tempo, note velocities and pitch bend.

• The Track Sheet is for naming, moving, deleting and editing tracks
and track parameters.

• The Mixer is for mixing tracks in real time, changing parameters like
volume, pan or pitch bend.

• The Event List allows you to see and edit all the musical events present
in your composition.

• The Song Editor displays an overview of your music as a string of
colored bars filled with notes and other musical data.

• The Comments Window allows you to insert your written notes about
each composition.

Each window can be moved and resized. All of these windows exist within
a frame window that is always visible, showing a control area with
tape recorder-style controls, the current song position, loop and punch -in
and punch-out times, as well as other settings which affect all of the
windows.

QuickScore Elite is compatible with all Windows sound cards and MIDI
interfaces. It reads and writes standard MIDI files and it will print high
quality music notation on all Windows compatible printers.
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About This Manual
This section describes how this manual is organized and explains the style
conventions used throughout the manual.

Manual Structure

This manual contains four principal sections:

• Getting Started — This section contains an overview of QuickScore
Elite, system requirements, installation and registration.

• Tutorials — This section provides a systematic way of learning to use
QuickScore Elite. You can also use the tutorials to quickly find out how
to accomplish common tasks.

• Reference — This section gives detailed information on all of
QuickScore Elite's windows and menu items.

• Appendices — This section gives information on system files, MIDI,
technical support, and troubleshooting.

Typographical Conventions

The following two sections explain the typographical conventions used in
the manual.

Keyboard Conventions

• A bold capital letter indicates a key on your keyboard.

• Example: P indicates the P key.

• ALL CAPITAL LETTERS IN BOLD TYPE  indicate special keys on
the computer’s keyboard.

• Examples: HOME, ENTER, PAGE UP, ALT, ESC, F12.
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• A key combination is when two or more keys are used in combination
with each other. This is indicated with a + (plus) between the keys to be
used in combination.

• Example 1: SHIFT+U means press and hold down the SHIFT
key while you press the U key.

• Example 2: CTRL+X means press and hold down the CTRL
key while you press the X key.

• Example 3: ALT+SHIFT+Y means press and hold down the
ALT key while you press and hold down the SHIFT key while
you press the Y key.

• Bold type, which is enclosed in quotation marks and is immediately
preceded by the word “type”, denotes anything that you must type
exactly as it appears. (Do not type the quotation marks.)

• Example: Type “a:install”.

General Conventions

• Initial Capital Letters denote names of items within the program such
as windows, menus, menu items, dialog boxes, and buttons, etc. They
also denote names of things outside the program.

• Examples: Piano Roll Editor, Play Score button, File menu,
Windows.

• Bold type denote a selection which must be made from a menu, dialog
box, etc. Bold type is also used to emphasize certain items.

• Example 1: Click on the Yes button.

• Example 2: Select the Record Options menu item.

• Example 3: Choose the pencil tool.

• ALL CAPITAL LETTERS denote the name of a file or directory.

• Example 1: CANYON.MID denotes the name of a file.

• Example 2: QSEWIN denotes the name of a directory.

• Italics indicate the title of a book or magazine. Italics are also used to
emphasize certain words.

• Example 1: Windows User's Guide.

• Example 2: Read this carefully.
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System Requirements
QuickScore Elite requires a 33 MHz 386 or faster Windows compatible
computer and a minimum of 4 megabytes of RAM to operate. A
33 MHz 486 or faster machine with 8 megabytes of RAM is recommended.
Windows 3.1 or greater is required.

Installation
QuickScore Elite comes on two floppy disks. To install QuickScore Elite,
put the first disk into your disk drive, make sure Windows is running and
select Run from the Windows Program Manager File menu.

• Type “a:install” if your floppy disk is in drive A.

• Type “b:install” if your floppy disk is in drive B.

Press ENTER. QuickScore Elite will now install itself onto your machine.

When QuickScore Elite installs itself, you will be asked a number of
questions. In most all cases, the answer should be obvious.

When the installer starts, you are given the choice to install QuickScore
Elite or not. Make sure Install QuickScore Elite  is selected and click on
the OK button.

Answer Yes to “Do you wish to install the QuickScore Demo .QSD
files?” if this is the first time that you are installing QuickScore Elite. If
you've already installed these files to the directory in which you are now
installing QuickScore Elite, you can answer No if you like.

Next you must select the drive onto which you wish to install QuickScore
Elite. Normally you will choose one of your fixed drives. Usually this is
drive C. You need at least 5.0 megabytes free on the drive on which you
want to install QuickScore Elite. When you've selected the drive you want,
click on OK.

Choose the installation directory for QuickScore Elite. This is where
QuickScore Elite will put all its files. If you don't like the default QSEWIN,
you can type in a different directory.

The installer will next check to see if you have already installed QuickScore
Elite to the directory you specified. If it detects a prior installation you will
be asked if you want to proceed. Note that the settings for the last
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installation of QuickScore Elite (MIDI setup, Metronome settings, etc.) will
be conserved if you proceed.

If you go ahead, QuickScore Elite will proceed to install itself in your
installation directory.

Next you are advised that QuickScore Elite needs the Mozart TrueType
font. If you already have this font on your system (probably because you
installed a previous version of QuickScore), you can reply No. You can also
reply No if you want to install the font yourself from Windows. The Mozart
font is in the file MOZART.TTF in the installation directory. If you want to
install the font yourself, see the section on installing fonts in your Windows
User's Guide.

Finally you are asked if you want to create a program group for QuickScore
Elite. Normally you will reply Yes. You can reply No if you already have a
program group for QuickScore Elite that is properly set up.

That's it! QuickScore Elite is now installed on your computer. Before you
quit the installation program, take a look at the readme file (click on Yes
when you are asked if you want to look at it) to see if there is anything that
is not in the manual that you should know about. You can print this file (it
is the file README.DOC in the directory in which you installed
QuickScore Elite) by loading it into the Windows Notepad and printing it
from there.

Registration
Make sure you fill out and send in your registration card. It is important
that you are in our database so that we can provide you with technical
assistance when you need it. If you haven't sent in your registration card, we
can only give you limited assistance in setting up QuickScore Elite. Sending
in your registration card will also help us know who you are so we can send
you information about product updates and special offers.
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Testing Your MIDI Setup
When you have installed QuickScore Elite, you should test that it will play
properly with your setup.

Start QuickScore Elite by double-clicking on the QuickScore Elite
program icon. Click on the File menu and choose Open. Double-click on
the file TEST.QSD to load this file. Press the SPACE BAR to play this
file.

If you hear music, all is well. If not, check that QuickScore Elite is using
the right MIDI driver. Click on the Options menu and choose MIDI Setup
Make sure MIDI out is set to the correct driver. If the driver you want is not
selected, select it by clicking in the drop-down list box and clicking on the
driver. Now try playing again.

If you don't hear music, maybe you haven't set up your computer properly to
play music. To check, close QuickScore Elite and load the Windows
Media Player. (It is in the Windows Accessories group.) Load a MIDI file.
(When you go to open a MIDI file, you will see CANYON.MID, which
comes with Windows.) Try playing this file with the Media Player by
clicking on the play button. If you hear sound, you know that your computer
is properly hooked up. If you don't, you must first set things up properly
before QuickScore Elite can work.

You must have an appropriate MIDI driver loaded on your system for your
MIDI interface or sound card. If you have a MIDI interface, make sure all
your connections are as they should be. Refer to the discussion of the
Control Panel in your Windows User's Guide for details on Windows MIDI
drivers.

Note: If you choose MIDI Mapper in the MIDI out list box in the
MIDI Setup dialog, you must make sure the MIDI Mapper is set up
correctly. Refer to the discussion of the MIDI  Mapper in your Windows
User's Guide for more details.
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Overview
This chapter provides a basic description of QuickScore Elite’s components
and how you use them.

Windows, Menus and All That

QuickScore Elite runs under Windows 3.1 or greater and follows the
conventions of Windows programs. For information beyond what is
provided in the next few sections regarding windows, menus, dialogs or any
other standard Windows Interface objects, check your Windows User's
Guide.

Windows
QuickScore Elite has a main window (technically called an MDI frame
window) and eight child windows inside the main window. When
QuickScore Elite first starts up, three of these windows are open, cascaded
on the top of the main window, and the other five windows are minimized
with an icon representing each along the bottom of the main window.

QuickScore Elite's main window has a control area at the top with buttons
and controls that affect all the child windows. At the bottom of the main
window is a status area where information about the current track, the title
of your composition and a description of menu operations is shown. Each of
QuickScore Elite's child windows, with the exception of the Track Sheet
and the Comments Window, also have a control area with controls that
affect that particular window.

You can bring up any of the minimized windows by double clicking on its
icon. You can make a window into an icon by clicking on the downward
pointing triangle at the top right-hand corner of the window (the minimize
button). You can make the main window fill the full screen by clicking on
the upward pointing triangle at the top right-hand corner of the window
(the maximize button). You can make a child window fill the main window
by clicking on its maximize button.

Move between QuickScore Elite's windows by clicking on the window you
want to move to. You can also move between windows by pressing
CTRL+TAB (Hold down the CTRL key and press the TAB key).
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Most of QuickScore Elite's windows have a horizontal scroll bar and a
vertical scroll bar on the right-hand side. The horizontal scroll bar is
used to move back and forth in time. The vertical scroll bar moves the
display up and down. The exception is the Event List, where the vertical
scroll bar moves back and forth in time. (There is no horizontal scroll bar in
the Event List.)

Menus

Along the top of QuickScore Elite's main window is the menu. You can
select an item from the menu by clicking the mouse on the name of the
menu you want to select from, and then clicking on the menu item you
want from the menu that drops down. You can also select a menu by
holding down the ALT key and pressing the key that is underlined in the
menu name. When the menu drops down you can select a menu item by
clicking on the letter that is underlined in the menu item name. There are
also menu shortcut keys. These are written to the right in the menu item.
For example, you can press CTRL+N (Hold down the CTRL key and press
N) to select the New menu item under the File menu.

Sometimes clicking on menu items will bring up a submenu. You can tell
when this will happen if the menu item has a right-facing arrow at its right
edge. The submenu appears to the right of the menu when you click on the
menu item. You can select items from the submenu just as you selected
items from the menu.

If a menu item has three dots after the description, you know that clicking
on the menu item will bring up a dialog. If there are no dots, selecting the
menu item will cause an action to take place right away.

Print Preview in the File menu, all the items below the line in the Options
menu, and the three Lock options in the Window menu act as toggle
switches. When you select these items, a check will appear on the left-hand
side of the menu item to show that the option is enabled. If you select the
item again, the check disappears, indicating that the option is disabled.

One of the window names in the Window menu always has a check before
it. This means that this window is currently selected. You can select a new
window by clicking on its name in the Window menu.



10 Getting Started

Palettes
Palettes are groups of icons, one of which is selected. You select from a
palette by clicking on the icon in the palette that you want.

There is a toolbar palette in some of the editing windows, where you select
the tool that you will be using.

The Score Editor has an object type palette. When you click on the symbol
button in the object type palette, a symbol palette appears from which you
can select various symbols.

The Mouse
The mouse is your main tool when you use QuickScore Elite. You carry out
the following actions with the mouse:

• You position the mouse by moving it until the pointer rests on
whatever you want to point to on the screen.

• You click the mouse by pressing and releasing the mouse button
without moving the mouse.

• You double-click the mouse by pressing and releasing the mouse
button twice in quick succession.

• You drag the mouse by pressing down the button, moving the mouse
with the button held down and then releasing the button.

• You control-click by holding down the CTRL key and then clicking
the mouse on one or more objects while holding the CTRL key down.



Overview   11

When you have finished selecting objects with the mouse, release the
CTRL key. Control-clicking is used to select a group of non-contiguous
objects.

All of these operations can be done with the left or the right mouse button.
If not stated explicitly, assume that the left mouse button is implied.

Editing Tools

The Score Editor, the Piano Roll Editor and the Controller Editor each
have a palette of editing tools to the left in their control areas. To edit,
enter, delete or move around objects you need to select the correct tool. The
shape of the tool will give you some clue as to its function. Here is a brief
rundown of the functions of the most used editing tools:

• Use the arrow tool to select objects for editing.

• Use the pencil tool to enter objects.

• Use the eraser tool to delete objects.

• Use the tools with the arrows on them to move objects around.

Objects

QuickScore Elite lets you enter and edit a wide variety of objects (sometimes
called events). In the Score Editor you can enter and edit notes, lyrics,
expressions, text, symbols, and clefs. In the Score Editor you choose the
type of object you are dealing with by selecting it from the object type
palette in the control area. In the Piano Roll Editor, you edit notes
exclusively. In the Controller Editor, you can enter and edit continuous
controllers, pitch bend, aftertouch, note velocity, program changes and
tempo changes. In the Event List you can edit all of QuickScore Elite's
objects. In the Controller Editor and the Event List you select the type of
object you want to edit using the data type list box at the far left in the
control area.
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Entering Objects
You can enter objects in the Score Editor, the Controller Editor and the
Piano Roll Editor. Make sure you have the pencil tool selected and then
click the mouse on the window where you want to enter an object. (Use the
object type palette in the Score Editor or the data type list box in the
Controller Editor to select the kind of object you will be entering.) In the
Score Editor and the Piano Roll Editor you can drag an object around with
the mouse as you enter it to make sure of its proper positioning. In the
Controller Editor, dragging the mouse while entering objects will enter a
group of objects, each set at the position of the mouse as you dragged. The
exception is when entering note velocity. You cannot actually enter new
note velocities, so dragging across existing velocities will only set them to
the height of the mouse.

If you have the arrow tool selected you can use the right mouse button to
enter objects. In the Controller Editor and the Piano Roll Editor, this works
the same as when you use the left mouse button with the pencil tool
selected. In the Score Editor, a note or other object is entered at the cursor
position at the height of the mouse and the cursor is advanced.

Selecting Objects
You can select objects in the Score Editor, the Controller Editor, the Piano
Roll Editor, the Event List and the Song Editor.

• Select a single object by double-clicking on the object.

• Select a contiguous group of objects by dragging the mouse from the
first object to the last object.

• Select a non-contiguous group of objects by control-clicking the
mouse, clicking on the objects that you want to include in your
selection. (You control-click by holding down the CTRL key and then
clicking the mouse on one or more objects while holding the CTRL key
down. When you have finished selecting objects with the mouse, release
the CTRL key.)

When you have selected the object or objects you want, a menu will drop
down to let you edit them.

Note: Double-clicking only works in the Score Editor, the Controller Editor,
the Piano Roll Editor, and the Event List. Control-clicking only works in
the Score Editor, the Controller Editor and the Piano Roll Editor.
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The Cursor

The Score Editor, the Piano Roll Editor, the Controller Editor, and the
Song Editor each have a cursor. The Event List has an implied cursor
which is on the first event in the Event List window.

The cursor point is where notes are entered in step time using the mouse or
the keyboard. It is the point where objects are pasted when you select Paste
from the Edit menu. It is also the point where recording will start.

The time of the cursor is displayed in the time display in the middle of the
main control area. The track that the cursor is on is displayed at the
bottom of the main window in the status area at the left.

You can move the cursor by clicking the mouse in an editing window, by
moving a horizontal scroll bar to change the display time, by clicking on the
time display in the main control area or by changing the track. You can also
move the cursor using the keyboard. See page  78, page 99, page 108,
page 115, and page 127 for details.

In the Score Editor, the cursor appears as a vertical line across the staff with
ledger lines above and below it. In the Piano Roll Editor and the Controller
Editor, the cursor appears as a vertical magenta line across the window. In
the Song Editor, the cursor appears as a box around the current bar.

You can lock cursors and lock tracks by setting the Lock Cursors and
Lock Tracks options in the Window menu. When you do this, moving to a
new time or track in one window will move all the others to the same time
or track. This is handy for looking at the same music with the different
views provided by different editors.

The Duration Value

The duration value is used for the duration of notes entered with the mouse
or in step entry. It is also the amount the cursor will move forward or
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backward in the Score Editor and the Piano Roll Editor when you press
the arrow keys or use step entry. If you click somewhere in the Score Editor
or the Piano Roll Editor, the mouse will always move to a multiple of the
duration value. You can make the mouse move the cursor freely in the
Piano Roll Editor by setting the Snap/Free button below the toolbar to
Free.

The duration value is chosen from the durations palette at the right-hand
side in the main control area. Click on a duration value to select it. The
duration value qualifier is set at the right of the durations palette. This can
be set to duple, triple or dotted.

Display Quantization

The display quantization affects how notes are displayed in the Score
Editor. You have to set the display quantization to something as small as or
smaller than the smallest duration you are trying to display.

When notes are displayed quantized to a certain value, the start time for the
note is displayed as a multiple of the quantization value and the duration of
the note is displayed as a multiple of the quantization value. When display
quantization is set to 64th, the start times and durations of the notes will be
multiples of 64th notes.

The display quantization can be set from the Display Bar, Display Track or
the Display Score dialog, available from the Display menu. If you are
displaying non-quantized music, you may have to experiment to find the
most appropriate display quantization. If you are displaying quantized
music, then you can use a very small display quantization value.
Triplet/32nds is usually a good choice, as triplets and duplets as small as
32nds will be displayed together correctly. If you want to display triplets ,
make sure you choose a triplet quantization value.
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Step Entry

Step entry can be done in the Score Editor or the Piano Roll Editor. To
enable step entry, click on the step entry icon (the little piano) to select it.
Now notes you play on your MIDI keyboard will be entered into QuickScore
Elite's active window at the cursor point. The duration  of the notes entered
is the duration value set in the durations palette. After a note is entered
using step entry, the cursor moves ahead by the duration value. Step entry
always merges the entered note with the notes already in your track. You
can step enter a chord, by playing the chord on your MIDI keyboard. Make
sure you play the notes all at the same time and then wait a half second or
so to play the next note or chord, so that successive notes or chords do not
end up at the same time. (QuickScore Elite needs a gap between notes to
distinguish them from imperfectly played chords.)

Playing and Recording

You play and record using the tape recorder-style buttons in the middle of
the main control area.

• The black triangle on the left is used to start play.

Play always starts from the beginning of the currently selected
window. A shortcut for using the play button is pressing the
SPACE BAR.

• The black square is used to stop play or recording.

Pressing the SPACE BAR while the music is playing is equivalent
to pressing the stop button.

• The button with the two black vertical lines is the pause button.

• The red circle is the record button.

Recording always starts from the cursor position in the active
window. (This is always shown in the time display in the main
control area.) When recording, there will be a count-in, set from
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the Metronome dialog under the Options menu. The metronome
can be on or off and the metronome sound can be controlled using
the Metronome dialog. When you record in a track, the recorded
data is normally merged with the data currently on the track. This
is not the case, however, when punch-in/punch-out is selected. In
this case, only the music between the punch points are affected,
and the old music is replaced by the new music. (The old music is
not merged with the new music.)
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Tutorials

Starting Out
This tutorial will introduce you to QuickScore Elite and show you how to
load files, enter and change notes in the Score Editor and change
parameters in the Track Sheet.

Starting QuickScore Elite

Start up QuickScore Elite by double-clicking on its program icon.

QuickScore Elite will appear on the screen. Inside the main window with its
controls are three windows cascaded one on top of the other. The Score
Editor is the topmost of these three windows. On the bottom of the main
window are five more windows, which appear as icons.
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We will be working with the Score Editor at first, so let's maximize it.
Click on the button in the top right-hand corner of the Score Editor's
window with the triangle pointing up (the maximize button). Now the Score
Editor will fill the screen. The Score Editor lets you enter and edit music in
standard music notation.

Entering Notes With the Mouse

Let's start by entering a few notes. Select the pencil icon from the Score
Editor's toolbar by clicking on it.

Now click the mouse once around the first beat of the first bar. You can
tell where the mouse is in time by the mouse time locator in the control
area of the Score Editor. As you move the mouse, the time will change.
When the time reads 1:1:0, this means the mouse is on the first bar, on the
first beat and on the 0th (first) step. A quarter note should appear where
you click the mouse. Move the mouse a little further along on the staff.
Check that the time reads close to 1:2:0 (close to the start of the second
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beat). It doesn't have to be exact. Click the mouse again and another
quarter note will appear close to where you clicked it.

We have been entering quarter notes, but now let's try entering some eighth
notes. To do this you need to change the duration value in the durations
palette in the main control area. Click on the eighth note to select it
instead of the quarter note.

Now move the cursor near the middle of the first bar so the mouse time
locator reads close to 1:3:0 and click in an eighth note. Move over half a
beat or so so that the mouse time locator reads close to 1:3:48 and put in
another note. You should now have two eighth notes in the third beat of bar
one.

Moving Music with the TAB Key

If you don't like where a note appears on the screen, you can move it with
the TAB key. Click the right mouse button on the note to put the cursor on
top of it. The cursor appears as a vertical line across the staff with ledger
lines above and below it. Press the TAB key to move the note forward. Hold
down the SHIFT key and press the TAB key again and the note will move
back to where it was before. Note that all notes after the cursor will move
back and forth by the duration value set in the durations palette when you
press TAB and SHIFT+TAB.

Step Entry

Now let's try to enter some notes from your MIDI keyboard. (If you don't
have a MIDI keyboard attached to your computer, you can skip this part.)
Select the step entry icon (the little piano icon, third from the right, in the
main control area) by clicking on it.

Now move the cursor to the first beat of the second bar. You can do this by
clicking the right mouse button at the start of this bar or by moving the
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cursor with the left and right arrow keys. Let's enter some sixteenth notes,
so click on the sixteenth note in the durations palette to set the duration
value to sixteenths. Now play four notes one at a time on your keyboard.
The four notes you played will appear as sixteenth notes on the first beat of
the second measure. After each note is entered, the cursor moves over by a
sixteenth note (the duration value) so you can enter another note.

Now press the SPACE BAR to play your piece. You can also play the piece
by clicking on the play button in the main control area.

Moving Notes Around

Chances are you aren't completely satisfied with your piece just yet. Let's
change some of the notes so they sound a little better. To do this select the
NSEW tool (the one with the four arrows) from the toolbar.

Now click on a note and drag it around (hold the left mouse button down on
the note, move the mouse and then release the button). You can drag it up
and down to change its pitch or back and forth to move it around in time.
Try changing a few notes this way. You can also use the other tools with
arrows on them (the NS and the EW tools) to move notes. The NS tool
moves notes up and down in pitch and the EW tool moves notes back and
forth in time.

Saving Your Work

Now let's save your work to a file. Click on the File menu and select the
Save menu item. Let's call this file MYFILE.QSD. Type “ myfile.qsd” in
the file name box and press OK. The first time you save a file you are
always asked to name the file. Afterwards the file is automatically saved
under the name you last saved it. If you don't save your work it will be lost
when you quit QuickScore Elite or when you load a new file. Now that
you've saved your work you can come back and work on it later.
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Loading a New File

Let's load in a file that was already created. Click on the File menu and
select the Open menu item. Select the file BRAND41.QSD.

You can select it by clicking on its name and then clicking on OK, or by
double-clicking on its name.

Playing

When this file loads, let's play it to hear what it sounds like. (Press the
SPACE BAR or click on the play button.) As the file plays the display will
scroll by, letting you see what the music looks like. You can stop playing by
pressing the SPACE BAR again or by clicking on the stop button in the
main control area.

While you play, you can look at the music in different windows. Choose a
different window if you like by clicking on the Window menu and choosing
the window you want by clicking on the window's name in the Window
menu. You can also change windows by pressing CTRL+TAB (holding
down the CTRL key and pressing TAB) or by unmaximizing the Score
Editor window by clicking on the maximize button in the top right-hand
corner of the window and then clicking on another window. If you want to
open a window that appears as an icon at the bottom of QuickScore Elite's
main window, double click on it.
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The Track Sheet

When you have finished playing, bring up the Track Sheet by double
clicking on its icon at the bottom of the main window or by selecting it from
the Window menu. In the Track Sheet, you can change some global settings
for your tracks. You can name tracks, mute or solo them when you play, and
change the channel and the initial program change and volume.

Changing Programs

Let's change the programs to something interesting. Click on the Program
for track one and select something new. Press the HOME key to move
back to the beginning of the piece and try playing again to see what your
new program sounds like.

When QuickScore Elite first starts, the program names are set for General
MIDI instruments. If you have a General MIDI synth or sound card the
sound you get should sound like its General MIDI description. If yours is
not a General MIDI instrument, the names won't correspond to the sounds
in your instrument. You can change the program names by choosing Patch
Lists from the Options menu and selecting a patch list for your instrument.
If your instrument isn't in here, you can make up a patch list for it. See
“Patch Lists” on page 204 and “PATCHES.INI” on page 217 for details.
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Setting the Volume

Now let’s set the volume for all the tracks to a low value Let’s try  50. Press
the HOME key and the SPACE BAR to hear the effect. Try setting the
volume to 127 (the maximum) and listen to the difference.

Conclusion

Feel free to look at the menus and at the other windows. Browse through
some of the files that are included with QuickScore Elite and look at some
MIDI files of your own, if you have any. (If you want to open MIDI files ,
select MIDI file in the List Type of the File drop-down list box at the
bottom of the Open File dialog box. If you want to open QuickScore Elite's
native files, select QSD file in this list box.) After you've opened a file or
saved it, its name appears at the bottom of the File menu. You can quickly
open this file again by clicking on its name.

When you want to leave QuickScore Elite, select Exit from the File menu.
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Score Editor Tutorial - Notes and
Formatting
In this tutorial, we will enter some music in a file that has already been
created, edit the music and then use some of QuickScore Elite's formatting
features to change the way the music appears on the page.

To start, load QuickScore Elite and load the file FUGUE10.QSD by clicking
on the File menu, selecting the Open menu item and then double-clicking
on FUGUE10.QSD in the file window. This piece is Fugue 10 from the
Well-Tempered Clavier by J. S. Bach.

Let's start by maximizing the Score Editor. Click on the button in the top
right-hand corner of the Score Editor's window with the triangle pointing
up (the maximize button). Now the Score Editor will fill the screen.

Print Preview Mode

To see the titles for the piece, click on the page icon in the Score Editor's
control area.

You now see the piece as it would appear when it is printed. This is called
Print Preview mode. You can't edit when you are in Print Preview mode.
Click on the 100% icon beside the page icon and the whole page will
exactly fit the window.
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You probably won't be able to see each individual note (the display will be
greeked) but you can see the complete layout of the page. You can scroll
through the piece or play the piece in this mode.
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Moving with the Scroll Bar

Let's go back to Edit mode. Click on the page icon again to do this. Now
we are going to move to bar 79 to do some note entry on this bar. Click on
the scroll box in the horizontal scroll bar at the bottom of the window and
drag it along the scroll bar by keeping the button down and moving the
mouse. As the scroll box is dragged, the time display in the main control
area will change, reflecting the time of the bar the scroll box is on. When
the time display reads 79:1:0 release the mouse button. The display now
shows bar 78 and bar 79.

(The bar numbers in the score display are one less than what the time
display shows. This is because in the piece the first bar is a pickup bar and
bar numbering has been set to start at the second bar.)
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Erasing a Block of Music

We are now going to erase the music in the top staff of bar 79 and reenter
it again to get an idea of entering music with two different voices on the
same staff. To erase the music, click the mouse on the top staff at the
middle bar line. Hold the mouse button down and drag the mouse to a
point after the last note in the bar. Release the mouse button. Now the
music you dragged over with the mouse should be highlighted in reverse
video and an edit menu should drop down.

Select Cut [Note] from the menu. The highlighted music should disappear.

Using Undo

You can undo your last edit by clicking on the Edit menu and clicking on
Undo. Give it a try even if you cut out the bar exactly the way you wanted
to. Now select Undo again from the Edit menu. Your notes should be
erased again. The undo feature is extremely useful if you make mistakes or
you just want to see what things look like before and after doing an edit. If
you didn't properly erase your music, you can click on Undo again and try it
again.
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Entering Music with Different Voices

Now we are going to put the music back in by hand to get an idea of how
this is done. We’ll start by selecting the voice. The voice palette is to the far
right of the Score Editor's control area. It is initially set to Def. (meaning
the default voice), but you can change it to voice 1, voice 2 or grace notes.
Notes entered on voice 1 all have the stems pointing up. Notes entered on
voice 2 all have the stems pointing down. Grace notes are all small size
notes. We want to enter two separate voices in this bar, one with stems up,
the other with stems down, so we will enter them as voice  1 and voice 2. We
will enter the top voice first, so choose 1 (for voice 1, with stems up) from
the voice palette.

Entering Triplets

Before we start entering notes on voice  1, we want to set the duration value
to eighth note triplets because we will be entering triplets. Click on the
eighth note in the durations palette at the far left in the main control area
and then click on the duration qualifier button (the button with the two
eighth notes on it) to set it to triplets. There should be a group of triplet
eighth notes shown on the button now.

Step Entry

Finally, select the step entry icon (third from the right in the main control
area) by clicking on it.

OK, now we are ready to enter the first voice. If you have a MIDI keyboard
attached to your computer you can use step entry to enter the notes.
Otherwise you can enter them with the mouse. Step entry with the mouse is
similar to step entry with the keyboard. Instead of using the keyboard, you
click the right mouse button at the height you want the new note entered.
The only difference is that you can only enter notes in key with the right
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mouse so you have to change notes that need accidentals afterwards. We'll
go over step entry with the mouse first.

Move the cursor so it is exactly at the beginning of bar number  79. Make
sure the time display in the main control area reads 80:1:0. (Remember
that the time display does not match up with the numbering of the bars in
the score display because the piece starts numbering from bar  two. The first
bar is a pickup bar.) Now let's enter the notes. Move the mouse to the level
of the note you want to enter and click the right mouse button. Follow the
music shown in the graphic on page 26 to put in B6, E5, G5, and C6. Move
the cursor with the RIGHT ARROW key four spaces and put in A5 and
D6. If you are step entering using the keyboard instead of the right mouse
button, you can enter C#6 and D#6. Otherwise you will have to change
these notes.

Changing a Note’s Pitch

To change the C6 to a C#, select the NS tool (the one with the up and down
arrows) from the toolbar. Click on the C6 with the left mouse button and
keep the button down. Now press the UP ARROW. The note will be raised
to a C#. Release the mouse button. Click on the D6 with the left mouse
button and keep the button down. Now press the UP ARROW. The note
will be raised to a D#. Release the mouse button.

All the notes we entered are still eighth note triplets. We have to put in their
real durations. Do this in one shot by selecting all the notes you entered (do
this the same way you did to erase the notes earlier) and choosing Make
Legato from the edit menu that appears. Now all the notes will be extended
to the beginning of the next note.

Let's put in the second voice now. Select voice 2 by clicking on the 2 in the
voice palette at the far right on the Score Editor’s control area. We only
have two notes to put in. Move the cursor back to the beginning of the bar
and press the RIGHT ARROW key once to move over by one triplet eighth
note. Now change the duration value to a half note, because we are going
to put in two half notes. Click the right mouse on E5 and then F5. If you are
using the keyboard, play these notes on the keyboard instead.

If all went well, you've put the notes back the way they were before you
erased them. Click on the step entry icon again to disable step entry for the
moment. This lets you play your keyboard without the notes ending up in
your piece. Of course when you want to step enter music again from the
keyboard, select the step entry icon again.
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Spacing Barlines and Notes

Now select the spacing tool. This is the last tool in the palette.

You use the spacing tool to move bar lines around and move notes around
on the page without affecting their position in time. If notes are on top of
each other or covering up other symbols, you can rearrange them with the
spacing tool. Move the mouse so that it is on top of the middle barline.
Click the left mouse button and hold it down. You should see the barline
selected. If you don't, try again with the mouse a little to the left or the
right. When you've grabbed the barline move it around with the mouse.
Release the mouse button and the music will respace itself with the barline
in its new place. Grab a note the same way you grabbed a barline. You can
move the note back and forth the same way, although you can't move the
note too far away from its original position. Remember that moving notes
with the spacing tool won’t affect the timing of the notes.

Moving Rests and Ties

Let's move some rests and ties up and down just to see how this works. You
do this using the Display Bar dialog. The Display Bar dialog is used for
making changes that will only affect one bar. Make sure the cursor is on
bar 79 and select Bar from the Display Menu. The title of the dialog should
read “Display Bar 80 Track 1”.
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Change the Rest Levels settings for voice 2 from 4 to 6. Change the Tie
Offsets for voice 2 from 0 to 2. Click on OK. Now you should see the
eighth note rest at the beginning of the bar shift down two spaces and the
ties for the notes in voice 2 also go down two spaces. In this case there is no
point doing this, but sometimes rests or ties are on top of other music or
symbols and it can be useful to move them. You can play with the levels of
rests and ties but when you're finished, put them back the way they were
and we'll go on to something else.

Now let's go back to Print Preview mode. Click on the page icon to do this.
Move back to the beginning of the piece by pressing the HOME key

Bar Numbers

Note that the first bar has no number above it and the first bar on the second
line is numbered 3, instead of 4. This is because the first bar is a pickup bar.
Let's look at the Bar Numbers dialog to see how this has been set up. Click
on the Display menu and select Numbers and then Bar from the submenu
that appears to the right of the menu. Note that bar numbers are shown on
every line, the first numbered bar is the second bar and the bar numbers
are displayed above the staff. You can experiment with changing these
settings if you like.
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Page Numbers

Let's look at how page numbers have been set up. Click on the Display
menu and select Numbers and then Page from the submenu that appear to
the right of the menu. Page numbers are displayed starting on page 1,
starting at number 1 and they are at the top right-hand corner or each
page. You can experiment with changing these settings if you like.

Titles

Now let's look at the titles. Click on the Display menu and select Titles and
then Score from the submenu that appear to the right of the menu. (We are
looking at the titles for the score, not for each individual part.) Note the
title which appears at the center of the page at the top, the composer which
appears at the right at the top and the footer which has been set at the right
of the page. There is nothing defined for the header or the copyright. You
can experiment with the titles if you like.

Indentation

Now let's look at some formatting options. Select Page from the Display
menu. This brings up the Display Page dialog. Note the indentation of the
first system is set to 10 spaces. (One space is about equal to half a character
width.) Change this value and watch how the indentation of the first system
on the first page changes.

Staff Spacing

Now let's change the staff spacing. Bring up the Staff Spacing dialog by
clicking on the Set Staff Spacing button. You can move the bottom staff
closer to the top staff by clicking the mouse on it and dragging it up and
down. When you press OK, you will see the effect on your score. When
you're finished dragging the staff around, you might want to set the staff
spacing back to the default by clicking on the Default Spacing button.
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Setting Up Braces

Now let's change the braces. Open the Braces dialog by clicking on the
Braces button in the Display Page dialog. Lets change the bracing style to a
bracket. Select track 1 and track 2 by dragging over the 1 and 2 in the
Track list box. They should be highlighted in blue. Now select the Bracket
from the Brace Type list box. Now you will see the curly brace in the
window replaced by a bracket. If you like what you have done, press OK
and the changes will show up in your score.

Display Quantization

Let's experiment with the display quantization, to show you how this affects
the score display. Note that you have duple 16th notes and triplet eighth
notes, sometimes both in the same bar. Click on the Display menu and
choose Score. The Display Score dialog is where parameters that affect the
whole piece can be changed. If you change something here and you set it to
something else before using the Display Bar dialog or the Display Track
dialog, the changes that you made before will be wiped out.

Note that the quantization is set to Triplet/32nds. This means that triplets
and duple values as small as 32nd notes can be displayed at the same time.
For fun let's set this to eighth notes and see what the display does. Click on
the Quantization Amount drop-down list box and select 8th. Click on OK.

That wasn't very nice, was it? Now the smallest resolution of notes you can
see is eighths, not what we want at all. Set the quantization back to
Triplet/32nd so we can get our notes back.

Using Engraver Spacing

There is one more thing that we will look at now in the Display Score
dialog. This is engraver spacing. Note that Use Engraver Spacing is set to
Yes, right now. Engraver spacing is used by the Score Editor to space music
so that it looks good visually. Without engraver spacing, spacing occurs by
time, rather than appearance. Crowding of music sometimes occurs, because
you always put music occupying the same amount of time into the same
amount of space. For example, eight thirty-second notes take up the same
amount of space as one quarter note. The thirty-second notes are crowded
together and the quarter note is all by itself. When you use engraver
spacing, you assign the amount of space notes of each duration take up. For
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example, you can have thirty-second notes taking up only half as much as
quarter notes. Your music will generally look better if you use engraver
spacing. Change Use Engraver Spacing to No and see how this affects the
appearance of the music. Afterwards, change it back to Yes.

Automatically Spacing Music

Finally, we are going to let QuickScore Elite respace our entire piece. Click
on the Display menu and choose Space Music. QuickScore Elite will
recalculate the bars per line and the positioning of bar lines automatically,
based on the density of the music. Note that the music spacing is set to 16,
which is the default. The display of notes shows how many 16th notes
would optimally be fitted onto one line. Let’s try spacing our piece a little
tighter. To do this, change the density of the music to  20 and click on OK.
Wait a few seconds while QuickScore Elite recalculates everything. Now
click on the 100% icon and go to the end of the piece by pressing the END
key. Now we have the piece on six pages, but the music doesn’t exactly fill
the last page. Let’s go back to the Space Music dialog and change the
density of the music to 16 again. Click on the OK button and wait a few
seconds while QuickScore Elite recalculates everything. Go to the end of the
piece by pressing the END key. This is page 8 and it is completely filled,
which is what we want to see.

Conclusion

This concludes the first score editing tutorial. The next tutorial will show
you how to deal with text, lyrics and symbols.
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Score Editor Tutorial - Text, Lyrics
and Symbols
The second score editing tutorial will show you how to enter and edit lyrics,
expressions, text, symbols and clefs.

To start, load QuickScore Elite and load the file SILENT.QSD by clicking
on the File menu, selecting the Open menu item and then double-clicking
on SILENT.QSD in the file window. This piece is Silent Night.

Let's start by maximizing the Score Editor. If you haven't already done so,
click on the button in the top right-hand corner of the Score Editor's
window with the triangle pointing up (the maximize button). Now the Score
Editor will fill the screen.

If you just finished the first score editing tutorial, you are probably still in
Print Preview mode. We want to be in Edit mode so make sure the page
button in the Score Editor’s control area is not highlighted.
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Deleting Lyrics

We'll start this tutorial by deleting the second line of text in bar three,
“Shep - herds quake”. We'll first select the L in the object type palette in
the Score Editor’s control area to put us in Lyric mode.

Select the arrow tool (the first tool) in the toolbar. Now we'll set the Lyric
Filter by clicking on the Edit menu and selecting the Lyric Filter menu
item. Put a check on Use Filter and then uncheck Lyric 1, Lyric 3 and
Lyric 4. We only want to edit Lyric 2.

Click on the OK button.
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Select all the notes in the third bar by dragging over them. Click the
mouse on the top staff at the beginning of the third bar. Hold the mouse
button down and drag the mouse to a point after the last note in the bar.
Release the mouse button. Now the music you dragged over with the mouse
should be highlighted in reverse video and an edit menu should drop down.

Select Cut [Lyric] from the menu. The second lyric line should disappear.

Entering Lyrics

Now let's reenter this line. Select Lyric 2 from the Lyric drop-down list
box at the far right of the Score Editor’s control area (click on the list box
and click on Lyric 2).

Select the pencil tool from the toolbar. Select the eighth note from the
durations palette in the main control area. Make sure the duration qualifier
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(to the right of the durations palette) is not showing a triplet. If you have a
triplet for the duration qualifier (left over from the last tutorial), press T
twice to set this back to a duple value. Click on the first note in bar three.

The lyric editing cursor should appear to let you enter the second lyric line
for the first note in bar three.

Type “Shep”. Now we want to move to the next note, but we want to put a
dash between this lyric and the next. We can move and put in a dash at the
same time by typing CTRL+- (dash). (Hold down the CTRL key and press
- (dash).) Now we have a dash between the first and second notes in the bar
and we are ready to type in the lyric for the second note. Type “ herds”.
Now press the TAB key to move to the next note without putting in a dash.
Type “quake”. Now select the arrow tool from the toolbar to stop entering
lyrics.

Spacing Lyrics Vertically

Let's change the vertical spacing for lyrics using the Lyric Positioning
dialog. Click on the Display menu, select Page and click on the Lyrics
button at the bottom of the dialog. Put a check mark in the Reposition
lyrics box and change the Lyric 1 position to 6 and leave the Spacing
number at 5. Click on OK. The lyrics will move up a couple of rows. (One
row is equal to half the distance between two staff lines or two ledger lines.)
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Editing Expression Text

Let's edit the “moderato” expression text in bar one. Click on the E in the
object type palette. Now you can edit expressions. Double-click at the
beginning of the “moderato” text. A box with a red arrow will appear to the
left of the text and a menu will drop down from the edit menu. Select Edit
from the drop down menu and a text editing dialog will appear.

Type “allegro” and click OK. The “moderato” expression text is changed
to “allegro”.
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Entering Block Text

Now let's put in two blocks of text and set the fonts for each of these blocks.
Click on the T in the object type palette to select Text mode. Select the
pencil tool from the toolbar. Click the mouse just below the second staff of
the first bar. A little box with a cursor inside it will appear.

Let’s make this box a bit bigger. Move the mouse over the bottom right-
hand corner of the box. The mouse pointer will change from a pencil to a
double-ended arrow at 45 degrees. Click and drag the end of the box to the
right and down. Let go of the mouse. Now the box should be a bit bigger.
You can change the shape of the text box in this way any time you want to
when you are editing text or entering text.

Now let's enter some text. Click inside the box and type “ Silent Night is a
Christmas carol.”.
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Now let's put in some text with a new text style. Click on the text type
drop-down list box and select the second text type. (This will probably have
the same font as the first text type, but don't worry about that for now.)

Now enter a box of text just under the second bar. Type “Franz Gruber
wrote Silent Night.” in the box. So far so good.

Changing Text Fonts

Now let's change the fonts for these pieces of text. Click on the Display
menu and select Page. Click on the Fonts button at the bottom of the
Display Page dialog. We want to change the fonts for Text  1 and Text 2.
First we'll do Text 1. Click on the button with the name of the font for
Text 1. Choose the font, the font style and point size for the Text 1 font.
Make it something interesting. Click on OK and do the same thing for
Text 2. Press on OK to get out of QuickScore Elite's Font dialog and OK
again to get out of the Display Page dialog. You'll see the new fonts for the
two text blocks you entered.

Moving Block Text

Let's move a text block around. Select the NSEW tool (the tool with the
four arrows on it) in the toolbar. Grab one of the text blocks by clicking the
left mouse button in the top left corner of the block and dragging the mouse
while holding down the mouse button. When you release the mouse button
the text is placed where you moved it.
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Entering Symbols

Let's put in a few symbols. Select the symbol in the object type palette.

The icon displays the last symbol that was selected. Click on it again and
the symbol palettes will drop down. You can select a symbol from ten
different symbol palettes. Let's select the upward fermata symbol. Click on
Marks in the upper left-hand corner of the Tools palette and then click on
the upward fermata in the lower left-hand corner of the Articulation
Marks palette that appears.

The fermata will replace the previous symbol in the symbol button in the
object type palette. Select the pencil tool from the toolbar. Click in a couple
of fermatas, one above the last note in the first bar and one above the last
note in the second bar.
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Entering a Slur

Now let's put in a slur. Let's select the slur symbol. Click on the symbol in
the object type palette, click on Adjust and select the slur symbol (the one
in the lower left-hand corner of the Adjustable palette that appears. The slur
will now appear in the symbol button in the object type palette. Let's put the
slur over the notes in the second bar on the first staff. Enter the slur by
clicking and dragging it from its starting point to its ending point. Then
adjust its shape by dragging around the three little triangles (control points)
and finally enter the slur by pressing ENTER. If you don't want to enter the
slur press ESC instead of ENTER.

Let's put in a piano dynamic mark. Select the piano symbol from the
Dynamics palette and click above the first staff at the beginning of the third
bar. The piano mark should appear.

Entering a Crescendo

Now we'll put in a crescendo going from just after the piano mark to the end
of the bar. Select the crescendo symbol from the Adjust symbol palette.
Enter the crescendo symbol by dragging it in as you did for the slur.
Reposition it by dragging the control points (the little diamonds) with the
mouse. When you have it the way you like, press ENTER. If you don't want
to put in the crescendo symbol press ESC instead of ENTER.
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Entering a Guitar Chord

Now let's put in a guitar chord at the beginning of bar  5. Click on the
horizontal scroll bar once at the right of the scroll box. The display will
move forward to bar 4. Bar 5 is the second bar displayed. Select the guitar
chord symbol from the Misc. symbols palette. Click the mouse above the
first staff at the first beat in bar 5. The Guitar Chords dialog will appear.

We will put in an F guitar chord, so select it from the chord name list box.
Scroll the box until you see F and click on F. The F chord will be displayed
on the grid in the dialog. Put an X in the Show Chord Name box. Now the
name of the chord (F) will appear above the grid. You can change the chord
name by clicking on the Set Chord Name button, but we don't have to do
that here. Click on OK to enter the chord.

Spacing Guitar Chords Vertically

Our guitar chord is a little low (it overlaps the note below it). Let's change
the guitar chord position by using the Guitar Chord Positioning dialog.
Click on the Display menu, select Page and click on the Guitar Chord
Position button. The entry position will affect all new guitar chords entered.
We want to reposition all the chords we entered (just one), so put a check in
the Reposition all chords box. Let's set the entry position to 6 rows above
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the staff instead of 4. Click on the 4 in the Rows above staff list box to
open it and select 6. Now click on OK. The guitar chord will be moved up
two rows and all future guitar chords you enter will be at this level.

Entering Clefs

Now let’s put in a few clef changes. This isn't very useful except as an
exercise, but we'll do it anyway. Click on the clef in the object type palette
to select it and click on it again to display the clef palette. Let's choose an
alto clef (the clef in the fifth position).

Make sure the pencil tool is selected in the toolbar and now we’ll put in the
alto clef. Let's enter it at the beginning of bar 5 on the lower staff. Click at
this point with the pencil tool and the clef will go in. Now all notes after the
clef will be drawn to reflect this clef. Let's make one more clef change.
Click on the clef symbol in the object type palette and select the bass clef.
Enter the bass clef at the beginning of bar 6. Now only bar 5 is written in
the alto clef.

Experiment with the tools available for clefs (the arrow, the pencil, the
eraser, and the EW tools) to move and edit clefs. You can change the
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duration value in the durations palette in the main control area to change
where you can enter or move the clefs.

Conclusion

You've seen an overview of most of the things you can do with the Score
Editor. For a detailed look at the Score Editor, see “ Score Editor” starting
on page 80 and “Block Editing Menus” starting on page 140.
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Setting Up For Sequencing
In the next group of tutorials we will go over the features of QuickScore
Elite's other editing windows and cover recording. You will see that you can
do a lot more than create good-looking scores with QuickScore Elite. We
will be using another piece by J. S. Bach, the two-part Invention number 13
from the Inventions and Sinfonias. The piece is in the file TUTOR13.QSD.

Start by opening the file TUTOR13.QSD. Click on the File menu, select
Open and double-click on TUTOR13.QSD in the file list box. We will set
up a few things in QuickScore Elite before we get going.

Locking Cursors and Tracks

First let's set the Lock Cursors and the Lock Tracks options to on. This
way, when we move to a certain place in one window, all the other windows
will also move to the same place. We can easily flip back and forth between
windows to see different views of the same music. Click on the Window
menu and select Lock Cursors, then click on the Window menu again and
select Lock Tracks.

Setting Programs

Press the SPACE BAR to hear a few bars of the piece play. If you have a
General MIDI instrument, you should hear a piano on track  1 and a cello on
track 2. If you don't hear these instruments playing, you should go to the
Track Sheet and change your programs to something like this.

When QuickScore Elite first starts, the program names are for General
MIDI instruments. If you have a General MIDI synth or sound card, the
sound you get should sound like its General MIDI description. If yours is
not a General MIDI instrument, the names won't correspond to the sounds
in your instrument. You can change the program names by choosing Patch
Lists from the Options menu and selecting a patch list for your instrument.
If your instrument isn't in here, you can make up a patch list for it. See
“Patch Lists” on page 204 and “PATCHES.INI” on page 217 for details.

It is really not important to properly set up your patch names before you go
on, so if you have an instrument without a patch list already in the Patch
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Lists dialog, you can continue with the tutorial. Just make sure your tracks
are playing some kind of sound.
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Piano Roll Editor Tutorial
This tutorial will acquaint you with the Piano Roll Editor. We want to start
by opening the file TUTOR13.QSD if it is not already open. Click on the
File menu, select Open and double-click on TUTOR13.QSD in the file list
box.

Select the Piano Roll Editor window. The Piano Roll Editor lets you edit
your music in piano roll notation. You see one track of music at a time.

The Piano Roll Editor’s control area has the following features:

• A toolbar.

• A track list box for changing from track to track.

• A channel list box showing the channel or channels being edited.

• A mouse time locator showing the time of the mouse.

• A mouse pitch locator showing the pitch of the mouse.

• A button to show waves or hide waves.

• An indicator letting you know whether you are currently editing waves
or editing notes.
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Below the control area is the piano roll display. Here you see your music in
piano roll notation.

• At the top of the display is the bar number indicator.

• To the left is a vertical piano keyboard to show you the pitches of
your notes.

• Notes appear in the note area as horizontal bars. The vertical position
of the bar indicates the pitch of the note. The beginning of the bar
shows the note's start time and the length of the bar shows the note's
duration.

• There is a cursor (the vertical purple line), where music is entered
using step entry or the right mouse button. This is also the point where
music, that has been cut or copied to the clipboard, will be pasted. The
cursor moves by clicking the mouse or by using the arrow keys.

You can add wave files to your piece using the Piano Roll Editor's wave
window. This area is just above the piano roll window. If the wave window
is not visible, click on the Show Waves button. Wave files appear in this
area as straight lines indicating the start time and duration of the wave file.
The name of the wave file is written above the line. You move between the
wave window and the piano roll window by clicking on one or the other.
The Edit Notes/Edit Waves indicator at the far right of the control area
will display Edit Notes if the piano roll window is active or Edit Waves if
the wave window is active.

As in the Score Editor, there is a horizontal scroll bar at the bottom of the
window and a vertical scroll bar at the right-hand side of the window. There
are also four magnifying glass icons in this window. You use these to
compress or expand the display. Click on the large magnifying glass on the
bottom to zoom in in time, and click on the small magnifying glass  on the
bottom to zoom out in time. Click on the magnifying glasses below the
vertical scroll bar to compress or expand the display vertically.

If you've been playing with the zoom icons, make sure that you are showing
two bars on the display and that the vertical size of notes is more than one
or two pixels.

Looping

We want to loop the first two bars in the piece. We do this by selecting the
loop control in the main control area and setting a loop start time and a
loop end time. Click on the loop button (this is the button with the looping
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red line) and then click on the time display to the right of the loop button.
This will bring up the Loop Times dialog where you can set the loop start
and end times. Set the loop From time to 1:1:0 and set the loop To time
to 3:1:0 and then press OK.

Press the HOME key and then the SPACE BAR to hear the first two bars
looping. Press the SPACE BAR again to stop playing.

Moving Notes Around

Now let's try some editing. First we'll drag some notes around. Let's set the
duration value to 32nds so that we can move notes around on 32nd note
boundaries. Click on the 32nd note in the durations palette in the main
control area. Select the EW tool from the toolbar. Grab a note and move it
around by clicking on the note, holding down the left mouse button and
dragging the mouse in time to where you want to put the note. Release the
left mouse button to enter the note at the point where you dragged it. Notice
that the note snaps to the nearest 32nd note boundary.

Using the Snap/Free Button

You can move notes around on single-step boundaries if you change the
Snap/Free button (below the toolbar) to Free. Right now this button reads
Snap. Click on it and it will change to Free. Now try dragging a note
around. You can put it anywhere in time you want.

Using Undo

Don't forget, you can undo any changes you make. You can choose Undo
from the Edit menu, or press U or CTRL+U. After you make an edit, you
can switch back and forth between the new version and the previous version
using Undo. Try this a few times, listening to the difference between the
two versions before you decide to keep the edit or go back to the previous
version.
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Changing Note Duration

Now let's change the durations of some notes. You do this with the
duration tool, the tool with the right-pointing arrow, second from the right
on the toolbar. Click on the duration tool. Now when you grab a note and
drag it, you lengthen it or shorten it instead of moving the note around in
time. We'll change the duration of notes in the second track, because this is
a cello part and we can hear the differences in note durations more easily
than in the first track, which is a piano track. Change to the second track by
clicking on the Track drop-down list box to the right of the toolbar in the
Piano Roll Editor’s control area and selecting Track 2. Grab the first note
with the mouse and lengthen it by dragging it to the right. Listen to how it
sounds. Undo it if you don't like it. The Snap/Free setting and the duration
value affect the way you can change durations. You can experiment with
these settings if you like. Try changing the durations of some other notes
and hearing what they sound like by pressing the SPACE BAR.

Changing Note Pitch

Now let's change some pitches. Select the NS tool (the one with the
connected up and down arrows to the left of the duration tool) and grab a
note. Drag it up and down to change its pitch. Press the SPACE BAR to
hear what you've done.

Entering Notes

Let's put in a few notes. Select the pencil tool (second from the left in the
toolbar) and click where you want to put in a note. The note is drawn with
the duration equal to the duration value you set in the durations palette in
the main control area. You can change this any time you want by clicking
on a new note value in the durations palette. Try some more notes. Be aware
that the note you enter doesn't get put in until you release the mouse button.
You can see exactly where the note will go before you release the button.

Editing a Contiguous Group of Notes

Now let's try some block editing in the Piano Roll Editor. Select the arrow
tool (the first tool in the toolbar) by clicking on it. Now let's select all the
notes in the first bar. The best way to do this is to click the mouse just



Piano Roll Editor Tutorial   53

before the barline and drag the mouse backwards to the start of the display
holding down the left mouse button. (It is easiest to select a note at the left
edge of the display by dragging from right to left instead of left to right,
because otherwise you would have to start with the mouse exactly at time
zero, which is tricky.) The notes you selected will now be highlighted in
gray and an edit menu will drop down. Let's select Octave and move all the
notes down an octave. Select Down 1 Octave from the submenu which
appears.

Editing a Non-Contiguous Group of Notes

Now let's try control-clicking to select some non-contiguous notes for
editing. Hold down the CTRL key and click on the first note and the third
note in the second bar. Release the CTRL key. The two notes you selected
will now be highlighted in gray and an edit menu will drop down. Let's
accent these notes by changing their velocities. Select Velocity from the edit
menu. A dialog box appears. Enter a value of 127 (the maximum) to make
these two notes sound loud. Press OK.
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Copying and Pasting

Finally, let's select all the notes in the first bar again and copy them. Select
the notes the same way you did earlier to change the octave. Instead of
choosing Octave to change the octave, select Copy. Now that we've put a
copy of these notes into the clipboard, we can paste it somewhere else
when we want to. Let's have these echo one beat after they are first played.
Put the cursor at the beginning of the second beat in bar one. Click on the
Edit menu and select Paste. The notes you just copied are now pasted
starting at the second beat in bar one, creating an echo effect.

Conclusion

If you like what you've done better than J. S. Bach's original, you can save
the file using the Save As option under the File menu. Choose a name
other than TUTOR13.QSD, otherwise you will write over the original file.
We need it for the next tutorial. For more details of the Piano Roll Editor,
see “Piano Roll Editor” starting on page 101.



Controller Editor Tutorial   55

Controller Editor Tutorial
This tutorial will acquaint you with the Controller Editor. We want to start
again, using the file TUTOR13.QSD, so let's load it again if you don’t
already have it loaded. Click on the File menu, select Open and double-
click on the TUTOR13.QSD entry in the file list box.

The Controller Editor can be used to edit all kinds of data of a continuous
nature, including controllers, pitch bend, aftertouch, note velocity, tempo
changes and program changes.

The Controller Editor’s control area has the following features:

• A data type list box.

• A track list box for changing from track to track.

• A channel list box showing the channel or channels being edited.

• A step list box for controlling the spacing between adjacent events.

• A display note list box (only for polyphonic aftertouch).

• A change note list box (only for polyphonic aftertouch).

• A toolbar.

• A mouse position locator showing the time and amplitude of the
mouse.

• An event position locator showing the time and amplitude of the event
closest to the mouse.

• A button to show notes or hide notes in the controller window.
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The Controller Editor’s window has the following features:

• Time is displayed on the horizontal axis.

• Amplitude is displayed on the vertical axis. The amplitude displayed
depends on the kind of data being displayed. For example, pitch bend
data has a range from -8192 to +8192 and controllers have a range of
0 to 127.

• Bar numbers are shown above the display.

• Beats are shown as gray vertical lines.

• Amplitude levels are shown as horizontal lines.

• Controllers or other data are displayed as vertical blue lines.

• Superimposed on the controller display is a piano roll display of the
notes in the current track. This can be turned off by clicking on the
Hide Notes button.

When we first select the Controller Editor, note velocities are displayed.
Each note is shown in piano roll notation and the velocities of the notes are
shown as vertical blue lines at the point the notes start. The height of the
blue lines represents the amplitude of the velocity.

Changing Note Velocity

Let's change the velocities of the third sixteenth note in the first two beats of
bar one. This will accent that note, giving a syncopated effect. Select the
NS tool from the toolbar. Move the mouse over the third sixteenth note in
beat one so that its velocity is highlighted in red. Now change the velocity
by holding the left mouse button down and dragging the mouse across the
blue line at the height you want the velocity to be. Let's set the velocity
to 96. Release the mouse button.

Now let's move the mouse over to the third sixteenth note in the second
beat. It should be highlighted in red. In the event position locator, the time
and amplitude of the highlighted event are shown. Now instead of using the
mouse to change the velocity, we will use the UP ARROW key. Press the
UP ARROW key until the amplitude of the event is 96. You can see the
amplitude change in the event position locator as well as in the window.
Play the notes on the screen by pressing P to see what affect the changes in
velocity have produced.
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Entering Volume Controllers

Now let's put in some volume controller changes . Click on the data type
list box (above the toolbar) and choose 7 Main Volume. This is continuous
controller number seven, which is generally assigned to main volume.
Select the pencil tool. We'll create a velocity curve by clicking the mouse
near the left edge of the screen and dragging the mouse to the right edge of
the screen while holding the left mouse button down, and then releasing the
mouse button. Draw in a curve starting with an amplitude of around 32,
swelling to around 112 and then fading back to 64. Press P to hear what this
sounds like.

Now let's try another way to enter a volume swell.

Erasing Controllers

You can erase the volume curve by selecting Undo from the Edit menu, but
just for the practice, we'll select the arrow tool (the first one) from the
toolbar and select all the volumes by clicking the left mouse button before
the first one, dragging the mouse while holding the mouse button down to a
point after the last one and then releasing the mouse button. From the edit
menu select Cut and your controllers will all disappear.

Interpolating

Now select the pencil tool again and enter a single controller near the
beginning of the screen with a value of 32. Put in another one at the start
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of bar 2 with a value of 96. Put in a third at the right side of the screen
with a value of 32.

Select the arrow tool. Position the arrow a little to the left of the first
controller. Press and hold down the left mouse button and drag the mouse
to the right of the second controller . Both controllers should be
highlighted in red. Release the mouse button. and an edit menu will drop
down. Select Interpolate from the edit menu. Now a ramp of controllers
will appear, creating an even crescendo between the two volume controllers.
Do the same for the highest volume and the last volume you put in at the
right edge of the screen. Now you have an even decrescendo back down
again matching the one going up.

Conclusion

Feel free to fool around as much as you wish with editing controllers. For
more details of the Controller Editor, see “Controller Editor” starting on
page 109.
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Mixer Tutorial
.

The Mixer lets you enter controllers and other kinds of data by moving
faders up and down as you listen to the music. Make sure you've loaded the
file TUTOR13.QSD. Select Mixer from the Window menu.
7 Main Volume should be selected in the data type list box at the left of
the Mixer window control area. If it isn't, select it by clicking on the box
and selecting 7 Main Volume from the list box that drops down. If you're
haven't turned off play looping yet, make sure you do it now.

If you've just finished the Controller Editor tutorial, you can see right away
what effect the volume controllers that you added have on the Mixer. Press
the SPACE BAR to start playing and watch the faders move. You can
move the faders yourself if you want to. Try grabbing a fader and dragging
it up and down. The volume will increase and decrease as you drag it. The
changes you make now aren't permanent, because you are not recording.
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Recording a Fadeout

Now lets use the Mixer to record a fadeout at the end of the piece. We'll
start fading at bar 23 and finish at bar 25, the end of the piece. For the
fadeout, we will group the two faders together so that moving one fader will
move both of them. Group the faders together by checking both the boxes
above the faders. We will start recording at bar 22, one bar before the fade
should start. Move to bar 22 by clicking on the time display in the main
control area and selecting 22:1:0 in the time field.

Now let's try recording. Remember to start fading at the start of bar 23.
Press the record button (the button with the red circle) in the tape transport
in the main control area. Grab one of the faders and slowly drag it down so
that it is down to zero at the end of bar 25. When you are finished
recording, press the SPACE BAR or click the stop button (the second
button in the tape transport). How did your fade go? If you didn't like it,
click on No to answer the question, “Keep Mixer Changes?”. If you liked
it, click on Yes. Don't forget that you can undo recording by selecting Undo
from the Edit menu if you decide you don't like what you've done after
hearing it a couple of times.
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Song Editor and Event List Tutorial
The Song Editor shows an overall view of your music. On the left side of
the window is a list of your tracks and beside each track is a horizontal list
of bars. Each bar is filled in with colored rectangles if there are notes or
other events present in the bar. Different colors denote different kinds of
musical data. You use the Song Editor to cut and paste and insert space on a
global level, i.e. to arrange your music.

If you haven't already loaded the tutorial file TUTOR13.QSD, load it by
clicking on the File menu, selecting Open and then double-clicking on the
entry TUTOR13.QSD in the file list box. If Lock Cursors and Lock Tracks
are not set in the Window menu, click the Window menu and select Lock
Cursors, then click the Window menu again and select Lock Tracks.
Click the Window menu a third time and select the Song Editor.
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Copying and Pasting Bars

The first thing we'll do is make a copy of the first two bars in both tracks
and paste it in at the beginning of the piece. Select the first two bars in both
tracks by clicking the mouse in the first bar of the first track and dragging
the mouse while holding the left mouse button down so that it is on the
second bar in the second track. The first two bars in both tracks should be
highlighted. Release the mouse.
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From the edit menu that appears select Copy.

Notice that the From time and the To time have been filled in with the
range that you have selected. Make sure the Paste To box has a check in it.
We want to paste at the beginning, which is the Paste To time already set
by the dialog. All we have to do is click on OK.

Take a look at the first four bars in the Song Editor. The first bar and the
third bar both have different colors in them. What is this stuff? The best
way to tell for sure is to go to the Event List and take a look. Select the
Event List from the Window menu.
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Erasing Events

We are looking at the first track. Scroll the display down to the beginning
of bar 3. There is some stuff here we don't really need because it's already
at the beginning of bar 1. This is the treble clef, the program change, and
the volume controller. Let's get rid of them. Select the three events with the
mouse by clicking on the treble clef symbol, keeping the left mouse button
down and dragging down until all three events are highlighted and then
releasing the button. Select Cut from the edit menu that drops down.

Go to track 2 by clicking on the track list box and selecting track 2.
Repeat the previous operation. Note that in the Song Editor, bar 3 now
only has a black rectangle in both tracks, indicating that only note events
exist in this bar.
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Changing Events

Let’s go back to the Event List and change the volume controller value at
the beginning of both tracks. Press HOME to go to the beginning of the
track and then double-click on the volume controller event (the controller
event with controller number 7).

For fun, lets make the value of the controller 120. Click on OK, then repeat
the operation for track 1.

Erasing Bars

Let’s go back to the Song Editor and cut out bar 3 and bar 4. Select these
bars in both tracks the same way you did for bar 1 and bar 2. Select Cut
from the edit menu that appears. The same dialog comes up as when you
selected Copy, except that Cut is selected in the top left-hand box instead of
Copy. Let's leave everything the way it is and click on OK. Now the music
in bar 3 and bar 4 is gone, but the bars are still there. We want to delete
the hole, so let's try again. Select the bars again and now, when the dialog
comes up, put a check in the Delete Hole box. Click on OK. The blank
bars are gone.
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Inserting Bars

The last thing we can do in the Song Editor is to insert blocks of space for
entering or pasting new sections of music. Let's try opening up the space we
just cut out. Select bar 3 and bar 4 again as before. Now select Insert
Space from the edit menu. We want to insert 2 bars (the amount we
selected) starting at bar 3 (where we started our range) and this is how the
dialog is set up. If we wanted to insert a different amount of space or insert
at a different time, we could enter different values in the Insert At Time
field or the Amount field. Click on OK. The display in the Song Editor
reflects the two inserted blank bars.

Of course you can get rid of the two blank bars you created by selecting
them and deleting them, remembering to check the Delete Hole box.
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Recording Tutorial
In this tutorial we are going to do some recording with QuickScore Elite.
You’ll need a MIDI keyboard attached to your computer in order to
complete this tutorial.

We'll start with the file ONEBASS.QSD, so let's load it up. Click on the
File menu, select Open and double-click on ONEBASS.QSD in the file list
box. ONEBASS.QSD is a file with one bass track.

Setting Up The Metronome

Before we start recording, let's make sure things are set up the way we want
them. Let's start with the metronome. Click on the Options menu and
select Metronome.

The metronome you are given by default is MIDI note 60 on channel 10
with a velocity of 127. The metronome will count four beats before
recording starts. Click on the Audition Metronome button at the bottom of
the dialog box to start the audition. Click on the Audition Metronome
button again to stop the audition. If you like what you hear, keep it;
otherwise change the settings for the metronome (especially if you hear
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nothing) until you get something you like (or at least something you can
live with). Click on OK when you are satisfied with your metronome.

Setting Up MIDI Thru

Now let's make sure MIDI thru is set up the way we want it. Click on the
Options menu and select MIDI Thru.

If you are using a single MIDI keyboard  that has its own internal sounds for
some or all channels, turn MIDI thru off for all of these channels. If you
are using one or more synth modules that are separate from your keyboard,
keep MIDI thru on for all channels. If you are using a keyboard that can
only send on one channel, keep MIDI thru on for that channel and set the
output channel for that channel to the one you would like QuickScore Elite
to record and play on. If you want to change this output channel to another
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at any time you will have to do it here because you can't do it from your
keyboard.

Note: If you set local control to off on your keyboard (that is, you only have
the instrument play sounds that it detects from the MIDI in port), you must
keep MIDI thru on for all channels in the MIDI Thru dialog.

Creating a New Track

Now let's make a new track and set it up for recording. Select the Track
Sheet. Click on New at the bottom of the list of track numbers. This creates
a new track. Let's call the track Guitar. Click on the name field for track 2
and type “Guitar”. (Erase “B”, the name that was given to the track by
default.) Set the channel for the track to 2. A dialog box appears asking,
“Change all events on track to channel  2?”. Click on Yes. This will not
affect the channel of events that are recorded from your keyboard, but it will
affect events recorded using the faders and notes entered with the mouse.
Set the program for the track to 27 - Electric Guitar (clean). Now set the
channel that your keyboard will send to 2. (If you can't do this on your
keyboard, you will have to do it using the MIDI Thru dialog as described
on page 68.)

Recording

Let's record. Press the HOME key to make sure you are at the beginning of
your piece. Press the record button (the button with the red circle) in the
tape transport in the main control area.

The count-in will play and then the bass track will start to play. Play some
notes along with the bass track. When you have finished, click on the stop
button. You will be asked, “Keep this take?”. If you like what you
recorded, click on Yes, otherwise click on No.

You can keep recording more takes, even if you answer Yes to the question
“Keep this take?”. Just use Undo. (Click on the Edit menu and select
Undo.) Then you can try again.
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Let's record one more track. Click on New at the bottom of the list of track
numbers in the Track Sheet. As before, this creates a new track. Let's call
the track Piano. Click on the name field for track 3 and type “Piano”.
(Erase “C”, the name that was given the track by default.) Set the channel
for the track to 3. A dialog box appears asking, “Change all events on
track to channel 3?”. Click on Yes. Set the program for the track to
3 - Honky-Tonk Piano. Now set the channel that your keyboard will send
to 3. (If you can't do this on your keyboard, you will have to do it using the
MIDI Thru dialog as described on page 68.)

Let's record the track. Press the HOME key to make sure you are at the
beginning of your piece. Press the record button. The count-in will play and
then the bass track and the guitar track will start to play. Play some notes
along with the music. When you have finished, click on the stop button. If
you like what you recorded, click on Yes, otherwise click on No when you
are asked “Keep this take?”.

When you record, you don't have to start with a new or an empty track. You
can record on any old track. When you record, the new events which are
recorded are merged with the events already on the track. You also don't
have to start at the beginning of a track. You can set the time (shown in the
time display in the main control area) to anything, and start recording from
the time you set.

Punch Recording

If you want, you can cut out part of what was already in a track and record
something new in its place. You do this by punch recording. Click on the
Punch button in the main control area (the button with the red line and two
little black arrows underneath it) and click on the time display to the right
of the Punch button.

Set the From time to 2:1:0 and set the To time to 3:1:0. Now when you
record, all events on bar 2 will be replaced by events recorded from the
keyboard. Try it. If you don't like what you did, you can reject the take, or
you can undo it after listening to it a few times.
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Recording While Tapping the Beat

Recording while tapping the beat is great if we don’t want to stick to a
rigid tempo as we record. We don't want to hear the metronome or any
other music for that matter as we record while tapping the beat, because the
metronome and our music will proceed in real time and we will not.

To make things simple, let's start a new file. Click on the File menu and
select New. Answer No to the question, “Do you wish to save?”, and then
select Default from the list of score settings that appears.

Select the Metronome dialog by clicking on the Option menu item and
choosing Metronome. We want to make sure the metronome doesn't play
when recording so remove the check mark in the box beside Metronome
on Record by clicking on it. Click on OK.

Now select Record Options from the Options menu. Click on Tap Beat in
the top left-hand part of the dialog. Put a check in the Listen to MIDI box
at the bottom of the dialog by clicking on it. Now press the lowest note on
your MIDI keyboard. The Listen to MIDI button will clear and the number
of the note you pressed will appear in the Value list box. Click on OK.
Click on the record button in the main control area. Now we are ready to
record.

There is no hurry about entering notes. Remember to tap the beat with the
left hand on the lowest note on your keyboard as you play with the right
hand. When you're finished, press the SPACE BAR. Answer Yes to the
question “Keep this take?” if you like what you did.

Remember it doesn't make sense to record while tapping the beat with your
music playing. If you want to record while tapping the beat into a track with
music either on this track or on tracks above or below it, it is best to mute
the tracks. Do this by selecting the Track Sheet and removing the circles
in the Play field for these tracks.
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Reference

The following sections describe all of QuickScore Elite's features in detail,
starting with the main control area and the status area, going through the
editing windows and ending with a description of the menus.

Main Control Area

The main control area appears just below the menu and has controls that
affect all of QuickScore Elite's windows.

Durations Palette

To the far left on the main control area is the durations palette. Use this to
select the duration of notes that you will be entering with the pencil tool.
When you click the mouse in an edit window, the cursor will go to the
nearest time that is a multiple of the duration value. This also affects the
amount the cursor will move forward or backward when you use the left and
right arrow keys. So when you want to enter eighth notes, make sure you
have set the duration value to eighths. You can set the duration value by
clicking on a note in the palette or by pressing W for whole note, H for half
note, 4 for quarter, 8 for eighth, 1 for 16th, 3 for thirty-second or 6 for
sixty-fourth note.

The duration qualifier is at the right of the durations palette. The qualifier
can be either duple (two notes tied together), triple (three notes tied
together) or dotted (a note followed by a dot). For example, if 16th notes is
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selected in the durations palette and the duration qualifier is triple, you can
enter 16th note triplets and the cursor will move in increments of 16th note
triplets.

Note that you have to set the display quantization to something as small or
smaller than the smallest duration that you are trying to display. The
display quantization is set from the Display Bar, Display Track or Display
Score dialogs under the Display menu. If you are displaying non-quantized
music, you may have to experiment to see what is the most appropriate
display quantization. If you are displaying quantized music, then you can
use a very small display quantization value. Triplet/32nds is a good choice,
as triplets and duplets as small as 32nds will be displayed together correctly.
For more information on display quantization, see “ Quantization Amount”
on page 177, page 182, and page 187.

Tape Transport

The tape transport looks like the transport on a tape recorder and it works
that way too.

• The black triangle on the left is used to start play.

Play always starts from the beginning of the currently selected
window. A shortcut for using the play button is pressing the
SPACE BAR.

• The black square is used to stop play or recording.

Pressing the SPACE BAR while the music is playing is equivalent
to pressing the stop button.

• The button with the two black vertical lines is the pause button.

• The red circle is the record button.

Recording always starts from the cursor position in the active
window. (This is always shown in the time display in the main
control area.) When recording, there will be a count -in, set from
the Metronome dialog under the Options menu. The metronome
can be on or off and the metronome sound can be controlled using
the Metronome dialog. When you record in a track, the recorded
data is normally merged with the data currently on the track. This
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is not the case, however, when punch-in/punch-out is selected. In
this case, only the music between the punch points are affected,
and the old music is replaced by the new music.(The old music is
not merged with the new music.)

On the top of the control area of the tape transport is a group of controls to
move around in time.

• Clicking on the button with a line and two left arrows moves to the
beginning of the piece.

• Clicking on the left arrow in the slider moves the time one bar to the
left.

• Clicking on the right arrow in the slider moves the time one bar to the
right.

• Clicking to the left of the scroll box moves the time one screen to the
left.

• Clicking to the right of the scroll box moves the time one screen to the
right.

• Dragging the scroll box will move to any place in the piece . The time
display in the main control area will change as you move the scroll
box. When it is on the bar you want, release the scroll box and the time
will change to the start time for this bar.

Time Display

The time display shows the position of the cursor in the active window.
The time is displayed in bars, beats, and steps on the top and in SMPTE
time on the bottom. The SMPTE time format is selected using the SMPTE
dialog under the Options menu. You can change the current time by
clicking on the time display and by setting either the Bar:Beat:Step time
or by setting the SMPTE time. When you do this, the cursor in the active
window will move to the new time you set.
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Loop Control

You can have a section of music loop continuously by selecting the loop
control and setting a loop start time and a loop end time. Click on the
loop button and then click on the time display to the right of the loop
button. This will bring up the Loop Times dialog where you can set the loop
start and end times. Looping is useful when you are experimenting with a
section of music and you want to try different things. You can enter and edit
notes as you are looping, which lets you quickly hear different musical
ideas.

Punch-In and Punch-Out Control

Punch-in and punch-out is used when recording so that you replace the
music between the punch points with the new music you have recorded.
When punch-in/punch-out is selected, the new music replaces the old
music between the punch points and is not merged with the old music. Any
music outside the punch points is not affected when punch recording. Note
that only old musical events with a time greater than or equal to the
punch-in time and smaller than the punch-out time are erased. Old musical
events at the punch-out time are not erased.

Tempo Button

The tempo button shows the tempo at the current time (the time displayed
in the time display, indicating the time of the cursor in the active window).
It is possible to click on the tempo button to change the tempo at the current
time. You can also change the tempo using the Controller Editor. This is
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usually better than using the tempo button because then you can see all the
tempo events before and after the current time.

Play Score Button

The play score button tells you whether you will hear all the tracks in your
piece or just the current track. Clicking on it will toggle it from Single
Track mode to Full Score mode. It is affected by the score button in the
Score Editor. When you set the score button to full score, the play score
button also changes to full score. When you set the score button to single
track, the play score button also changes to single track. However,
changing the play score button does not affect the score button in the score
window. This way you can easily hear the full score while looking at one
track, or hear just one track while looking at the full score.

Step Entry Button

The step entry button lets you enable or disable step entry from a MIDI
keyboard. When it is highlighted, step entry is enabled. Step entry is a very
useful way to enter music. Notes played on the keyboard will be entered at
the cursor point in the active window. The duration of the notes entered is
the duration value set in the durations palette. After a note is entered using
step entry, the cursor moves ahead by the duration value. Step entry always
merges the entered note with the notes already in your track. You can step
enter a chord, by playing all the notes of the chord at once on your MIDI
keyboard. Make sure you play the notes all at the same time and then wait a
half second or so to play the next note or chord, so that successive notes or
chords do not end up at the same time. (QuickScore Elite needs a gap
between notes to distinguish them from imperfectly played chords.)
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Panic Button

The panic button is used to stop notes from playing if, for some reason, they
don't stop by themselves. It sends out MIDI note off commands for all notes
on all channels and turns pedal controllers off.

Save Button

The save button will save your file to disk. It acts as the Save As menu item
under the File menu, so you have to enter the name of the file to which you
want to save your data.
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Keys Used in the Main Control Area

Keystroke Action

P Play screen.

SPACE BAR Play/Stop play.

ESC Stop play.

SHIFT+P Play without scrolling.

R Record.

W Select whole note duration value.

H Select half note duration value.

4 Select quarter note duration value.

8 Select eighth note duration value.

1 Select 16th note duration value.

3 Select 32nd note duration value.

6 Select 64th note duration value.

T Select the next duration qualifier.

CTRL+C Move the cursor in all windows to the cursor location in
the current window.

CTRL+T Move the track in all windows to the track in the current
window.

INSERT Paste.

CTRL+V Paste.

CTRL+A Edit track.

U Undo.

CTRL+U Undo.

M Mute the current track.

S Solo the current track.
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Status Line

The status line is at the bottom of QuickScore Elite's main window. There
are three items in the status line:

• The first display in the status line shows you the name and number of
the current track. You can double click on the track name to change
it.

• The second display in the status line shows the title of your piece.
Double click on the title name to change it. The dialog that comes up is
the Titles dialog which is also available under the Display menu. For
more information, see “Titles” on page 188.

• The third display in the status line generally shows you what action
you will be taking if you choose a menu item. As you move your mouse
over the menus, this display will give you an idea what you can do.
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Score Editor
The Score Editor shows your music in standard music notation.

The Score Editor’s control area has the following features:

• A toolbar.

• A track list box for changing from track to track.

• A mouse time locator showing the time of the mouse.

• A palette of different objects.

• A staff button.

• A page button.

• A voice palette.

Below the control area is the score display. Here you see your music in
standard music notation. Usually each staff represents one track, but it is
also possible to split a track and show it on a bracketed pair of bass and
treble clef staves. There is a cursor, where music is entered using step entry
or the right mouse button. This is also the point where music that has been
cut or copied to the clipboard will be pasted. The cursor moves by clicking
the mouse or by using the arrow keys.
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Toolbar

The toolbar in the Score Editor contains seven tools.

Arrow Tool
The arrow tool is generally used for selecting notes or other events and
then editing them by selecting an editing operation from the edit  menu. It is
also used to select a single note or event (by double clicking on it) and then
edit it by selecting an operation from the edit menu.

When the arrow is selected, notes or other events can be entered at the
cursor point by clicking the right mouse button. This will enter a note or
event at the height of the mouse at the cursor point and it will advance the
cursor.

The cursor point can be moved by pressing the left mouse button or by
using the arrow keys. The cursor always moves in increments of the
selected duration value, set using the durations palette. The durations
palette is in the main control area, to the far left. (To change the selected
duration, click on the duration you want.)

If you are using any other tool except the arrow tool, use the right mouse
button to position the cursor, because the left mouse button is used for
editing.

To select a group of notes, you can drag over them using the mouse. Click
before the first note you want to edit, hold the mouse button down, and drag
past the last note you want to edit. You can drag past the end of the window
if you want. The window will scroll if you do this. You can also select a
group of notes by pressing SHIFT+S (for start) where you want to start your
range, moving to the end of your range and then pressing SHIFT+F (for
finish). If you want to select only a few notes, hold the CTRL key down and
then click on each note you want to include in your selection. To remove  a
note from the selection, just click on it again. When you have selected all
the notes you want, release the CTRL key. Another way to limit the notes
you are editing is by using the Note Filter, available under the Edit menu.
Click on Use Filter to select it and then create your filter. For example, you
can just select notes above middle C (MIDI note 60) by setting the From
Pitch to 61 instead of 0.
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Pencil Tool
The pencil tool is used to enter notes or events anywhere on the page.
Select the pencil tool and click where you want to enter a note. This note
will go where you click it, quantized to the value of the selected duration.

Eraser Tool
The eraser tool will erase notes or events anywhere on the page. Select the
eraser tool and click on a note you want to erase. The note will disappear.

NSEW Tool
The NSEW tool is the one with the four arrows: one pointing north (up),
one pointing south (down), one pointing east (right) and one pointing west
(left). It moves a note or event around with complete freedom of movement.
Select the NSEW tool by clicking on it and then click the left mouse button
on a note that you want to move around. Keep the button down and drag the
note to where you want to put it and then release the button. The score will
redraw with the note in its new position.

EW Tool
The EW tool is the one with one arrow pointing east (right) and one arrow
pointing west (left). It moves a note or event forward or backward in time.
Select the EW tool by clicking on it and then click the left mouse button on
a note you want to move forward or back. Keep the button down and drag
the note to where you want to put it and then release the button. The score
will redraw with the note at its new time.

NS Tool
The NS tool is the one with one arrow pointing north (up) and one arrow
pointing south (down). It moves a note or event up or down. If the event is a
note, of course this means that the pitch is being changed. Select the
NS tool by clicking on it and then click the left mouse button on a note you
want to move up or down. Keep the button down and drag the note until it
is at the pitch you want, then release the button. The score will redraw with
the note at its new pitch. When the note is being dragged it stays in key.
This is usually what you want, but sometimes you will want to set a note to
a pitch that is not in the key signature. You can move a note chromatically
by using the arrow keys while the note is being dragged. For example, to
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change a C natural to a C sharp in the key of C, click on the note and keep
the left mouse button down. Then press the UP ARROW key once. Now
release the left mouse.

Spacing Tool
The spacing tool is available only when you are editing notes, that is, when
the note is selected in the object type palette. It is used to move notes and
bar lines forward and backward in space  without effecting their time values.
For example, to move the middle bar line to the left when you have two bars
per line, select the note spacing tool and click on the bar line. Drag it to the
left as far as you want. The music will redraw with the left barline where
you dragged it. You can also use it to move notes back and forth. Select the
note you want to move and drag it to where you want it. You can only drag
notes about three note widths left or right from their original position.

Track Selector List Box

To the right of the tool palette is the track selector list box. Use this to
change to a new track in the Score Editor. Click on the track selector list
box and then click on the track that you want from the list of tracks that
drops down. If you are in Single Track mode (if the score button has a
single bracketed staff), you only see one track at a time, so the new track
will replace the one you were looking at before. If you are in Score mode (if
the score button has a double bracketed staff), the cursor will move to the
track you select. You can also change tracks in Score mode by using the up
and down arrow keys. When you change the track, the first box of the status
line (at the bottom of the main window) will change, telling you the name
and the number of the track you are on.
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Mouse Time Locator

The mouse time locator shows you the time in bars, beats and steps of the
mouse. Notice how this changes as you move the mouse back and forth in
the Score Editor.

Object Type Palette

The object type palette lets you select the type of object you are entering or
editing. There are six different types of objects.

Notes
The button with the note is for notes. When the note is selected you will see
what we call a voice palette to the far right of the control area. Each of the
four buttons (Def, 1, 2, or Grace) represent a possible voicing for music
that is entered. When music is entered with the Def voice (the default),
notes are entered with the stems up or down depending on the position of
the note on the staff. (Notes on or below the middle line are written with
stems up and notes above the middle line are written with stems down.)
Notes entered in voice 1 all have their stems pointing up. Rests for voice  1
appear centered on the top staff line. Notes entered in voice  2 all have their
stems pointing down. Rests for voice 2 appear centered on the bottom staff
line. Grace notes are all drawn at small size and have no rests associated
with them.

If you want a single voice to appear in a bar, it is usually best to use the
default (Def) voice. If you want two voices to appear in a bar, enter the first
voice as voice 1 and then enter the notes for the second voice as voice 2. If
you want some grace notes, put them wherever you want. If you want them
to appear before the first beat of a measure, you can move the grace notes
ahead of the first normal-sized note using the note spacing tool.

Lyrics
The button with the L is for lyrics. When the L is selected in the object type
palette the voice palette is replaced by a lyric drop-down list box This is
used to select which lyric number is being edited. (Lyric 1 is the first below



Score Editor   85

the staff, lyric 2 is the next and so on.) The lyrics first appear at a set
distance below the staff, but this can be changed by moving the lyrics with
the NS or the NSEW tool as well as by using the lyric spacing dialog
(available from the Lyrics button in the Display Page dialog in the Display
menu).

To enter lyrics, click on the L in the object type palette and then select the
pencil from the tool palette. Click the mouse on the note for which you
want to enter a lyric. The cursor will appear for you to enter your lyric. As
you enter the lyric, it will automatically center on the note you have
selected. To stop entering a lyric, click on a new note or else press the ESC
key. A fast way to enter lyrics under successive notes is to use the TAB key
to move the lyric cursor to the next note. You can move back and forth
between lyrics using the TAB and the SHIFT+TAB keys. A single dash
can be entered halfway between the current lyric and the next one by
pressing CTRL+- (dash). Two dashes can be entered by pressing
CTRL+SHIFT+- (dash). The lyric font can be selected using the Fonts
dialog from the Page dialog under the Display menu. The lyric events can
be edited, erased and moved using the appropriate tools.

Expression Marks
The button with the E is for expression marks. When the E is selected in
the object type palette, expression text can be entered. Select the pencil tool
and click the mouse where you would like to put an expression. The Enter
Expression dialog will appear. You can type in the expression you want or
select it from the drop-down list box. By default the expression text is
drawn in Times New Roman 10 point italic. You can change the expression
font by selecting the Fonts dialog from the Page dialog under the display
menu. The expression events can be edited, erased and moved using the
appropriate tools.

Text
The button with the T is for text. When the T is selected from the object
type palette blocks of text can be entered or edited. A drop-down list box of
eight block text fonts appears at the right of the Score Editor’s control area.
Select the font you want for your text. The block text fonts that are available
can be changed by selecting the Fonts dialog from the Display Page dialog
under the Display menu. Select the pencil tool and click the mouse. Now
you have a text box that can be resized by dragging on the lower right
corner. You can enter text in the font you've selected at the cursor point.
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The text event you've entered can be cut, copied and moved using the
appropriate tools, just as with other types of events.

Symbols
The button with the symbol (fff to start) is for symbols. The symbol button
changes when a new selection is made and displays the last symbol that was
selected. Click once on the symbol button and it becomes selected. At this
point you can enter the symbol that is drawn on the button or edit any
symbols that are in your score. Click on the symbol button again and a
double palette of symbols drops down. There are ten symbol palettes to
choose from, the last four of which are custom. Click on a symbol palette
name to display the palette to the right of the names. Click on the symbol
you want to enter and it will appear on the symbol button in the object type
palette. Now this will be the symbol you can enter using the pencil tool. The
Sym. 1, Sym. 2, Sym. 3 and Sym. 4 palettes can be changed by selecting
the Fonts dialog from the Display Page dialog, which you choose from the
Display menu. You can use these palettes to enter symbols from alternate
music fonts or fonts you have created yourself.

Clefs
The button with the clef is for clefs. The clef button changes when a new
selection is made and displays the last clef that was selected. Click once on
the clef button and it becomes selected. At this point you can enter the clef
that is drawn on the button or edit any clefs that are in your score. Click on
the clef button again and a palette of clefs drops down. Select the clef you
want. Now you can enter that clef using the pencil tool. When you enter a
clef all the notes following that clef up to the point where you have entered
another clef will be displayed using that clef. The last clef is the single-staff
percussion clef and it behaves a little different from the other clefs. When it
is set, the staff is reduced to a single line and all notes are displayed on the
line. When the single staff percussion staff or the regular percussion staff is
used, the notes are displayed either as regular note heads, open or closed
diamonds, open or closed triangles, X’s, with a variety of different
percussion accent marks. The mapping of drum note heads and accents to
note numbers can be set by set using the Drum Notation dialog available
from the Options menu.
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Score Button

The score button changes the score display from Single Track mode (a
single staff is shown on the button) to Score mode (a bracketed double staff
is shown on the button). Click on the score button to change from Single
Track mode to Score mode.

Page Button

The page button changes the display from Edit mode to Print Preview
mode. When the page button is selected, the score is shown in Print
Preview mode. A 100% button appears to the right of the page button.

Pressing the 100% button causes all of the current page of the score to fit
exactly in the Score Editor window.

Entering Symbols

For the most part, symbols are entered like notes; that is, you simply click
them in with the pencil tool where you want them on the page. The
adjustable symbols, chords, guitar chords, and figured bass symbols are
exceptions to this rule.

Another exception is dynamic symbols (all dynamics including crescendo
and decrescendo). You can enter dynamic symbols in all tracks at once
instead of just in one track at a time. When you hold down the SHIFT key
when entering a dynamic, the symbol is entered in all tracks. If you don't
hold the SHIFT key down when you enter the symbol, of course the symbol
is entered only on the current track.

Note: When you are entering symbols (as well as other objects) in Score
mode, always be aware of the current track when you enter the symbol. The
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symbol you enter will go onto this track, even if you put it closer to a staff
for a different track. If you make this mistake, you will have a hard time
editing the symbol afterwards. Make sure you switch the current track to the
one on which you want to enter symbols before you enter symbols on a new
staff. You can do this by moving the cursor to the new staff with the arrow
keys. The current track is shown at the left in the status line at the bottom of
the main window. You can also simplify your life by entering symbols in
Single Track mode instead of Score mode.

Adjustable Symbols
The adjustable symbols are the ones you see when you click on the Adjust
palette name. These symbols have adjustable shape and size. These symbols
are entered by dragging them in. Choose the pencil tool and select the
adjustable symbol you want to enter. Now click the left mouse button where
you want the left edge of the symbol to go. Keep the mouse button down and
drag the mouse to where you want the right or bottom edge of the symbol to
go. Now release the mouse button.

As you drag, the symbol will shrink and expand to follow the mouse.
Release the mouse when you have positioned the symbol approximately
where you want it. There will be three little diamonds at the left, right and
center of the symbol. You use these control points to further shape and
move the symbol. Click on a control point to select it and drag it around to
shape or move the symbol. Alternatively you can move a control point
around using the arrow keys. You can move between control points by using
the TAB and the SHIFT+TAB keys as well as by clicking on them with the
mouse. The middle control point is usually used for moving the symbol and
the outer control points for shaping the symbol. When you are finished
shaping and positioning your symbol, click the right mouse button or press
the ENTER key to enter it. If you don't want to enter your symbol, press the
ESC key.

When you are entering the slur symbols, you can automatically position the
left slur point over the closest note by pressing Z. You can automatically
position the right slur point over the closest note by pressing X. You can
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automatically center the slur by pressing V. If the slur is above the notes,
the slur end points go over the closest notes when you press Z and X. If the
slur is below the notes, the slur end points go under the closest notes when
you press Z and X.

When you are entering the 8va and 8vb symbols, you can control whether
or not the 8va or 8vb text is shown and whether or not the finishing vertical
line is displayed. The HOME key toggles whether the 8va is shown; the
END key toggles whether the finishing vertical line is displayed. This is
useful when octava markings extend over more than one line.

When you are entering first and second endings  you can change or
eliminate the ending number. The ending number defaults to  1. for the first
ending and 2. for the second ending. The numbers can be changed or
eliminated by pressing the + (plus) and the - (minus) keys.

You can put in and change the number for groupings by using the + (plus)
and the - (minus) keys. Pressing + (plus) increments the number; pressing
- (minus) decrements it. When you decrement past  1, the number
disappears. You can change or eliminate the amount of space in the middle
of the grouping by using PAGE UP and PAGE DOWN.

PAGE UP and PAGE DOWN also work on crescendo and decrescendo
symbols to change the angle of the symbol.

Press F to flip a number of adjustable symbols. These include the crescendo
and decrescendo symbols, the groupings, the endings and the octavas.

Press L to horizontally level crescendos, decrescendos and groupings.

It is possible to change the number of tremolo  lines in the tremolo symbol
from one to four by pressing 1, 2, 3 or 4 while entering or editing the
tremolo symbol.
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Chord Symbol
The symbol at the bottom left of the miscellaneous symbols palette is the
chord symbol. When you enter a chord symbol, the Chord Name dialog
appears for you to build the chord you want.

Select the root of the chord in the box at the left of the dialog. The root can
have a sharp, a flat or neither after it, depending on whether you select n, #
or b beside the name for the root note.

If your bass note isn't the root, you can indicate this. Check the Bass box
and then choose the note you want for the bass. The bass can have a sharp,
a flat or neither after it, depending on whether you select n, # or b beside
the name for the bass note.

Type in the type of chord you want in the Type box. If you want to type in a
flat symbol, type B. If you want to type in a sharp symbol, type #.

The Preview box will show you what your chord will look like. Note that
numbers and accidentals appear in superscript.

Tempo Symbol
The tempo symbol is to the right of the chord symbol at the bottom of the
miscellaneous symbols palette. When you enter a tempo symbol, the Tempo
Symbol dialog appears. Here you choose the beat value you want and the
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number for the tempo. The tempo symbol is previewed in the box at the
right of the dialog.

To select the beat value, click on the drop-down list box and select a beat
value. Drag up and down with the mouse over the list box to scroll it. Click
on the beat value you want.

To select the tempo number, click on the spin buttons to move the number
up and down or click on the number itself and change it by typing in a new
number.
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Guitar Chord Symbol
The guitar chord symbol is to the right of the tempo symbol in the
miscellaneous symbols palette. When you enter a guitar chord symbol, the
Guitar Chords dialog appears.

You make your guitar chord by selecting a chord from the list box at the
top left of the dialog. You choose a starting fret number from the drop-
down list box under the chord list box. You choose whether your guitar
chord will have four or five frets by selecting 4 Frets or 5 Frets in the box
below the fret number drop-down list box. You choose to show or not show
the name of the chord above the guitar chord grid by checking or
unchecking the Show Chord Name box. The name that first appears is the
name of the chord that you selected from the chord name list box. You can
change this by clicking on the Set Chord Name button. This will bring up
the Chord Name dialog, which was discussed earlier (see page 90).

You can set the circles on the guitar chord frets yourself by clicking on the
preview grid wherever you want to put in a circle. You can only have one
circle on any vertical line so entering a new circle on a vertical line will
erase the old one. Circles entered at the nut will be open. Other circles will
be closed. You can erase a circle by clicking on it.
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Figured Bass Symbol
The figured bass symbol is to the right of the guitar chord symbol at the
bottom of the miscellaneous symbols palette. When you enter a figured bass
symbol, the Figured Bass dialog appears.

Enter the figure you want by typing in the Figure box. Press ENTER to get
to a new line. You can add accidentals at the cursor position by clicking on
one of the accidental buttons at the left-hand side of the dialog or by using
the key for each accidental (Press N for natural, # for sharp, etc.). Check
the Parenthesis box if you want your figure to be enclosed in parentheses.
The figure will appear in the Preview box the way it will be displayed on
the page.

Moving Around in the Score Editor

The horizontal scroll bar is used to move the display forward or backward
in time. Click on the left button and the display will move one bar to the
left. Click on the right button and the display will move one bar to the
right. Clicking to the right of the scroll box will move the display right one
screen. Clicking to the left of the scroll box will move the display left one
screen. Dragging the scroll box will move to any place in the piece. The
time display in the main control area will change as you move the scroll
box. When it is on the bar or the time you want, release the scroll box and
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the display will go to this bar, with the cursor at the beginning of this bar.
You can also move to a specific time by clicking on the time display in the
main control area and setting a time to which you want to go.

You can move the cursor forward or backward, by the duration value set in
the durations palette in the main control area, by using the LEFT ARROW
key and the RIGHT ARROW key. You can move the cursor forward or
backward, by the score quantization duration (set in the Display Score
dialog under the Display menu), by using CTRL+LEFT ARROW and
CTRL+RIGHT ARROW.

The vertical scroll bar will scroll the display up or down.

Notes on Transcription

The Score Editor automatically transcribes the music in your tracks and
updates it whenever you make changes or enter new music.

Quantization
The display is generally quantized. This means that the start time and
duration of notes and rests will always be a multiple of the  display
quantization value. For example, thirty-second notes and other notes
smaller than sixteenths will be displayed as sixteenth notes if the display
quantization is set to sixteenths. If you want to display triplets properly you
must select a triplet quantization value, such as triplet, triplet/8th,
triplet/16th or triplet/32nd. Display quantization can be done globally
using the Display Score dialog, on a track-by-track basis using the
Display Track dialog, or on a bar-by-bar basis using the Display Bar
dialog. The Display Score, Display Track, and Display Bar dialogs are
available from the Display menu.

Note Extending
By default, notes are extended in duration to the beginning of  the next
note or to the beginning of the next beat, whichever is closest. This is done
to avoid lots of little rests, which can clutter the display and are normally
dispensed with in notational practice. This can be changed so that all notes
display at their real duration regardless of their position in the score. Like
display quantization, note extending can be adjusted on a bar-by-bar,
track-by-track, or global basis. You change this using the Display Bar,
Display Track, or Display Score dialogs.
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Accidentals
Accidentals are generated automatically for notes. If you don't like the way
accidentals have been chosen by QuickScore Elite, you can change them by
selecting the note or notes whose accidental you want to change, by double-
clicking or control-clicking and choosing Accidental from the edit menu.

Note Grouping
By default, notes are grouped together by beat . For example, in 6/8 time
there will be two groups each containing three eighth notes in each bar. You
can adjust the way notes are grouped by changing the time signature or
changing the beat. You can change the time signature or the beat globally
using the Display Score dialog or on a bar-by-bar basis using the Display
Bar dialog. You can also group notes by selecting the notes you want to
group together and choosing Group from the edit menu.

Stem Direction
Notes below the middle staff line are normally drawn with stems up; notes
on or above the middle staff line are normally drawn with stems down. This
can be changed by selecting notes and grouping them with stems up or
down. It can also be changed by setting the voice of the notes you want to
change or by changing the stem direction of all the notes in the bar or track
using the Display Bar or Display Track dialogs.

Voice
By default, notes are displayed on a track as a single voice. Notes can be
entered or changed to appear on four distinct voices — the default, voice 1,
voice 2 or grace notes. Change notes to a given voice by selecting the notes
and choosing Voice from the Edit menu.

Split Track
You can choose to display a track as two separate staves (you would
generally do this if you are displaying a keyboard part or a reduction of
more than one distinct parts). Do this by setting the option Split Track to
Yes in the Display Track dialog.



96 Reference

Cross-staff Beaming
If you display your track on two separate staves, notes above and including
middle C appear on the top staff and notes below middle  C appear on the
bottom staff. You can choose which notes go on which staff by selecting
them and choosing Staff from the edit menu. You can set cross-staff
beaming by selecting Crossed from the submenu that appears after you
select Staff from the edit menu. For more details on cross -staff beaming, see
“Staff” on page 145.

Note Size
Notes can be drawn large (the default) or small (for grace or cue notes, for
example). Change the size of notes by selecting the notes, choosing Group
from the edit menu, and then Big Notes or Small Notes. For more
information on grouping notes, see “Group” on page 145.

Clefs
You can select several different kinds of clefs including two kinds of drum
clefs. The single-line drum clef (with a line through it in the clef palette)
will cause the staff to appear as a single line. You select clefs on a track-by-
track basis using the Display Track dialog or you can drop in a clef
anywhere in a track by selecting a clef in the object type palette and
entering that clef with the pencil tool. When a drum clef is selected, notes
are displayed with drum note heads. The mapping of note pitches to drum
note heads is governed by the Drum Notation dialog available under the
Options menu.

Drum clefs
It is easiest to enter and edit notes that you want to display with a drum clef
by switching to a bass clef. When you have finished entering or editing
notes, switch the clef back to a drum clef. This is because you can map
several pitches to the same position on the staff when you display notes
using a drum clef. (Using a single-staff drum clef maps all notes to the same
staff line.) You can also enter or edit drum notes using the Piano Roll
Editor.
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Rests, Ties, and Tied Notes
Rests, ties and tied notes are generated automatically. For this reason it is
usually futile to try to edit rests and tied notes. The exception is when you
have explicitly entered rests or tied notes yourself. (See next paragraph.)

However, the level of rests and ties can be adjusted so that they don't
overwrite notes or other symbols. This is done from the Display Bar dialog.
You can also choose not to generate rests at all in a given section of your
music and put them in yourself. You can do this for a given bar using the
Display Bar dialog or, for an entire track, using the Display Track dialog.

If you really must have a tied figure displayed in a manner that you can't
seem to get any other way, you can enter the note, the ties, and the tied
notes by hand. Use a slur to simulate the tie. You can set the velocity of the
tied notes to zero if you like.

Changing How Music is Transcribed
As we have pointed out, you can change how your music is transcribed on a
note-by-note basis, a bar-by-bar basis, a track-by-track basis, or
globally. To change things on a note-by-note basis, select a note or a group
of notes and apply a formatting edit to it (accidental, group, staff, or
voice). For details on applying these edits, see “Note Block Editing Menu”
starting on page 141. To make changes on a bar-by-bar basis, use the
Display Bar dialog. To make changes on a track-by-track basis, use the
Display Track dialog. To make changes on a global basis, use the Display
Score dialog. The Display Bar, Display Track and Display Score dialogs are
available by clicking on the Display menu and selecting the appropriate
menu item. There are also a number of display options in the display
dialogs that haven't been covered here. For information about display
options not covered here as well as more information about display options
which were covered here, see “Display Menu” starting on page 167.

Printing

You can print a full score, a single track, a group of tracks or just what
appears on the screen. The printing options are available from the File
menu. Choose Print File to print your score. If you are printing a single
part you can select Single Track mode with the Score button (make sure a
single staff is displayed on the button) and then choose Print File, or you
can choose Print Part. Print Part lets you select a group of tracks for your
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part. If you want to print just the music that appears on the screen, choose
Print Line.

If you choose Print File or Print Part  you can opt to print the entire piece or
you can select a range of pages to print. You can print in landscape or
portrait page orientation by selecting this in the Print Setup dialog. The
Print Setup dialog is available from the File menu or by pressing the Setup
button in the Print dialog.

On some printers you can select the staff size for your printout. This is done
by changing the Scaling (%) box in the Options dialog. This changes the
aspect ratio of the music by stretching in the y direction while keeping the x
direction constant. The Options dialog is available for some printers when
you select the Options button in the Print Setup dialog.

What Else Affects the Score Editor?

Of course, the menus that drop down when you edit notes or other objects in
the Score Editor will affect objects and the way they are displayed. See “ Edit
Menu” starting on page 136 for a detailed discussion of these. Also, options
that are selected from the dialogs that come up under the Display menu,
affect how music is displayed in the Score Editor. Under the Options menu,
the Legato Entry option is important for the Score Editor. When a note is
entered with legato entry set to on, the note that precedes it will lengthen
or shorten its duration so that it ends where the new note starts. This is
sometimes very useful, because you can enter a lot of music with different
rhythmic values without changing the duration value from the main control
area. Of course, you have to remember to turn legato entry off when you
want to keep space between notes that you are entering.
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Keys Used in the Score Editor

Keystroke Action

TAB Insert space equal to the current duration
value.

SHIFT+TAB Delete space equal to the current duration
value.

DELETE Delete whatever is at the cursor position.

BACKSPACE Delete what is one duration value before the
cursor and move the cursor back one
duration value.

UP ARROW Move the cursor to the track above when in
Score mode.

DOWN ARROW Move the cursor to the track below when in
Score mode.

LEFT ARROW Move the cursor to the left one duration
value.

RIGHT ARROW Move the cursor to the right one duration
value.

CTRL+LEFT ARROW Move the cursor to the left by the
quantization amount.

CTRL+RIGHT ARROW Move the cursor to the right by the
quantization amount.

CTRL+PAGE UP Move the display one bar ahead.

CTRL+PAGE DOWN Move the display one bar back.

PAGE UP Scroll the screen up.

PAGE DOWN Scroll the screen down.

SHIFT+S Set the start block editing mark.

SHIFT+F Set the finish block editing mark.

F11 Move the display back one screen.

F12 Move the display forward one screen.
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Keystroke Action

HOME Move to the beginning of the piece.

END Move to the end of the piece.

SHIFT+LEFT ARROW Select tool to the left of the selected tool.

SHIFT+RIGHT ARROW Select tool to the right of the selected tool.

CTRL+F Toggle between Score mode and Single
Track mode.
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Piano Roll Editor
The Piano Roll Editor lets you edit your music in piano roll notation. You
see one track of music at a time.

The Piano Roll Editor’s control area has the following features:

• A toolbar.

• A track list box for changing from track to track.

• A channel list box showing the channel or channels being edited.

• A mouse time locator showing the time of the mouse.

• A mouse pitch locator showing the pitch of the mouse.

• A button to show waves or hide waves.

• An indicator letting you know whether you are currently editing waves
or editing notes.

Below the control area is the piano roll display. Here you see your music in
piano roll notation.

• At the top of the display is the bar number indicator.

• To the left is a vertical piano keyboard to show you the pitches of
your notes.

• Notes appear in the note area as horizontal bars. The vertical position
of the bar indicates the pitch of the note. The beginning of the bar
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shows the note's start time and the length of the bar shows the note's
duration.

• There is a cursor (the vertical purple line), where music is entered
using step entry or the right mouse button. This is also the point where
music, that has been cut or copied to the clipboard, will be pasted. The
cursor moves by clicking the mouse or by using the arrow keys.

You can add wave files to your piece using the Piano Roll Editor's wave
window. This area is just above the piano roll window. If the wave window
is not visible, click on the Show Waves button. Wave files appear in this
area as straight lines indicating the start time and duration of the wave file.
The name of the wave file is written above the line. You move between the
wave window and the piano roll window by clicking on one or the other.
The Edit Notes/Edit Waves indicator at the far right of the control area
will display Edit Notes if the piano roll window is active or Edit Waves if
the wave window is active.

Toolbar

The toolbar in the Piano Roll Editor contains eight tools.

Arrow Tool
The arrow tool is generally used for selecting notes and then editing them
by selecting an editing operation from the edit  menu. It is also possible to
select a single note (by double clicking on it) and then edit it by selecting an
operation from the edit menu. When the arrow is selected notes can be
entered at the cursor point by clicking the right mouse button. This will
enter a note or event at the height of the mouse at the cursor point and
advance the cursor.

The cursor point can be moved by pressing the left mouse button or by
using the arrow keys. The cursor always moves in increments of the
selected duration value, set from the durations palette. (The durations
palette is in the main control area, to the far left. To change the selected
duration, click on the duration you want.)
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If you are using any other tool except the arrow tool, use the right mouse
button to position the cursor, because the left mouse button is used for
editing.

To select a group of notes you can drag over them using the mouse. Click
before the starting point of the first note you want to edit, hold the mouse
button down and drag past the starting point of the last note you want to
edit. You can drag past the end of the window if you want. The window will
scroll if you do this.

While the mouse is being dragged, the HOME, END, F11 and F12 keys
can be used to move around in the Piano Roll Editor to more quickly find
the end of the range.

If you want to select only a few notes, hold the CTRL key down and then
click on each note you want to include in your selection. To delete  a note
from the selection, just click on it again. When you have selected all the
notes you want, release the CTRL key. Another way to limit the notes you
are editing is by using the Note Filter, available under the Edit menu.
Click on Use Filter to select it and then create your filter. For example, you
can just select notes above middle C (MIDI note 60) by setting the From
Pitch to 61 instead of 0.

Pencil Tool
The pencil tool is used to enter notes. Select the pencil tool and click
where you want to enter a note. This note will follow the mouse until you
release the mouse button. Remember that the duration of the note is set by
the durations palette in the main control area. If the Snap/Free button (just
below the arrow tool in the control area) is set to Snap, the start time of the
notes you enter are quantized to the value of the selected duration. If it is set
to Free, the start time of the notes you enter are not quantized and you can
enter them at any point in time.

Eraser Tool
The eraser tool will erase notes. Select the eraser tool and click on a note
you want to erase. The note will disappear.

NSEW Tool
The NSEW tool is the one with the four arrows: one pointing north (up),
one pointing south (down), one pointing east (right) and one pointing west
(left). It moves a note around with complete freedom of movement; that is
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you can move it back and forth in time or up and down in pitch. Select the
NSEW tool by clicking on it and then click the left mouse button on a n ote
that you want to move around. Keep the button down and drag the note to
where you want to put it and then release the button. The display will
redraw with the note in its new position.

EW Tool
The EW tool is the one with one arrow pointing east (right) and one arrow
pointing west (left). It moves a note forward or backward in time. Select the
EW tool by clicking on it and then click the left mouse button on a note you
want to move forward or back. Keep the button down and drag the note to
where you want to put it and then release the button. The display will
redraw with the note at its new time.

NS Tool
The NS tool is the one with one arrow pointing north (up) and one arrow
pointing south (down). It moves a note up or down in pitch. Select the
NS tool by clicking on it and then click the left mouse button on a note you
want to move up or down. Keep the button down and drag the note until it
is at the pitch you want then release the button. The display will redraw
with the note at its new pitch.

Duration Tool
The duration tool is the one with the long arrow pointing to the right. It
lets you change the duration of a note. Click the left mouse button on the
note whose duration you want to change. Keep the button down and drag
the end of the note until it is where you want it and then release the button.

Multi Tool
The multi tool is the one at the far right of the toolbar. It combines the EW,
the NS, and the duration tools. If you click on the first third of the note, the
multi tool behaves like the EW tool. (You can move the note back and forth
in time) If you click on the second third of the note, the multi tool behaves
like the NS tool. (You can move the note up and down in pitch.) If you click
on the last third of the note, the multi tool behaves like the duration tool.
(You can change the duration of the note.)



Piano Roll Editor   105

Track Selector List Box

To the right of the tool palette is the track selector list box. Use this to
change to a new track in the Piano Roll Editor. Click on the track selector
list box and then click on the track that you want from the list of tracks that
drops down. When you change the track, the first box of the status line (at
the bottom of the main window) will change, telling you the name and the
number of the track that you are on.

Channel Selector List Box

To the right of the track selector is the channel selector list box. This tells
you what channel or channels are being displayed and edited in the Piano
Roll Editor. Usually the channel is set to All Channels, letting you see and
edit notes on all channels. Use the channel selector to change the display of
the channel. Click on the channel selector list box and then click on the
channel that you want from the list of channels that drops down.

Mouse Time Locator

The mouse time locator shows you the location of the mouse in time in
bars, beats and steps. Notice how this changes as you move the mouse back
and forth in the display.

Pitch Locator

The pitch locator box tells you the location of the mouse in pitch. The
display shows the name of the note and, in brackets, the MIDI note number.
Notice how this changes as you move the mouse back and forth in the
display.

Hide Waves/Show Waves Button

Click on Hide Waves to hide the wave file window. (This will give more
room for the piano roll window.) Click on Show Waves to show the wave
file window.
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Edit Notes/Edit Waves Indicator

This indicator shows you whether you are currently editing waves or notes.
Click in the wave window to edit waves. Click in the note window to edit
notes.

Snap/Free Button

If the Snap/Free button (just below the arrow tool in the control area) is set
to Snap, the start times of the notes you enter are quantized to the value of
the selected duration. If it is set to Free, the start times of the notes you
enter are not quantized and you can enter them at any point in time. The
setting of the Snap/Free button affects the same way the moving of notes
forward or backward in time and the adjusting of the durations of notes.

Wave Files

Wave files can be entered, cut, copied and moved in the wave window of
the Piano Roll Editor. Enter wave files by clicking the left mouse button
when the pencil tool is selected. An Open File dialog box will appear to let
you choose the wave file you want to select. When you select a file it will
show up in the wave window with its name and duration as a thin blue line.
You can delete wave files with the eraser tool or move them around in time
with the EW tool. When the arrow tool is selected you can select waves to
be cut or copied. Later they can be pasted to a new location. The NSEW,
NS, duration and multi tools are not available for editing waves.

Moving Around in the Piano Roll Editor

The horizontal scroll bar is used to move the display forward or backward
in time. Click on the left button and the display will move one bar to the
left. Click on the right button and the display will move one bar to the
right. Clicking to the right of the scroll box will move the display right one
screen. Clicking to the left of the scroll box will move the display left one
screen. Dragging the scroll box will move to any place in the piece. The
time display in the main control area will change as you move the scroll
box. When it is on the bar or time that you want, release the scroll box and
the display will go to this bar with the cursor at the beginning of this bar.
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You can also move to a specific time by clicking on the time display in the
main control area and setting a time to which you want to go.

You can move the cursor forward or backward, by the duration value set in
the durations palette in the main control area, using the LEFT ARROW
key and the RIGHT ARROW key. You can move the cursor forward or
backward, by the score quantization duration (set in the Display Score
dialog under the Display menu), by using CTRL+LEFT ARROW and
CTRL+RIGHT ARROW.

The vertical scroll bar will scroll the display up or down.

Magnifying Glasses

There are four little magnifying glasses in the lower right corner of the
Piano Roll Editor. The two magnifying glasses to the right of the horizontal
scroll bar control the horizontal (time) scale of the piano roll display. Click
the larger magnifying glass to zoom in (show less bars on the screen).
Click the smaller magnifying glass to zoom out (show more bars on the
screen).

The two magnifying glasses below the vertical scroll bar control the vertical
(pitch) scale of the piano roll display. Click the larger magnifying glass to
zoom in (show less pitches on the screen). Click the smaller magnifying
glass to zoom out (show more pitches on the screen).



108 Reference

Keys Used in the Piano Roll Editor

Keystroke Action

UP ARROW Scroll the screen up by one note.

DOWN ARROW Scroll the screen down by one note.

LEFT ARROW Move the cursor to the left one duration
value.

RIGHT ARROW Move the cursor to the right one duration
value.

CTRL+LEFT ARROW Move the cursor to the left by the
quantization amount.

CTRL+RIGHT ARROW Move the cursor to the right by the
quantization amount.

CTRL+PAGE UP Move the display one beat ahead.

CTRL+PAGE DOWN Move the display one beat back.

PAGE UP Scroll the screen up.

PAGE DOWN Scroll the screen down.

F11 Move the display back one screen.

F12 Move the display forward one screen.

HOME Move to the beginning of the piece.

END Move to the end of the piece.

SHIFT+LEFT ARROW Select tool to the left of the selected tool.

SHIFT+RIGHT ARROW Select tool to the right of the selected tool.
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Controller Editor
The Controller Editor can be used to edit all kinds of data of a continuous
nature, including controllers, pitch bend, aftertouch, note velocity, tempo
changes and program changes.

The Controller Editor’s control area has the following features:

• A data type list box.

• A track list box for changing from track to track.

• A channel list box showing the channel or channels being edited.

• A step list box for controlling the spacing between adjacent events.

• A display note list box (only for polyphonic aftertouch).

• A change note list box (only for polyphonic aftertouch).

• A toolbar.

• A mouse position locator showing the time and amplitude of the
mouse.

• An event position locator showing the time and amplitude of the event
closest to the mouse.

• A button to show notes or hide notes in the controller window.
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The Controller Editor’s window has the following features:

• Time is displayed on the horizontal axis.

• Amplitude is displayed on the vertical axis. The amplitude displayed
depends on the kind of data being displayed. For example, pitch bend
data has a range from -8192 to +8192 and controllers have a range of
0 to 127.

• Bar numbers are shown above the display.

• Beats are shown as gray vertical lines.

• Amplitude levels are shown as horizontal lines.

• Controllers or other data are displayed as vertical blue lines.

• Superimposed on the controller display is a piano roll display of the
notes in the current track. This can be turned off by clicking on the
Hide Notes button.

Data Type List Box

The data type list box lets you select the kind of controller or other data you
will be working on in the Controller Editor. Click on the data type list box
and select a controller or other data type by clicking on it. Scroll up or down
with the scroll bar to the right of the list box to find the kind of data you
want.

Track Selector List Box

To the right of the data type list box is the track selector list box. Use this
to change to a new track in the Controller Editor. Click on the track
selector list box and then click on the track that you want from the list of
tracks that drop down. When you change the track, the first box of the
status line (at the bottom of the main window) will change, telling you the
name and the number of the track that you are on.

Channel Selector List Box

To the right of the track selector is the channel selector list box. This tells
you what channel or channels are being displayed and edited in the Piano
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Roll Editor. Use the channel selector to change the display of the channel.
Click on the channel selector list box and then click on the channel that
you want from the list of channels that drops down.

Step List Box

The step list box lets you control the fineness of vertical resolution between
controllers. For example, if the step value is  4, data will not be entered with
the mouse until the vertical difference between the current point and the
previous data point is greater than or equal to  4. A step value of 1 gives you
the finest level of control over your data. A value of  10 gives you the
coarsest level of control. It is sometimes useful to use a step value other
than 1 to avoid clogging your tracks with more controller data than you
need. It is a good idea to economize on controllers and use as few as you
can to achieve the effect you are after.

Display Note List Box

The display note list box is only for polyphonic aftertouch. It is disabled
unless Poly Aftertouch is in the data type list box. It lets you set the pitch
of the polyphonic aftertouch you want to enter or edit.

Change Note List Box

The change note list box is only for polyphonic aftertouch. It is disabled
unless Poly Aftertouch is in the data type list box and if Display All is in
the display note list box. When the change note list box becomes active, if
changes are made to aftertouch data, the new aftertouch data will be
assigned to the note in the change note list box.
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Toolbar

The toolbar in the Controller Editor has six tools.

Arrow Tool
The arrow tool is generally used for selecting events and then editing them
by selecting an editing operation from the edit menu. It is also possible to
select a single event (by double clicking on it) and then edit it by selecting
an operation from the edit menu. When the arrow is selected events can be
entered by dragging with the right mouse.

The cursor point can be moved by pressing the left mouse button or by
using the arrow keys. The cursor always moves in increments of one step.

If you are using any other tool except the arrow tool, use the right mouse
button to position the cursor, because the left mouse button is used for
editing.

To select a group of events you can drag over them using the mouse. Click
before the starting point of the first event that you want to edit, hold the
mouse button down and drag past the starting point of the last event that
you want to edit. You can drag past the end of the window if you want. The
window will scroll if you do this.

While the mouse is being dragged, the HOME, END, F11 and F12 keys
can be used to move around in the Controller Editor to more quickly find
the end of the range.

If you want to select just certain events in your range, hold the CTRL key
down and then click on each event you want to include in your selection. To
delete an event from the selection, just click on it again. When you have
selected all the events you want, release the CTRL key.

Pencil Tool
The pencil tool is used to enter events. Select the pencil tool and click
where you want to enter a single event. You can also drag the mouse to
enter a group of events. When you drag in events, the density of the events
is controlled by the step setting in the step list box.
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Eraser Tool
The eraser tool will erase events. Select the eraser tool and click on an
event you want to erase. The event will disappear. To delete a group of
events in one operation, use the arrow tool to select the events and then
choose Cut from the edit menu.

NSEW Tool
The NSEW tool is the one with the four arrows: one pointing north (up),
one pointing south (down), one pointing east (right) and one pointing west
(left). It moves an event around with complete freedom of movement, that is
you can move it back and forth in time or up and down in amplitude. Select
the NSEW tool by clicking on it and then click the left mouse button on an
event you want to move around. Keep the button down and drag the note to
where you want to put it and then release the button. The display will
redraw with the event in its new position.

When the NSEW tool is selected you can position an event with the arrow
keys. Move the cursor over the event you want to move until it is
highlighted in red. Now you can use the arrow keys to move it or change its
amplitude.

EW Tool
The EW tool is the one with one arrow pointing east (right) and one arrow
pointing west (left). It moves an event forward or backward in time. Select
the EW tool by clicking on it and then click the left mouse button on an
event you want to move forward or backward. Keep the button down and
drag the event to where you want to put it and then release the button. The
display will redraw with the note at its new time.

When the EW tool is selected you can position an event with the LEFT
ARROW key and the RIGHT ARROW key. Move the cursor over the
event you want to move until it is highlighted in red. Now you can use the
LEFT ARROW key and the RIGHT ARROW key to move it back and
forth in time.

NS Tool
The NS tool is the one with one arrow pointing north (up) and one arrow
pointing south (down). It moves an event up or down in amplitude. Select
the NS tool by clicking on it and then click the left mouse button on an
event you want to move up or down. Keep the button down and drag the
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event until it is at the pitch that you want and then release the button. The
display will redraw with the event at its new amplitude.

When the NS tool is selected you can position an event with the UP
ARROW key and the DOWN ARROW key. Move the cursor over the
event you want to move until it is highlighted in red. Now you can use the
UP ARROW key and the DOWN ARROW key to change its amplitude.

Mouse Position Locator

The mouse position locator shows the position of the mouse in time and
amplitude. If you are editing controllers, the name of the controller
represented by the mouse's amplitude is shown as well.

Event Position Locator

The event position locator shows the position in time and the amplitude of
the event closest to the mouse. This event is highlighted in red in the
controller window. If you are editing controllers, the name of the controller
represented by the event's amplitude is shown as well.

Hide Notes/Show Notes Button

Click on Hide Notes to get rid of the piano roll display superimposed on the
controller window. The button now reads Show Notes. Click on it again to
put the notes back. The piano roll display is just for reference. It lets you
line up your controllers with the notes they belong to.
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Keys Used in the Controller Editor

Keystroke Action

UP ARROW Add 1 to the selected event (only with NS or
NSEW tool selected).

DOWN ARROW Subtract 1 from the selected event (only with
NS or NSEW tool selected).

LEFT ARROW Move the cursor to the left one step (with all
tools except EW and NSEW).

Move the selected event one step to the left.
(only with EW or NSEW tool selected).

RIGHT ARROW Move the cursor to the right one step (with
all tools except EW and NSEW).

Move the selected event one step to the right.
(only with EW or NSEW tool selected).

CTRL+PAGE UP Move the display forward one beat.

CTRL+PAGE DOWN Move the display back one beat.

F11 Move the display back one screen.

F12 Move the display forward one screen.

HOME Move to the beginning of the piece.

END Move to the end of the piece.

SHIFT+LEFT ARROW Select tool to the left of the selected tool.

SHIFT+RIGHT ARROW Select tool to the right of the selected tool.
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Track Sheet
The Track Sheet shows you an overview of your tracks and lets you easily
change a lot of the important settings for them.

A new track can be created by clicking on New at the bottom of the list of
track numbers. If you already have sixteen tracks (QuickScore Elite's
maximum), you can't create any new tracks.

You can delete a track by selecting a track by clicking on that track's
number and then pressing the DELETE key. You will be asked to confirm
the deletion of the track before the track is actually deleted.

You can exchange tracks by dragging one track number on top of another.

You can copy one track to another one by holding down the CTRL key and
then dragging one track on top of another. If you do this, the second track is
replaced by a copy of the first track.

Name

You can change the track names by clicking on the Name field and entering
a new name. You can edit characters to the left or right of the end of the
field by dragging the mouse to the left or right, or by moving the cursor left
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or right with the arrow keys. Click outside the field to finish editing the
track name.

You can enter line feeds, sharps, flats, naturals and double sharps in the
name field by preceding the character for each with a backslash. Enter a
line feed by typing “\r”. Enter a sharp by typing “\#”, a flat by typing “\b”
and a natural by typing “\n”. The name will look funny in the name field
but it will appear correctly when it is displayed on the score page in Print
Preview mode.

Play

Each track will play if there is a circle in the Play field. It will be mute if
there is no circle. Click on the Play field to remove or display the circle.

Solo

Click on a track's Solo field to solo that track. A circle will appear in that
field and now only that track will play when you play or record. Click on
the Solo field for another track and the new track will become the solo
track. Revoke the solo status of a track by clicking on the circle in the Solo
field. The circle disappears and no track has solo status.

Mouse+Faders

The mouse+faders field shows you the channel on which events entered
with the mouse or with the faders in the Mixer will appear. Click on the
mouse+faders field and a list box will appear allowing you to change the
channel. If you change the channel, you are given the opportunity to set the
channel for all data that is already on the track to the new channel. Usually
it is good practice to keep all data on a track on the same channel. However,
QuickScore Elite does allow you to have data on more than one channel on
the same track.

Program

The name of the initial program change for each track is displayed in the
program field. If there is a little dash in the field, there is no program
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change at the beginning of the track. If you want to choose a new program
for your track, click on the program field and a drop-down list box will
appear. Select the new program you want. This program change will be
entered at the beginning of the track with the Mouse+Faders channel.

You can choose your program names so that they correspond to the
instrument(s) you have in your setup using the Patch Lists dialog. (See
“Patch Lists” on page 204 and “PATCHES.INI” on page 217 for details.)

Volume

This is where the initial volume for your track is displayed. If a dash is
displayed in this field, there is no volume controller at the beginning of the
track. If you want to change the initial volume for your track, click on the
volume field and enter a new volume. A new volume controller will be
entered at the beginning of the track on the Mouse+Faders channel.
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Mixer
You use the Mixer to make changes to controllers and other continuous
data, such as pitch bend or aftertouch, as you listen to your music. You can
use the Mixer while playing or recording. Moving the sliders while
recording will record the changes you make and affect playback at the same
time. You can also use the Mixer while playing, and in this case it will only
change the playback sound; it will not change any data. This is useful to test
any changes before you record them.

The Mixer has a control area with the following features:

• A data type list box.

• Two buttons for grouping your faders.

• Two buttons for taking and recalling snapshots of your faders.

There are sixteen faders, one for each possible track. Only the faders for
tracks defined in your piece can be moved. Each fader that can be moved
has either a red or a green line through its slider button. The line in the
middle of the last fader you selected is green, and all the others are red. You
play the faders by dragging the slider button up and down with the mouse,
as you would real faders in a mixing console. As you drag a fader, MIDI
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events are sent out and you can hear them affect your music. For example, if
7 Main Volume is selected in the data type list box and you drag fader
number one from top to bottom as you play, you will send out a number of
main volume control changes starting at 127 (the top) and ending at 0 (the
bottom) on track one. This will make the volume on track one fade away to
nothing.

Note that when you are recording, previously recorded controllers are
erased only as long as you hold down the mouse button on a fader. While
you have the mouse button released, any controllers already in the track will
not be affected.

Above each fader is a little box that can be checked or unchecked by
clicking the mouse in the box. Checking faders is used to group faders
together for moving. If more than one fader is checked, moving one
checked fader will move all checked faders. You can use the Group All
button to group all faders and the Clear All button to ungroup all faders.

Below each fader are three dedicated pan pots, which show volume,
expression and pan. You can move these by grabbing them with the mouse
and twisting in a circle. (Click the left mouse button where the indicator
line meets the edge of the pan pot, hold the button down and drag around
the pan pot.)

The fader channel for each track is set in the Track Sheet in the
Mouse+Faders channel field.

You can mute the current track (the one with the green line in the middle of
the fader’s thumb) by pressing M. You can solo the current track by
pressing S. This can be done in all the editing windows, but you will
probably find it especially helpful when you’re using the Mixer.

Data Type List Box

The data type list box lets you select the kind of controller or other data you
will be working on in the Mixer. Click on the data type list box and select a
controller or other data type by clicking on it. Scroll up or down with the
scroll bar to the right of the list box to find the kind of data you want.
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Group All Button

The Group All button groups together all faders. A check is put in each box
above each fader and now moving one fader will move all faders.

Clear All Button

The Clear All button clears all the group buttons. Now moving a slider will
affect only this fader's track.

Snapshot Button

Use the Snapshot button to insert single controller values into your tracks.
First select the time at which you want to insert your controllers by clicking
on the time display in the main control area and setting the time you want.
Select the controller type you want in the data type list box, then move the
faders to the positions you want. Now click on the Snapshot button.

Recall Button

When you take a snapshot, the position of the faders and their groupings is
saved. This snapshot can be recalled later with the Recall button.

Keys Used in the Mixer

Keystroke Action

UP ARROW Increase the value of the fader by one. This only
works if the left mouse button is held down on a
fader.

DOWN ARROW Decrease the value of the fader by one. This only
works if the left mouse button is held down on a
fader.

HOME Move to the beginning of the piece.

END Move to the end of the piece.
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Event List

The Event List's control area consists of the following features:

• A track selector list box.

• An event type filter list box.

• A channel list box.

The track selector list box is used to change the track being viewed and
edited. The event type filter list box allows the selective viewing and
editing of different types of event data. The channel list box allows you to
view and edit data on selected channels.

The body of the Event List is the list of events themselves. For each event,
the SMPTE time and the Bars:Beats:Steps time is displayed on the left.
Then the channel is displayed (if applicable), then the event type and as
much information on the contents of the event as possible in the Values
field.

Each different type of event has a different color to more easily distinguish
between different events in the list.

Each event can be edited individually by double clicking on it and editing
values in the subsequent dialog box. The dialog box associated with each
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event is different because the information in the event is different, but each
dialog contains the SMPTE time and Bars:Beats:Steps time as well as
fields that pertain to the specific event type. For example, note events have
fields for channel, note number, velocity and duration while program
change events have fields for channel and program number.

Events can be selected for cutting and copying by clicking on the first event
to be selected and dragging the mouse with the left button down until the
last event has been selected.

While the mouse is being dragged, the HOME, END, F11, F12, PAGE UP
and PAGE DOWN keys can be used to move around in the Event List to
more quickly find the end of the range.

When you have finished selecting a range of events a menu of two items
will drop down from the edit menu. Now you can cut your events or copy
them to be pasted later.

You can paste events anywhere in the Event List. Set the time at which you
want to paste your selection by clicking on the time display in the main
control area.

Colors Used in the Event List

Event Color

Notes Black

Text Dark blue

Lyrics Dark blue

Expressions Dark blue

Symbols Pink

Clefs Pink

Controllers Light blue

Pitch Wheel Green

Channel Aftertouch Reddish purple

Polyphonic Aftertouch Reddish purple

Program Changes Red
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Tempo Changes Light purple

Waves Light purple

Keys Used in the Event List

Keystroke Action

UP ARROW Move the display back one event.

DOWN ARROW Move the display forward one event.

PAGE UP Move the display back one screen.

PAGE DOWN Move the display forward one screen.

F11 Move the display back one screen.

F12 Move the display forward one screen.

HOME Move to the beginning of the piece.

END Move to the end of the piece.
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Song Editor

The Song Editor shows an overall view of your music. On the left side of
the window is a list of tracks and beside each track is a horizontal  list of
bars.

Each bar is filled in with colored rectangles if there are notes or other
events present in the bar. Different colors denote different kinds of musical
data.

Editing takes place in the Song Editor by selecting a number of bars in one
or more tracks by dragging the mouse.

While the mouse is being dragged, the HOME, END, F11, F12, PAGE UP
and PAGE DOWN keys can be used to move around in the Song Editor to
more quickly find the end of the range.

Select an edit operation (Cut, Copy, or Insert Space) from the edit menu to
complete the operation. Each track has a check box beside it. If one or
more check boxes are checked, then selecting with the mouse will affect
only the tracks that are checked. You can check all tracks for editing by
clicking on the Select All button in the control area of the Song Editor, or
uncheck all tracks by clicking on the Clear All button. If no bars are
checked then you must select the tracks that you want to edit by dragging
the mouse over them. In this case the tracks being edited must, of course, be
contiguous.

Pressing the right mouse button on a bar in the Song Editor will bring up
a flyaway list of four of QuickScore Elite's editors: Score Editor, Piano
Roll Editor, Controller Editor and Event List. Choosing one of these
from the list will bring up that editor, with the cursor on the track and bar
at which the mouse was pointing when you clicked the right mouse button.
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Colors Used in the Song Editor

Event Color

Notes Black

Text Dark blue

Lyrics Dark blue

Expressions Dark blue

Symbols Pink

Clefs Pink

Controllers Light blue

Pitch Wheel Green

Channel Aftertouch Reddish purple

Polyphonic Aftertouch Reddish purple

Program Changes Red

Tempo Changes Light purple

Waves Light purple
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Keys Used in the Song Editor

Keystroke Action

UP ARROW Move the cursor to the track above.

DOWN ARROW Move the cursor to the track below.

LEFT ARROW Move the cursor to the left one bar.

RIGHT ARROW Move the cursor to the right one bar.

PAGE UP Move the display back one screen.

PAGE DOWN Move the display forward one screen.

F11 Move the display back one screen.

F12 Move the display forward one screen.

HOME Move to the beginning of the piece.

END Move to the end of the piece.
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Comments Window

The Comments Window is useful for writing notes to yourself or to others
about your composition. You can write about three hundred words here.
You write and edit here as you would using a simple Windows text editor.
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Menus
Along the top of QuickScore Elite's main window is the menu. You can
select an item from the menu by clicking the mouse on the name of the
menu from which you want to select, and then clicking on the menu item
you want from the menu that drops down. You can also select a menu by
holding down the ALT key and pressing the key that is underlined in the
menu name. When the menu drops down you can select a menu item by
pressing the key that is underlined in the menu item name. There are also
menu shortcut keys. These are written to the right in the menu item. For
example, you can press CTRL+N (Hold down the CTRL key and press N)
to select the New menu item under the File menu.

File Menu

New
New is for starting work on a new file. If you haven't saved your work when
you select New, you are first given a chance to do so. Then you are given a
choice of the initial layout for your new score. You can choose the default
settings, the current settings, or you can use one of several preset templates .
The templates are for different instrumental combinations, like String
Quartet, Choral Ensemble, or Classical Band. Choose the default score
settings to set all the display options under the Display menu to the defaults
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(the same as when you first load the program). Choose the current score
settings to keep the settings you are currently using. Choose a template to
set the display options as well as number of tracks, names of tracks, and
patches to those of the template file. You can easily add a template file or
modify the existing ones. See “Appendix 1: Template Files” on page 215 for
details on doing this.

Open
Select Open from the File menu to bring up the Open dialog.

You select the file type to load from the drop-down list box at the bottom of
the file dialog. You can open two different types of files.

• QSD file.

QSD files have the file extension .QSD. They are the native files of
QuickScore Elite.

• MIDI file.

MIDI files have the file extension .MID. They are generic files
that can be loaded and saved by music programs from a variety of
vendors.

If the MIDI file you open is a type 0 MIDI file, a dialog appears which
allows you to split the tracks into separate tracks for each channel. This
way, MIDI data on each channel will appear on a separate track. If you
open a type 2 MIDI file, QuickScore Elite only imports the first pattern. For
more information regarding MIDI file types, see “ About Standard MIDI
Files” on page 222.
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Before a new file is opened, the previously opened file is discarded from
memory. If the old file has changed since it was last saved, you are asked if
you want to save it. Choose Yes, No or Cancel. If Cancel is chosen, the
new file will not be opened. Only one file can be open at a time.

For more detailed information on the Open File dialog see your Windows
User's Guide.

Save
Choose Save to save your file. If you have not named your file yet, the Save
As dialog appears and you will be able to give a name to your new file
before you save it.

Save As
Choose Save As when you want to save your work to a file with a new
name. You can also use this menu option if you haven't already named your
file and you want to save it.
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You can save your file as one of three different types:

• QSD file.

QSD files have the file extension .QSD. They are the native files of
QuickScore Elite. All your formatting information is conserved if
you choose QSD file. You will normally save your files as QSD
files.

• MIDI file.

MIDI files have the file extension .MID. They are generic files
that can be loaded and saved by music programs from a variety of
vendors. If you save your work as a MIDI file your formatting
information will be lost.

• Copyist file.

Copyist files have the file extension .CP3. They are files for the
Copyist music publishing program. Use Copyist if you want to fine
tune scores in ways that you may be unable to do using QuickScore
Elite.

Choose the new name of the file and press OK. If the file already exists you
will be asked if you want to write over the old file. For more detailed
information on the Save As dialog see your Windows User's Guide.

Export Picture
You can export either a line of music or a page of music. To export a line,
make sure you are not in Print Preview mode. In this mode, only the system
of music that you see in the Score Editor window will be exported. Titles
and page numbers will not appear. To export a page, make sure you are in
Print Preview mode. In this mode, the full page of music appearing in the
Score Editor, including page numbering and titles, will be exported.

Select the resolution you want from the submenu. Bear in mind that the
quality of the image and the size of the file generated increase with the
resolution.

A file selection dialog box appears. In the Save File as Type list box select
either BMP or TIFF. Now enter the name of the file to which you wish to
save your line or page and click on OK or press Enter.

You can now import your saved score into another application. To do this,
follow the directions specified in the documentation for this application.
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Print File
Select Print File to print your piece. You will see the standard Windows
Print dialog.

Make sure you have set up your print the way you want it (correct printer,
pages, number of copies, etc.) and press OK to print. For more detailed
information on the Print dialog see your Windows User's Guide.

On some printers you can select the staff size for your printout. This is done
by changing the Scaling (%) box in the Options dialog. This changes the
aspect ratio of the music by stretching in the y direction while keeping the x
direction constant. The Options dialog is available for some printers when
you select the Setup button in the Print dialog and then the Options button
in the Print Setup dialog that appears.
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Print Part
Print Part allows you to print a group of tracks. These tracks need not be
contiguous. The Parts dialog appears after selecting Print Part.

Select the tracks that you want to print by dragging over contiguous tracks
and CTRL clicking non-contiguous tracks, or to erase selected tracks. Of
course if you just want to print one track, just click on that track. When you
have selected the tracks you want to print out, click on OK. It will take a
second or two to set up the tracks selected for printing, and then the
Windows Print dialog will appear. Make sure you have set up your print the
way you want it (correct printer, pages, number of copies, etc.) and press
OK to print.

Note: You can print a one-track part by setting the Score button in the
Score Editor to Single Track mode and then selecting the Print File menu
item.

Print Line
Use Print Line to print just the line of music you see in the Score Editor
when you are in Edit mode. This lets you make a quick copy of what’s on
the screen as you’re editing.
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Print Setup
Select Print Setup to brings up the Windows Print Setup dialog.

This allows you to change aspects of your printing which depend on your
printer. For more detailed information on the Print Setup dialog, see your
Windows User's Guide.

On some printers you can select the staff size for your printout. This is done
by changing the Scaling (%) box in the Options dialog. This changes the
aspect ratio of the music by stretching in the y direction while keeping the x
direction constant. The Options dialog is available for some printers when
you select the Options button in the Print Setup dialog.

Print Preview
Selecting Print Preview is the same as selecting the page button in the
Score Editor. When Print Preview is selected, the Score Editor displays
your score as it would look when it is printed. You can see the full page in
the Score Editor by selecting the 100% button.

Exit
Select Exit from the File menu to exit the program. If the current file has
changed since it was last saved, you are asked if you want to save it. Choose
Yes, No or Cancel. If you choose Cancel, you will not exit from the
program.
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File 1, 2, 3, 4
If you have already opened or saved one or more files, the names of the last
files that you looked at are displayed in menu items at the end of the File
menu. Selecting any of these loads the file. If you work on the same files a
lot, this saves you a lot of trouble finding and opening up your files using
the Open File dialog.

Edit Menu

When you select an object or a group of objects in the Score Editor, the
Piano Roll Editor, the Controller Editor, the Event List, or the Song Editor,
an edit menu will drop down. The entries in the edit menu depend on what
editor you are using and what kind of object(s) you are editing. These
menus are called the block editing menus. In addition to the block editing
menus there is the standard Edit menu that is accessed directly from the
main menu.

The standard Edit menu contains the following entries:

Undo
Undo negates the last editing operation that was performed. You can undo
an Undo operation.

Note: Undo only affects operations that affect real data, not operations that
affect the appearance of data. Changes to the way music is displayed, made
using the dialogs accessed from the Display menu, are not affected by
Undo.

Paste
Paste takes the data that was saved to the clipboard using the last cut or
copy operation and pastes it into the current track at the current time.
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Make sure you position your cursor on the right track and at the right time
before you paste your data.

When data is cut or copied, leading rests are eliminated. When you paste,
the first event that was saved is placed at the cursor position.

Block Start

Block End
When you are in the Score Editor, you can select a range by moving the
cursor to where you want your range to start, selecting Block Start, then
moving the cursor to where you want your range to end and selecting Block
End. When you select Block End, a block editing menu will drop down,
allowing you to select an edit operation. The edit menu that drops down will
depend on the kind of objects you are editing. (This is set by clicking on an
icon in the object type palette.)

Select Last Range
After you finish an edit operation, the highlighted range disappears and you
are left with the edit cursor. If you want to select the range you last set (by
dragging the mouse or using Block Start and Block End) without redoing
it again, click on Select Last Range. The range will become highlighted
and an edit menu will drop down for you to perform another edit operation.



138 Reference

Note Filter
If you are in the Score Editor and you are in Note mode (the note in the
object type palette is selected), or if you are in the Piano Roll Editor, you
can select the note filter. The Note Filter menu item is checked when the
note filter is selected.

The note filter lets you pick only notes which satisfy a certain criteria when
you are selecting notes. For instance, you can decide to select all the notes
in your track on channel 12, or select all the notes higher than middle C.

To activate the note filter, put a check in the box to the left of Use Filter in
the top part of the Note Filter dialog. When the note filter is active you can
filter on pitch, velocity, channel, beat, step, or voice or any combination
of the above. Check the filter type you want to use and then set the filter the
way you want it. For example, if you want to only edit notes above
middle C, make sure Pitch is checked and then put a 61 in the From box
and 127 in the Thru box to the right of Pitch. If you want to edit notes
equal to or below middle C, check the Not box for pitch and you will get
the opposite of what you selected before, that is notes equal to or below
middle C.
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Lyric Filter
If you are in the Score Editor and you are in Lyric mode (the L in object
type palette is selected), you can select the lyric filter. The Lyric Filter
menu item is checked when the lyric filter is selected.

The lyric filter lets you selectively edit one or more of your lyric lines. For
example, you may have entered four lines of lyrics and you want to delete
the second line of lyrics. You can do this by activating the lyric filter and
then selecting only the Lyric 2 lyric. To activate the lyric filter put a check
in the box to the left of Use Filter in the top part of the Lyric Filter dialog.
Make sure that only the lyric lines that you want to select are checked. Click
on the box to the left of the lyric line you want to check or uncheck.
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Text Filter
If you are in the Score Editor and you are in Text mode (the T in object
type palette is selected), you can select the text filter. The Text Filter menu
item is checked when the text filter is selected.

The text filter lets you selectively edit block text based on style. For
example, you may have entered four different styles of text and you want to
delete all the text you entered in the second style. You can do this by
activating the text filter and then selecting only Block Text 2. To activate
the text filter put a check in the box to the left of Use Filter in the top part
of the Block Text Filter dialog. Make sure that only the block text styles you
want to select are checked. Click on the box to the left of the block text
number you want to check or uncheck. Recall that each block text number is
associated with a text style. This text style can be seen by looking in the list
box on the far right of the Score Editor’s control area. The text styles can be
changed by clicking on the Fonts button in the Display Score dialog
available from the Display menu.

Block Editing Menus

The block editing menus drop down when you select an object or a group
of objects. You select an individual object by double clicking on it. You
select a group of objects by dragging over them with the mouse. You can
select non-contiguous items by control-clicking, that is, by holding down
the CTRL key and then clicking on each object you want to include (click
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again on an object that you included by mistake to exclude it). Release the
CTRL key to finish your selection.

The menu that drops down after you make a selection is context-sensitive.
The Piano Roll Editor, the Controller Editor, the Event List and the Song
Editor all have different menus. In the Score Editor there are different
menus for notes, lyrics, expressions, text, symbols and clefs.

Note: When you are in the Score Editor, make sure that the object type
palette is set to the kind of object you are trying to edit. Otherwise the menu
you get will not be the one you want. This is important to remember. If you
set a range that doesn't contain any of the objects you are trying to edit you
will get a minimal menu, containing only the Stretch Time menu item.

Note Block Editing Menu

The Note block editing menu drops down when editing notes in the Score
Editor, that is, when one or more notes are selected and the note is selected
in the object type palette in the Score Editor’s control area. A subset of the
note block editing menu also drops down when editing notes in the Piano
Roll Editor.
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Cut [Note]
Cut will erase the selected notes from the current track and copy them to
the clipboard. They can be pasted somewhere else in the music by using
Paste, available under the standard Edit menu.

Copy
Copy will copy the selected notes from the current track to the clipboard.
They can be pasted somewhere else in the music by using Paste, available
under the standard Edit menu.

Transpose
Select Transpose to bring up the Transpose dialog.

Drag the note up and down in the window that appears or use the
+ (plus)and - (minus) buttons to move the note up or down chromatically.
You can also use the up and down arrow keys to move the note up or down
chromatically. All notes selected will be transposed up or down by the same
amount.
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Shift
Select Shift to bring up the Shift dialog. This is similar to the Transpose
dialog, except that notes are moved up and down in key, not chromatically.
Drag the note up and down in the window that appears or use the
+ (plus)and - (minus) buttons to move the note up or down in key. You can
also use the up and down arrow keys to move the note up or down in key.
All notes selected will be shifted up or down in key by the same amount.

Octave
When you select Octave, a submenu appears to the right of the menu,
allowing you to move the selected note or notes up or down one or two
octaves.

Duration
When you select Duration, a dialog appears that allows you to change the
duration of the selected note or notes to a certain value. All notes selected
are set to the new duration.

Time
When you select Time, a submenu appears to the right of the menu, which
allows you to stretch or contract the start times and durations for the
selected notes. You can multiply or divide the times by three or two. For
example, if you multiply the selected notes by two, they will all become
twice as long as before and they will be shifted over to fit. When these notes
play, they will play at half speed because each note is twice as long. The
separation between the notes is doubled as well.
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Velocity
When you select Velocity, a dialog appears that allows you to change the
velocity of the selected note or notes to a certain value. All notes selected
will be set to the new velocity.

Quantize
Select Quantize if you want to physically quantize the selected notes. When
notes are quantized to a certain value, the start time for the note is a
multiple of the quantization value and the duration of the note is a multiple
of the quantization value. Quantizing the selected notes to 64th means that
the start time and durations of the notes will be multiples of 64ths.

A submenu will appear to the right of the menu, showing all the
quantization options. The checked quantization value is the current display
quantization. (This can be changed using the Display menu.)

Channel
Select Channel to set all the selected notes to a particular MIDI channel. A
submenu will appear to the right of the menu, allowing you to choose any of
sixteen channels. The checked channel is the channel of the first note
selected.

Voice
Select Voice to set all the selected notes to a particular voice. A submenu
will appear to the right of the menu, allowing you to set the voice to
default, 1, 2, or grace notes. The checked voice is the voice of the first note
selected. Notes set to voice 1 all have stems drawn up by default; Notes set
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to voice 2 all have stems drawn down by default. Notes set to default will be
either up or down, depending on their position on the staff. Grace notes will
be drawn at reduced size and will not be accompanied by rests.

Group
Select Group to group the selected notes together in a particular way. When
you group notes, you can make them all small (select Small Notes from the
submenu) or normal size (select Big Notes from the submenu). After
selecting the size, you get another submenu with four items. Choose Default
Group to reset the grouping to the default, that is, to have the selected notes
grouped by beat. (See “Beat” on page 176 for more information.) Select
Stems Up to have the selected notes grouped together with stems up. Select
Stems Down to have the selected notes grouped together with stems down.
Select Default Stems to have the selected notes grouped together with stems
up or down depending on what voice they form part of and where the notes
appear on the staff. (Voice 1 has stems up by default, voice 2 has stems
down by default and the default voice has stems either up or down. See “ Use
Ascending or Descending Stems” on page 178 for more information.)

Staff
If you select notes in a split track (see “Split Track” on page 183), you can
select Staff. This lets you change the way notes are assigned to the treble or
bass staves in a split track.

To put a note on either side of a split track regardless of its pitch, select the
note(s) and choose Staff from the edit menu. The note is moved to the bass
staff by selecting Bass and to the treble by selecting Treble from the
submenu which appear to the right of the menu. Selecting Default makes
the note go to the treble staff if it is greater than or equal to middle  C, and
to the bass staff if not.

You can also have cross-staff beaming on split tracks. This is done by
selecting the note(s) in the bass staff you want to have connected to notes in
the treble staff, choosing Staff from the edit menu and then selecting
Crossed from the submenu. (Only notes that are beamed together can be
crossed.) When you want to do cross-staff beaming, make sure you only
select notes on one staff, not both. If you choose notes on both staves, the
crossing effect will cancel itself out.
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Accidental
QuickScore Elite automatically chooses accidentals and displays them. If
you don't like the accidentals that have been chosen for you, you can change
them by choosing Accidental. You can only choose Accidental if you have
selected a note by double-clicking or a group of notes by control-clicking.

When you choose an accidental that doesn't work for the note you have
chosen, the note will be displayed with the accidental that most closely
resembles the one you chose. For example, if you choose Double Sharp for
a note with MIDI number 58 (that can be notated as B flat, C double flat or
A sharp), you will get A sharp.

If you choose Display Accidental, the accidental for the note will be
displayed regardless of its accidental and what notes have appeared before
it. If you choose Hide Accidental, the note will be displayed without an
accidental, even if it normally would have one. This is useful when you are
displaying the same note with the same accidental in two different voices at
the same time and they have been moved apart so that they do not appear on
top of each other.

Note: Changing the accidental for a note doesn’t change the pitch of the
note; it just changes the way it is displayed. To change the pitch of a note,
use the NS tool or the Transpose or Shift edit command.

Make Legato
Selecting Make Legato will eliminate space between the end of selected
notes and the start of the next note. Also, if there is overlap between a note
and the next note, this will be eliminated. You cannot make the last note in
a track legato, because it can't be extended to another note.

Play
Selecting Play will play the range selected.
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Explode

Use the Explode Track dialog to extract the individual notes of chords that
you have entered on one track and place them onto a number of tracks
where they will appear as single notes, one note per track. For example, you
can spread a three-note C major chord with the notes C4, E4 and G4 on
track 1 onto tracks 1, 2 and 3 so that C4 is on track 1, E4 is on track 2 and
G4 is on track 3.

Set the source track using the drop-down list box at the top left-hand side
of the dialog. Set the destination tracks by selecting track numbers in the
middle of the dialog. You can set tracks by dragging over the ones you want
or by control-clicking, that is, holding down the CTRL key and then
clicking on the track numbers you want to select. Use this method to select
non-contiguous destination tracks.

Set the explode order by selecting either Top to bottom or Bottom to top.
If you select Top to bottom, the highest note of each source chord found
will go onto the first destination track, the second note will go onto the
second destination track and so on. If there are more notes in the source
chord than destination tracks, the last notes will all end up on the last track.
If there are less notes than tracks, the last tracks will not get any notes. If
you select Bottom to top, the lowest note found will go onto the last
destination track, the second lowest note will go on the second to last
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destination track, and so on. Extra notes will all end up on the first track
and if there are less notes than tracks, the first tracks will not get any notes.

Check the Delete Source box if you want to get rid of the chord(s) you are
exploding. Normally you will do this, especially if the source track is also
one of the destination tracks (which is perfectly valid). If you don't delete
the source, of course you will have duplicates of all your source notes on the
destination tracks.

Implode
Imploding music is the opposite of exploding music. The Implode Tracks
dialog lets you take notes from a number of tracks and put them all together
(implode them) on a single track.

Set the source tracks by selecting track numbers at the left-hand side of the
dialog. You can set tracks by dragging over the ones you want or by control-
clicking, that is, holding down the CTRL key and then clicking on the
track numbers that you want to select. Use this method to select non-
contiguous destination tracks. Set the destination track using the
Destination Track drop-down list box in the middle of the dialog.

If you want to delete all the selected notes on the source tracks, check the
Delete Source box. Otherwise leave the Delete Source box unchecked.
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Stretch Time
The Stretch Time dialog allows you to set a section of music to last a set
period of time. This is done by altering the tempo(s) present during this
section of music to make the music fit.

Set the beginning and end points of the section of music you are trying to fit
(in Bars:Beats:Steps) and then set the time you want the section of music to
last (in SMPTE time format).

Lyric Block Editing Menu

The Lyric block editing menu drops down when editing lyrics, that is,
when one or more lyrics are selected and the L is selected in the object type
palette in the Score Editor’s control area.



150 Reference

Cut [Lyric]
Cut will erase the selected lyrics from the current track and copy them to
the clipboard. They can be pasted somewhere else in the music by using
Paste, available under the standard Edit menu.

Copy
Copy will copy the selected lyrics from the current track to the clipboard.
They can be pasted somewhere else in the music by using Paste, available
under the standard Edit menu.

Move
Selecting Move brings up the Move dialog. Drag the lyric up and down in
the window that appears or use the + (plus)and - (minus) buttons to move
the lyric up or down. You can also use the up and down arrow keys to move
the lyric up or down. All lyrics selected will be moved up or down by the
same amount.

Edit
Choosing Edit lets you edit the first lyric selected.

Lyric Number
When you choose Lyric Number a submenu will appear to the right of the
menu containing the four possible lyric numbers. Set the selected lyrics to
the number you want. You can change the lyric number of a given lyric so
that when you apply an operation to that lyric number (all lyrics for a given
verse normally appear at the same level and have the same lyric number),
the lyrics that you changed to that number will also be affected.

Stretch Time
The Stretch Time dialog allows you to set a section of music to last a set
period of time. This is done by altering the tempo(s) present during this
section of music to make the music fit.

Set the beginning and end points of the section of music you are trying to fit
(in Bars:Beats:Steps) and then set the time you want the section of music to
last (in SMPTE time format).
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Expression Block Editing Menu

The Expression block editing menu drops down when editing expressions,
that is, when one or more expressions are selected and the E is selected in
the object type palette in the Score Editor’s control area.

Cut [Expression]
Cut will erase the selected expressions from the current track and copy
them to the clipboard. They can be pasted somewhere else in the music by
using Paste, available under the standard Edit menu.

Copy
Copy will copy the selected expressions from the current track to the
clipboard. They can be pasted somewhere else in the music by using Paste,
available under the standard Edit menu.

Move
Selecting Move brings up the Move dialog. Drag the expression up and
down in the window that appears or use the + (plus)and - (minus) buttons to
move the expression up or down. You can also use the up and down arrow
keys to move the expression up or down. All expressions selected will be
moved up or down by the same amount.

Stretch Time
The Stretch Time dialog allows you to set a section of music to last a set
period of time. This is done by altering the tempo(s) present during this
section of music to make the music fit.

Set the beginning and end points of the section of music you are trying to fit
(in Bars:Beats:Steps) and then set the time you want the section of music to
last (in SMPTE time format).
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Text Block Editing Menu

The Text block editing menu drops down when editing text, that is, when
text is selected and the T is selected in the object type palette in the Score
Editor’s control area.

Cut [Text]
Cut will erase the selected text from the current track and copy it to the
clipboard. It can be pasted somewhere else in the music by using Paste,
available under the standard Edit menu.

Copy
Copy will copy the selected text from the current track to the clipboard. It
can be pasted somewhere else in the music by using Paste, available under
the standard Edit menu.

Move
Select Move to bring up the Move dialog. Drag the text up and down in the
window that appears or use the + (plus)and - (minus) buttons to move the
text up or down. You can also use the up and down arrow keys to move the
text up or down. All text selected will be moved up or down by the same
amount.

Edit
Choose Edit to edit the first text block selected.
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Text Number
When you choose Text Number, a submenu appears to the right of the
menu containing the eight possible text numbers. Set the selected text to the
number you want. Normally you would change the text number of a given
text block so that it would have the font of the new text number.

Stretch Time
The Stretch Time dialog allows you to set a section of music to last a set
period of time. This is done by altering the tempo(s) present during this
section of music to make the music fit.

Set the beginning and end points of the section of music you are trying to fit
(in Bars:Beats:Steps) and then set the time you want the section of music to
last (in SMPTE time format).

Symbol Block Editing Menu

The Symbol block editing menu drops down when editing symbols, that is,
when one or more symbols are selected and a symbol is selected in the
object type palette in the Score Editor’s control area.

Cut [Symbol]
Cut will erase the selected symbols from the current track and copy them to
the clipboard. They can be pasted somewhere else in the music by using
Paste, available under the standard Edit menu.

Copy
Copy will copy the selected symbols from the current track to the
clipboard. They can be pasted somewhere else in the music by using Paste,
available under the standard Edit menu.
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Move
Select Move to bring up the Move dialog. Drag the symbol up and down in
the window that appears or use the + (plus)and - (minus) buttons to move
the symbol up or down. You can also use the up and down arrow keys to
move the symbol up or down. All symbols selected will be moved up or
down by the same amount.

Edit
If you double click on an adjustable symbol or a chord, guitar chord,
metronome marking or figured bass symbol, the edit menu contains the
option Edit instead of Move. The adjustable symbols are the ones that
appear in the Adjustable symbols palette. (Click on the symbol button in
the object type palette in the Score Editor’s control area, then on the Adjust
symbol palette name and the Adjustable symbols palette will appear.) The
chord, guitar chord, metronome marking, and figured bass symbols are
on the bottom of the Miscellaneous symbols palette.

When you select Edit after you have selected an adjustable symbol, you can
edit the adjustable symbol. Three control points (shaped like diamonds)
appear at the left, in the center and at the right of the symbol you are
editing. You can move these control points around on the screen to change
the shape and the position of the symbol you are editing. Click on a control
point to select it and then drag it around by holding the left mouse button
down and moving the mouse. Alternatively you can move a control point
around using the arrow keys. You can move between control points by using
the TAB and the SHIFT+TAB keys as well as by clicking on them with the
mouse.

When you are finished editing the adjustable symbol, press ENTER or click
the right mouse button to accept your changes, or press ESC to leave the
symbol the way it was before you edited it.

When you are editing the slur symbols, you can automatically position the
left slur point over the closest note by pressing Z. You can automatically
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position the right slur point over the closest note by pressing X. You can
automatically center the slur by pressing V. If the slur is above the notes,
the slur end points go over the closest notes when you press Z and X. If the
slur is below the notes, the slur end points go under the closest notes when
you press Z and X.

When you are editing the 8va and 8vb symbols, you can control whether or
not the 8va or 8vb text is shown and whether or not the finishing vertical
line is displayed. The HOME key toggles whether the 8va is shown; the
END key toggles whether the finishing vertical line is displayed. This is
useful when octava markings extend over more than one line.

When you are editing first and second endings  you can change or eliminate
the ending number. The ending number defaults to  1. for the first ending
and 2. for the second ending. The numbers can be changed or eliminated by
pressing the + (plus) and the - (minus) keys.

You can put in and change the number for groupings by using the
+ (plus)and - (minus) keys. Pressing + (plus) increments the number,
pressing - (minus) decrements it. When you decrement past  1, the number
disappears. You can change or eliminate the amount of space in the middle
of the grouping by using PAGE UP and PAGE DOWN.

PAGE UP and PAGE DOWN also work on crescendo and decrescendo
symbols to change the angle of the symbol.

Press F to flip a number of adjustable symbols. These include the crescendo
and decrescendo symbols, the groupings, the endings and the octavas.

Press L to horizontally level crescendos, decrescendos and groupings.

If you select Edit when you are editing one of the chord, guitar chord,
metronome marking, or figured bass symbols, a dialog will appear to let
you edit the symbol. See “Entering Symbols” starting on page 87 for details
on how to use these dialogs.

Stretch Time
The Stretch Time dialog allows you to set a section of music to last a set
period of time. This is done by altering the tempo(s) present during this
section of music to make the music fit.

Set the beginning and end points of the section of music that you are trying
to fit (in Bars:Beats:Steps) and then set the time you want the section of
music to last (in SMPTE time format).
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Clef Block Editing Menu

The Clef block editing menu drops down when editing clefs, that is when
one or more clefs are selected and a clef is selected in the object type palette
in the Score Editor’s control area.

Cut [Clef]
Cut will erase the selected clef(s) from the current track and copy them to
the clipboard. They can be pasted somewhere else in the music by using
Paste, available under the standard Edit menu.

Copy
Copy will copy the selected clef(s) from the current track to the clipboard.
They can be pasted somewhere else in the music by using Paste, available
under the standard Edit menu.

Stretch Time
The Stretch Time dialog allows you to set a section of music to last a set
period of time. This is done by altering the tempo(s) present during this
section of music to make the music fit.

Set the beginning and end points of the section of music you are trying to fit
(in Bars:Beats:Steps) and then set the time that you want the section of
music to last (in SMPTE time format).
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Controller Block Editing Menu

After you have selected one or more data item using the Controller Editor
the Controller block editing menu will drop down. In the discussion of the
controller block editing menu items we talk about controllers, but we could
be talking about any of the data which can be edited using the Controller
Editor, i.e. pitch wheel, channel or key aftertouch, tempo change, program
changes, note velocity or controllers.

Cut
Cut will erase the selected controllers from the current track and copy them
to the clipboard. They can be pasted somewhere else in the music by using
Paste, available under the standard Edit menu.

Copy
Copy will copy the selected controllers from the current track to the
clipboard. They can be pasted somewhere else in the music by using Paste,
available under the standard Edit menu.

Interpolate
Choose Interpolate to create a ramp of values between the first and last
controller selected. Interpolate won't do anything if you choose one or less
controller. All the controllers that existed between the first and last selected
controllers will be eliminated and replaced by the new controllers. If you are
interpolating note velocity, notes between the first and last one aren't
replaced. Instead, the velocity values for these notes are set to interpolated
values.
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Scale

Scale lets you scale your selected controller to a percentage between  0
and 1000. For example, entering a scale factor of 10% will set all your
selected controllers to 10% of their current value. Entering a scale factor of
150% will set all your selected controllers to 150% of their current value.
When controllers are scaled beyond their normal range they will be set to
their maximum possible value. For example, a controller of  100 scaled by
150% will be set to 127, not 150.

Thicken
Select Thicken to increase the density of selected controllers by a factor of
two. This is done by interpolating a controller item between each pair of
selected controllers. For example, if you have selected two controllers, one
at time 1:1:0 with a value of 60 and one at time 1:3:0 with a value of 70, a
new controller will be entered between the two at time  1:2:0 with a value
of 65.

There is a threshold for thickening controllers. If the difference in value
between two adjacent controllers is less than  2, no new controller will be put
between them.

You cannot thicken note velocities.

Thin
Thin produces the opposite effect of Thicken. When you select Thin every
second selected controller is eliminated.

You cannot thin note velocities.
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Crop

Crop sets bounds for the controllers you have selected. When you select
Crop the Crop dialog appears, which allows you to set a ceiling and a floor
for your controllers. All the controllers above the ceiling are cropped to the
value of the ceiling. All the controllers below the floor are set to the value of
the floor. If there are redundant controllers (e.g. consecutive controllers
with the same value), they are eliminated. If you are editing note velocities,
consecutive notes with the same velocity are not eliminated.

Stretch Time
The Stretch Time dialog allows you to set a section of music to last a set
period of time. This is done by altering the tempo(s) present during this
section of music to make the music fit.

Set the beginning and end points of the section of music you are trying to fit
(in Bars:Beats:Steps) and then set the time you want the section of music to
last (in SMPTE time format).

Event List Block Editing Menu

The Event List block editing menu drops down after you select one or
more events in the Event List.
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Cut
Cut will erase the selected events from the current track and copy them to
the clipboard. They can be pasted somewhere else in the music by using
Paste, available under the standard Edit menu.

Copy
Copy will copy the selected events from the current track to the clipboard.
They can be pasted somewhere else in the music by using Paste, available
under the standard Edit menu.

Song Editor Block Editing Menu

The Song Editor block editing menu drops down after you select one or
more bars in the Song Editor.
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Cut

Copy

When you choose Cut or Copy you bring up the Arrange dialog. If you have
selected more than one track, the dialog title reads “ Arrange Multiple
Tracks — NOT UNDOABLE!”. If you have only selected one track the
dialog title reads “Arrange Track n” (where n is the number of the track
you selected). You use the Arrange dialog to cut or copy whole sections of
your music and possibly paste them somewhere else. You can arrange all
your tracks, some of your tracks or just one track. (See “ Song Editor” on
page 125 for details on selecting tracks.)

The top left section the dialog shows that either Cut or Copy is selected,
depending on your selection from the menu. You can change your mind and
choose to copy instead of cut or vice versa, by clicking on Copy or Cut.

Cut will delete all the music you select and Copy will make a copy of it
without deleting it. All the objects you select are affected by the Arrange
dialog.

The bars you have selected will be shown in the From and To times. If you
want to adjust the starting and ending times for your range, you can do that
here. The From and To times do not have to be on bar boundaries.

If you select Copy, the Paste To box will automatically become checked.
Otherwise you must check it yourself in order to paste the data that you cut
to a new location. (You cannot paste it later because Arrange does not copy
anything to the clipboard.)
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If you check the Delete Hole box, the empty space created when you cut out
your selected data will be eliminated. This means all the data after the
selection will move back in time to fill the hole.

Remember that Arrange does not copy anything to the clipboard, so if you
select Copy and uncheck Paste To nothing will be accomplished.

When you paste using the Arrange dialog, leading rests are conserved. This
is  unlike pasting using the Edit menu. When you paste using the Edit
menu, leading rests are not conserved.

Insert Space

The Insert Space allows you to insert space in a single track or in multiple
tracks. The Insert At Time field is filled in initially with the time of the
first bar that you selected. You can change this if you like. The Amount
field is filled in initially with the number of bars that you selected. You can
change this as well if you like. When you click on OK the amount of space
you specify will be inserted in all the tracks that you have selected.
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Goto Menu

The Goto menu is full of ways to move to different places in your piece.

Time

Selecting Time brings up the New Time dialog. This is the same as the
dialog that you get if you click on the time display in the main control area.
Selecting a time and pressing OK will take you to the time you asked for.
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Find Event

Select Find Event to go to the first occurrence of an event  of a specific type.
In the Find Event dialog, first choose the event type you want to look for.
For some kinds of events, such as controllers, you can choose the number
and either a range of values or a specific value for that event. Sometimes
you can just choose a number, sometimes just a value  or range of values and
sometimes neither a number or a value. What you are allowed to choose will
depend on the kind of event you are searching for. Next choose if you want
to look in all tracks or just the current track for your event. Finally choose
the direction in which you want to search. Press OK to look for your event.

Find Next
Select Find Next (or press F3) and the previous Find Event will be
repeated from the current time. The first corresponding event after the
current time will be found.
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Marker 1, 2, 3, 4
Selecting any of these markers will set the time and move the active
window to the time of the marker. The markers are shown in SMPTE and
then in Bars:Beats:Steps format. If a little lock is in front of the marker, the
marker is locked to SMPTE. In this case, if the tempo changes anywhere in
the piece, the SMPTE time will stay the same and the Bars:Beats:Steps time
will change. If the marker is not there (SMPTE lock is not on), and the
tempo changes somewhere, the Bars:Beats:Steps time will stay the same but
the SMPTE change will change.

Set Marker 1, 2, 3, 4
Selecting any of these will set the numbered marker to the current time.
Therefore to set a marker to a particular time, set the time display in the
main control area to the time you want (one way is to click on it, set the
time and then press OK) and then select the marker. If you want to lock the
marker to SMPTE, select Set and Lock to SMPTE from the submenu.
Otherwise select Set from the submenu.

Play Menu

Play
Selecting Play is the same as pressing the play button in the tape transport
in the main control area. It will start your song playing from the beginning
of the active window.

Play Without Scrolling
Selecting Play Without Scrolling acts the same as selecting Play, except
that none of the windows scroll along with the playback. On a slower
machine and with a very dense score, this can limit the demands made on
the machine during playback.
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Play Screen
Selecting Play Screen will play the screen of the active window. This is
useful when you just want to hear the music you are looking at on the
screen.

Track Menu

Edit
Select Edit to select all the notes in the current track and bring up the edit
menu. Depending on which editor is active (and what object type is selected
if you are in the Score Editor) you will get a different menu of editing
options to choose from.

Instrument Range

Select Instrument Range to bring up the Check Instrument Range dialog.
Use this feature when you want to proof your track for notes out of the range
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of the instrument for which you are writing. You choose the instrument you
are writing for from the drop-down list box. The full or the practical range
or the instrument can be checked. Pressing Check will check from the
beginning of the piece or the last out of range note found (if a previous
check has been done). Cancel stops the checking function.

When a note is found that is out of range, the cursor moves to that note and
you are warned that a note has been found that is out of range.

The ranges of instruments can be changed or new instruments and their
ranges can be added by editing RANGES.INI in the installation directory.
See “RANGES.INI” on page 217 for details.

Delete
Select Delete if you want to delete the current track. You will be asked to
confirm that you want to go ahead and delete the track.

Insert
Select Insert to insert a new track in front of the current track.

New
Select New to add a new track after the last track in your song.

Display Menu

The Display menu allows you to make changes to the way music is
displayed in the Score Editor and printed out.
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Page
Selecting the Page menu item from the Display menu brings up the
Display Page dialog. You use the Display Page dialog to control a number
of global formatting options. Here you set system indentation, vertical staff
positioning, vertical lyric and guitar chord positioning, brace and barline
styles and fonts for all your text items.

System Indentation

The system indentation allows you to indent your systems. The first
indentation refers to the first system on the first page in your piece. The
next indentation refers to all the remaining systems in your piece. The
numbers you enter here correspond to the width of about half a character.
(160 spaces cover the whole page.) The defaults are  20 for the first
indentation and 0 for the next indentation.
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Staff Spacing

Click on the Set button for Staff Spacing to bring up the Staff Spacing
dialog.

You can move the staves that appear on the window on the left side of the
Staff Spacing dialog by dragging them up or down. You can move the
staves three different ways, depending on the moving mode you select. If
you choose Independent, moving a staff up or down does not affect any of
the other staves. If you choose Accordion, the top staff and the bottom staff
are anchored and the staff you move pulls the staves above and below it in
an accordion effect. Choosing Push Up/Down moves the staves below the
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one being moved, along with the one being moved, as you move it up or
down. If you click on the Default Spacing button the staff spacing will
revert to the default. Of course, if you have only one track in your piece, you
won't be able to affect the spacing between staves.

You can affect the spacing between systems by setting a new value in the
System Spacing list box. By default, the spacing between systems is set
at 4, which is about equivalent to the space between three ledger lines. This
means that systems are spaced apart by this amount in addition to the
default spacing between staves in the same system.

Guitar Chords

Click on the Guitar Chords Position button to change the automatic
positioning of guitar chords.

When you enter guitar chords they are entered at a set number of rows
above the staff. (There are two rows between ledger lines, one for the space
and one for the line) You can change the entry position of guitar chords by
changing the value in the Entry Position list box. Check the Reposition all
chords option to reset to the entry position all chords that have already been
entered. Guitar chords can be displayed in either large or small format. If
Display large chords is checked (the default), all chords will be displayed
in large format. If Display large chords is not checked, all chords will be
displayed in small format.

Style

You can control the appearance of barlines  and braces in the Style section of
the Display Page dialog. Check Connect left side of staves in parts if you
want the far left of each staff to be closed with a bar line when you are
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printing parts. If this option is not checked, the far left of each staff will be
open when printing parts. Many editors prefer this style for orchestral parts.

You have three choices of barline styles. If you choose Join Barlines, all
barlines will extend from the top of the first staff in a system to the bottom
of the last staff in the system. If you choose Break Barlines by Staff, all
staves in a system will have barlines, but there will be no barline
connections between staves in the same system. If you choose Break
Barlines by Brace Group , barlines in a system will extend across staves
that are grouped together by a brace or bracket. There will be no barline
connection between staves in the same system not joined by a brace or
bracket.

Braces

Click on the Braces button to select the Braces dialog.

Now you can set up the brace and bracket style that you want for your piece.
Select the tracks you want to connect with a given brace type (either a
bracket, a curly brace or a line) by dragging over the numbers for these
tracks in the Track box with the mouse. The tracks you have selected will
be highlighted. Now choose a brace type by clicking on Bracket, Curly
Brace, or Line in the Brace Type box. The tracks you selected will now be
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connected together in the brace display window. You can continue
connecting tracks with different types of braces until you are happy with the
brace and bracket style for your piece.

Text

The two buttons in the Text section of the Display Page dialog affect the
display of text.

Click on the Lyrics button if you want to change the vertical positioning of
lyrics.

Change the value in the Lyric 1 list box to change the number of rows the
first lyric appears below the staff. (Remember two rows equals the distance
between two staff or ledger lines.) Change the vertical spacing between
lyrics by changing the value in the Spacing list box. If you check
Reposition Lyrics, all lyrics already entered will be repositioned to the
position and spacing you have set. Otherwise only newly entered lyrics will
be affected.
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Click on the Fonts button to change the fonts for the text and symbols that
you are using in QuickScore Elite.

There are many different types of text fonts used in QuickScore Elite and
they all show up here. The name of each type of text is to the left and the
font for that type of text is displayed on the button to the right. Sometimes
the button can't show all attributes for the font. Click on the button if you
want to see all the attributes for the font or change the font. This brings up
the Windows Font dialog, which allows you to select any font in your
system, at any size that is available and with a wide variety of styles.
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For more information on the Windows Font dialog see your Windows User's
Guide.

Bar
Selecting the Bar menu item from the Display menu brings up the Display
Bar dialog.

Select the Display Bar dialog when you want to make a change to the way
a single bar in your score is displayed. Some of the parameters in this
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dialog affect all tracks, and some just the current track. Some of the
parameters only affect the current bar, and some also affect all bars after the
current bar until a change to the parameter is found in a later bar.

Key Signature, Time Signature, Beat, Barline, and Rehearsal Mark all
affect all tracks. All other parameters affect only the current track.

Key Signature, Time Signature, Beat and Bars per Line affect the
current bar and all bars afterwards until a change to the parameter is found
in a later bar. All other parameters only affect the current bar.

The bar number and track number are written on the title of the Display
Bar dialog. You can change the bar number and/or the track number by
double clicking on the title and selecting a new bar or track in the Jump to
dialog that appears. This can be useful if you are in Print Preview mode in
the Score Editor and you want to change a few things on different bars or
tracks. (When the Display Bar dialog comes up in Print Preview mode, the
parameters you first see are for the first bar displayed on the current page.)

You can change parameters by clicking on the drop-down list box to the
right of the parameter name and selecting an item from the list that drops
down. When you change a parameter, the check box beside the parameter
becomes checked. Only parameters that are checked will be changed in
your score when you press OK. You can uncheck a parameter that you
don't want to change, if it is checked for any reason, by clicking on the
check.

There are a number of parameters that can be set for the entire score, for
each individual track, or for each individual bar. For example, you can set
the quantization for your full score, each individual track, or each
individual bar. It is easiest to set parameters like quantization for your full
score first, and then make changes on a case by case basis using the Display
Track or Display Bar dialogs. Remember that changing a setting in the
Display Score dialog will wipe out any settings made in the Display Track
or the Display Bar dialogs. So set your parameters first in the Display Score
dialog, then in the Display Track dialog, and finally in the Display Bar
dialog.

Key Signature

Select a new key signature starting at the current bar by choosing the
number of sharps or flats you want in the key signature. The key signature
affects all tracks. The key signature that you set in the Display Bar dialog
will be in effect from the current bar until the key signature is set in a
subsequent bar.
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Time Signature Numerator

Select a new time signature numerator starting at the current bar. The
time signature numerator affects all tracks. The time signature numerator
that you set in the Display Bar dialog will be in effect from the current
bar until the time signature numerator is set in a subsequent bar.

Time Signature Denominator

Select a new time signature denominator starting at the current bar. The
time signature denominator affects all tracks. The time signature
denominator that you set in the Display Bar dialog will be in effect from
the current bar until the time signature denominator is set in a subsequent
bar.

Beat

Choosing the beat affects the way music is grouped. Unless you explicitly
group notes together (see “Group” on page 145), the notes are grouped
together by beat. For example, suppose you have six eighth notes in a
6/8 bar. If you choose quarter as the beat, the notes in the bar will be
grouped into three groups of two eighth notes each. If you choose dotted
eighth as the beat, the notes in the bar will be grouped into two groups of
three eighth notes each.

The beat affects all tracks. The beat that you set in the Display Bar
Dialog will be in effect from the current bar until the beat set in a
subsequent bar. You can set the beat  for the entire piece using the Display
Score dialog.

Note: Some combinations of beat and time signature are not allowed.
The rule is the bar must be able to be broken into an integral number of
beats. If you try to select a beat value that doesn't work with a given time
signature, QuickScore Elite will not let you exit the Display Score dialog
until you have selected a compatible beat value.

Bars per Line

Changing the bars per line setting will change the number of bars per line
displayed after the current bar. If you have a track number displayed in
the title, the bars per line setting will only affect that particular track. In
other words, you will only see the bars per line change when you display the
track in Single Track mode or when you print out the track as a single part.
To change the bars per line for the full score, double click on the title bar
and set the value in the track drop-down list box to Score. Then change the
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bars per line. This way you can have your music spaced differently for each
part and for the full score.

To automatically set the bars per line for your entire piece, use the Space
Music dialog (see “Space Music” on page 193). This works a lot faster than
setting all the bars per line for your piece by hand. After you have set your
bars per line with the Space Music dialog, you can make small changes
using this option in the Display Bar dialog.

Quantization Amount

When QuickScore Elite displays music, it usually quantizes it first. The
quantization amount is the smallest resolution used to display music. For
example, if you have a group of eight, even thirty-second notes in a beat and
your quantization amount is set to sixteenths, your thirty-second notes will
show up as four groups of two sixteenth notes, looking as if you played each
group of two sixteenth notes at the same time.

It is important to know the smallest duration that you are trying to display
in a measure Make sure you set the quantization amount to a value equal
or smaller than this amount. If you have triplets  in your bar, they won't be
displayed correctly unless you set the quantization value to either Triplet,
Triplet/8th, Triplet/16th, Triplet/32nd, or None. The quantization amount
set in the Display Bar dialog only affects the current track and the
current bar.

You can set the quantization for each individual bar, each individual track,
or for your full score. It is easiest to set quantization (as well as other
parameters) for your full score (using the Display Score dialog) to what
looks like a reasonable value. Then, if there are individual problems, try to
correct them on a case by case basis using the Display Track or Display Bar
dialogs. Remember that changing a setting in the Display Score dialog will
wipe out any settings made in the Display Track or the Display Bar dialogs.
So make your settings first in the Display Score dialog, then in the
Display Track dialog, and finally in the Display Bar dialog.

Barline

This is where you set the type of barline that appears to the left of the
current bar. If you are setting the barline for the first bar in your piece, you
can only set the barline to a normal (thin line) barline or to a left repeat.
For any other bar, you can set a wide variety of barlines.
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Display Rests

Normally, rests are automatically displayed but you may decide not to
display rests for a given bar and put them in yourself (using graphic rest
symbols from the notes palette in the Score Editor). This can happen if you
can find no way to display the rests in the bar without obscuring music or
other symbols in the bar. Try changing the rest levels for rests in the bar
(this option is in the next column in the Display Bar dialog) before you get
rid of rests entirely and try to put them in yourself. Display Rests only
affects the current bar.

Rehearsal Mark

Checking the Rehearsal Mark option puts in a rehearsal mark at the
current bar. The rehearsal mark appears above the first track in Score
mode and above each track in Single Track mode. The rehearsal mark is a
letter enclosed in a box. The letters start with A, and after Z, if there are
more, continue with AA, BB, etc. The letters for rehearsal marks are
calculated automatically, so if you get rid of one or enter a new one between
two old ones, all rehearsal mark letters are adjusted.

Extend Isolated Notes

When Extend Isolated Notes is set to Yes, short notes will extend to the
next note (of the same voice) as long as that note is less than a quarter note
beyond the start of the note. This is useful to get rid of lots of little rests if
there are small gaps between notes. These rests can make the notation very
difficult to read. Extend Isolated Notes is on by default. Setting Extend
Isolated Notes in the Display Bar dialog only affects the current bar. You
can also set Extend Isolated Notes in the Display Score and the Display
Track dialogs.

Use Ascending or Descending Stems

Setting this option will set the stem direction of all notes in the current
bar which uses the default voice. You can set the stem direction to
Ascending, Descending, or Both. If Both is selected, all notes above the
middle staff line will have stems pointing down and all notes on or below
the middle staff line will have stems pointing up. You can also set Use
Ascending or Descending Stems in the Display Score and the Display
Track dialogs. In addition, you can change the direction of note stems on a
note by note basis by selecting a note or group of notes and applying a
Group edit to it. (See “Group” on page 145 for more details.)
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Join Stems

This option is on by default. If Join Stems is off, all stems in the current
bar will be drawn separately. Otherwise they are drawn together. You can
also set Join Stems in the Display Score and the Display Track dialogs. In
addition, you can join notes together on a note by note basis by selecting a
note or group of notes and applying a Group edit to it. (See “Group” on
page 145 for more details.)

Ties

Normally ties go in the opposite direction of note stems. Sometimes this
creates a problem because ties cover up notes or other symbols. You can set
the direction of ties (above or below notes) in the Display Bar dialog if you
are having problems. You can set the direction for ties in the default, first
voice, or second voice individually. Setting Ties only affects ties in the
current bar.

Tie Offsets

If changing the direction of ties does not solve your problems of ties
overlapping notes or other symbols, you can change the vertical distance of
the tie from the notes it is linking together. Remember that the offset is
measured in rows and there are two rows between each staff line or ledger
line. Setting Tie Offsets only affects ties in the current bar.

Rest Levels

If you are having trouble with rests that overlap notes or other symbols you
can move the rests in the bar up or down to get them out of the way. Rest
levels are measured in rows from the top of the staff. There are two rows
between each staff line or ledger line. Setting Rest Levels only affect rests
in the current bar.
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Track
Selecting the Track menu item from the Display menu brings up the
Display Track dialog.

The Display Track dialog is useful to change parameters that affect the
way a track is displayed. Each of the parameters that you set here affect all
bars in the current track.

The number of the track affected is shown in the title of the dialog. You
can change the track number by double clicking on the title and selecting
a new track in the Jump to dialog that appears.

You can change parameters by clicking on the drop-down list box to the
right of the parameter name and selecting an item from the list that drops
down. When you change a parameter, the check box beside the parameter
becomes checked. Only parameters that are checked will be changed in
your score when you press OK. You can uncheck a parameter you don't
want to change, if it is checked for any reason, by clicking on the check.
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There are a number of parameters that can be set for the entire score, for
each individual track, or for each individual bar. For example, you can set
the quantization for your full score, each individual track, or each
individual bar. It is easiest to set parameters like quantization for your full
score first and then make changes on a case by case basis using the Display
Track or Display Bar dialogs. Remember that changing a setting in the
Display Score dialog will wipe out any settings made in the Display Track
or the Display Bar dialogs. So set your parameters first in the Display Score
dialog, then in the Display Track dialog, and finally in the Display Bar
dialog.

Bars Per Line

Changing the bars per line setting will change the number of bars per line
displayed for the current track. Note that you will only see the bars per
line that you set for the current  track when you display the track in Single
Track mode or when you print out the track as a single part. To change the
bars per line for the full score, change the bars per line using the Display
Score dialog. This way you can have your music spaced differently for each
part and for the full score.

To automatically set the bars per line for your entire piece, use the Space
Music dialog (see “Space Music” on page 193). This will automatically
justify the spacing based on the density of your music. Doing things this
way works a lot faster than setting all the bars per line for your piece by
hand. After you have set your bars per line with the Space Music dialog,
you can make small changes using the Display Bar dialog.

Join Stems

This option is on by default. If Join Stems is off, all stems in the current
track will be drawn separately. Otherwise they are drawn together. You can
also set Join Stems in the Display Score and the Display Bar dialogs or
you can join notes together on a note by note basis by selecting a note or
group of notes and applying a Group edit to it. (See “Group” on page 145
for more details.)

Use Ascending or Descending Stems

Setting this option will set the stem direction of all notes in the current
track which use the default voice. You can set the stem direction to
Ascending, Descending, or Both. If Both is selected, all notes above the
middle staff line will have stems pointing down and all notes on or below
the middle staff line will have stems pointing up. You can also set Use
Ascending or Descending Stems in the Display Score and the Display
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Bar dialogs or you can change the direction of note stems on a note by note
basis by selecting a note or group of notes and applying a Group edit to it.
(See “Group” on page 145 for more details.)

Extend Isolated Notes

When Extend Isolated Notes is set to Yes, short notes will extend to the
next note (of the same voice) as long as that note is less than a quarter note
beyond the start of the note. This is useful to get rid of lots of little rests if
there are small gaps between notes. These rests can make the notation very
difficult to read. Extend Isolated Notes is on by default. Setting Extend
Isolated Notes in the Display Track dialog only affects the current track.
You can also set Extend Isolated Notes in the Display Score and the
Display Bar dialogs.

Quantization Amount

When QuickScore Elite displays music it usually quantizes it first. The
quantization amount is the smallest resolution used to display music. For
example, if you have a group of eight, even thirty-second notes in a beat and
your quantization amount is set to sixteenths, your thirty-second notes will
show up as four groups of two sixteenth notes, looking as if you played each
group of two sixteenth notes at the same time.

It is important to know the smallest duration you are trying to display in a
measure. Make sure you set the quantization amount to a value equal or
smaller than this amount. If you have triplets  in your track, they won't be
displayed correctly unless you set the quantization value to either Triplet,
Triplet/8th, Triplet/16th, Triplet/32nd, or None. The quantization amount
set in the Display Track dialog only affects the current track.

You can set the quantization for each individual bar, each individual track,
or for your full score. It is easiest to set quantization (as well as other
parameters) for your full score (using the Display Score dialog) to what
looks like a reasonable value. Then, if there are individual problems, try to
correct them on a case by case basis using the Display Track or Display Bar
dialogs. Remember that changing a setting in the Display Score dialog will
wipe out any settings made in the Display Track or the Display Bar dialogs.
So make your settings first in the Display Score dialog, then in the
Display Track dialog, and finally in the Display Bar dialog.

Clef

Setting the clef in the Display Track dialog sets the clef for the entire
current track, wiping out any clefs you may have put into the track earlier.
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You can also put clefs into your track using the clef palette in the Score
Editor.

Transposition

The Transposition option affects the display of notes in the current track.
The actual pitch of the notes does not change. Use this feature if you are
writing for transposing instruments, such as clarinets or French horns.

Split Track

Split Track causes the track to be displayed on two staves. The top staff has
a treble clef and the bottom staff has a bass clef. This is useful for
displaying keyboard parts.

Display Rests

Display Rests is on by default, but if you don't want to display any rests in
the current track, set it to off. This can be useful if you want to print out a
blank track without any music or rests in it and then later draw in the notes
in the blank track by hand.
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Score
Selecting the Score menu item from the Display menu brings up the
Display Score dialog.

The Display Score dialog allows you to change a number of parameters that
affect the display of your entire score.

There are a number of parameters that can be set for the entire score, for
each individual track or for each individual bar. For example, you can set
the quantization for your full score, each individual track, or each
individual bar. It is easiest to set parameters like quantization for your full
score first and then make changes on a case by case basis using the Display
Track or Display Bar dialogs. Remember that changing a setting in the
Display Score dialog will wipe out any settings made in the Display Track
or the Display Bar dialogs. So set your parameters first in the Display Score
dialog, then in the Display Track, dialog and finally in the Display Bar
dialog.
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Tempo

Set the tempo in the Display Score Dialog  to set the tempo for your entire
piece. But be careful, because any tempo changes you have put in anywhere
in your piece (using the Tempo button, the Mixer, or the Controller
Editor) will be wiped out.

Steps per Quarter

The steps per quarter is the number of steps or clock ticks in a quarter
note. This is set by default to 96 and normally does not need to be changed.
If you read in a MIDI file, the steps per quarter will be taken from the MIDI
file. The time display for the cursor and for individual events is always in
bars, beats and steps. Changing the steps per quarter after you have
entered music in a piece will affect the display and playback of the music
you have already entered, so do this with extreme caution.

Beat

Choosing the beat affects the way music is grouped. Unless you explicitly
group notes together (see “Group” on page 145), the notes are grouped
together by beat. For example, suppose you have six eighth notes in a
6/8 bar. If you choose quarter as the beat, notes will be grouped into three
groups of two eighth notes each. If you choose dotted eighth as the beat, the
notes in the bar will be grouped into two groups of three eighth notes each.

The beat affects all tracks. The beat that you set in the Display Score
Dialog will wipe out any earlier changes you made to the beat using the
Display Bar dialog. The beat is set for the entire piece in the Display
Score Dialog . You can set the beat on a bar by bar basis using the
Display Bar dialog.

Note: Some combinations of beat and time signature are not allowed.
The rule is the bar must be able to be broken into an integral number of
beats. If you try to select a beat value that doesn't work with a given time
signature, QuickScore Elite will not let you exit the Display Score dialog
until you have selected a compatible beat value.

Bars per Line

Changing the bars per line setting will change the number of bars per line
displayed for the entire piece. Any bars per line settings you made earlier
using the Display Track, Display Bar or Space Music dialogs will be
wiped out.
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Staves per Page

Select Staves per Page to set the number of staves which appear on each
page.

Include Bar Lines

You can choose not to include bar lines for your piece if you want. Include
Bar Lines is set to Yes by default.

Join Stems

This option is on by default. If Join Stems is off, all stems in the piece will
be drawn separately. Otherwise they are drawn together. You can also set
Join Stems in the Display Bar and the Display Track dialogs or you can
join notes together on a note by note basis by selecting a note or group of
notes and applying a Group edit to it. (See “Group” on page 145 for more
details.) Setting the Join Stems option in the Display Score dialog will
wipe out any changes you made earlier to this parameter using the Display
Track or Display Bar dialogs.

Use Ascending or Descending Stems

Setting this option will set the stem direction of all notes in the piece
which use the default voice. You can set the stem direction to Ascending,
Descending, or Both. If Both is selected, all notes above the middle staff
line will have stems pointing down and all notes on or below the middle
staff line will have stems pointing up. You can also set Use Ascending or
Descending Stems in the Display Track and the Display Bar dialogs or
you can change the direction of note stems on a note by note basis by
selecting a note or group of notes and applying a Group edit to it (See
“Group” on page 145 for more details.) Setting this parameter in the
Display Score dialog will wipe out any changes you made earlier to this
parameter using the Display Track or Display Bar dialogs.

Extend Isolated Notes

When Extend Isolated Notes is set to Yes, short notes will extend to the
next note (of the same voice) as long as that note is less than a quarter note
beyond the start of the note. This is useful to get rid of lots of little rests if
there are small gaps between notes. These rests can make the notation very
difficult to read. Extend Isolated Notes is on by default. You can also set
Extend Isolated Notes in the Display Track and the Display Bar dialogs.
Setting this parameter in the Display Score dialog will wipe out any
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changes you made earlier to this parameter using the Display Track or
Display Bar dialogs.

Quantization Amount

When QuickScore Elite displays music it usually quantizes it first. The
quantization amount is the smallest resolution used to display music. For
example, if you have a group of eight even thirty-second notes in a beat and
your quantization amount is set to sixteenths, your thirty-second notes will
show up as four groups of two sixteenth notes, looking as if you played each
group of two sixteenth notes at the same time.

It is important to know the smallest duration you are trying to display in a
measure. Make sure you set the quantization amount to a value equal or
smaller than this amount. If you have triplets  in your bar, they won't be
displayed correctly unless you set the quantization value to either Triplet,
Triplet/8th, Triplet/16th, Triplet/32nd, or None. The quantization amount
set in the Display Score dialog affects the entire piece and wipes out any
changes you made earlier to this parameter using the Display Track or
Display Bar dialogs.

You can set the quantization for each individual bar, each individual track,
or for your full score. It is easiest to set quantization (as well as other
parameters) for your full score (using the Display Score dialog) to what
looks like a reasonable value. Then, if there are individual problems, try to
correct them on a case by case basis using the Display Track or Display Bar
dialogs. Remember that changing a setting in the Display Score dialog will
wipe out any settings made in the Display Track or the Display Bar dialogs.
So make your settings first in the Display Score dialog, then in the
Display Track dialog, and finally in the Display Bar dialog.

Time Signature Numerator

Setting the time signature numerator in the Display Score Dialog affects
your entire piece and wipes out any changes that you made earlier to this
parameter using the Display Bar dialog.

Time Signature Denominator

Setting the time signature denominator in the Display Score Dialog
affects your entire piece and wipes out any changes you made earlier to this
parameter using the Display Bar dialog.
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Key Signature

Select a new key signature by choosing the number of sharps or flats you
want in the key signature. The key signature affects your entire piece and
wipes out any changes you made earlier to this parameter using the Display
Bar dialog.

Show Tempo Changes

You can choose to show tempo change events in the Score Editor by
setting this option to Yes. If you do, each tempo change event will be shown
as a string of the form, “Tempo = t” (where t is the tempo value), above the
first track displayed in the printed score.

Use Engraver Spacing

Engraver spacing is used by the Score Editor to space music so that it
looks good visually. Without engraver spacing, spacing occurs by time,
rather than appearance. Crowding of music sometimes occurs, because you
always put music occupying the same amount of time in the same amount of
space. For example, eight thirty-second notes take up the same amount of
space as one quarter note. The thirty-second notes are crowded together and
the quarter note is all by itself. When you use engraver spacing, you assign
the amount of space notes of each duration take up. For example, you can
have thirty-second notes taking up only half as much as quarter notes if you
want to. Your music will generally look better if you use engraver spacing.
See “Engraver Spacing” on page 206 for more details.

Octavas Affect Notes

The octava markings are adjustable symbols found in the adjustable
symbols palette. You enter octavas by dragging them in with the pencil tool
over the notes you want them to affect.

Set this option to make octava markings affect the notes above or below
them. This option is set to NO by default. If you set this option to Yes, you
can enter the notes at their real pitch and then lower them or raise them on
the display using an octava marking.

Titles
Selecting the Titles menu item from the Display menu brings up a submenu
with two items. Selecting Score from the submenu brings up the Score
Titles dialog. Selecting Track from the submenu brings up the Track
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Titles dialog. Both dialogs are almost the same. Select Score to set titles for
the entire score. Select Track to set titles for each part or track.

The titles for each part can be different than the titles for the entire score.
This is so you can use a title, headers, or footers for your score that are
different from the ones you use for your tracks. For example, you may want
to use the track name in the footer when you are printing parts, and the title
of your piece in the footer when you are printing the full score. You can
copy all track titles from the score titles if you want to save time putting
them in by hand.

You can set the title, the composer, the header, the footer, and the
copyright using the Score Titles dialog and the Track Titles dialog. You
can decide to show or hide the track names on the first page of your parts
and score.

If you want to set the font for a particular title, click on the Set Font button.
You can also set the font for your titles by selecting the Fonts button in the
Display Page dialog under the Display menu.

Select the title you want to set by clicking on the diamond beside the title.
The text for that title will be displayed and the possible options for the title
will appear below the text.
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Title

The title is always centered on the first page of the printed score or part.
You can imbed the track name into the title for the track titles by clicking
on the Track %T button or by typing “%T” in the title text.

Composer

The composer appears to the right on the first page of the printed score or
part.

Header

The header appears at the top of your page. It will appear on each page of
your score starting at a page you specify in the Starting page field. The
header can be centered, left justified, or right justified. You can imbed
the page number by clicking on the Page %P button or by typing “%P” in
the header text. You can imbed the track number (for track titles) by
clicking on the Track %T button or by typing “%T” in the header text.
You can imbed the date by clicking on the Date %D button or by typing
“%D” in the header text.

Footer

The footer appears at the bottom of your page. It will appear on each page
of your score starting at a page you specify in the Starting page field. The
footer can be centered, left justified, or right justified. You can imbed the
page number by clicking on the Page %P button or by typing “%P” in the
footer text. You can imbed the track number (for track titles) by clicking
on the Track %T button or by typing “%T” in the footer text. You can
imbed the date by clicking on the Date %D button or by typing “%D” in
the footer text.

Copyright

The copyright appears on the bottom of the first page of the printed score
or part. The copyright can be centered, left justified, or right justified.
You can imbed the copyright symbol in the copyright text by clicking on the
Copyright button.
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Numbers
Selecting the Numbers menu item from the Display menu brings up a
submenu with two items, Page and Bar.

Page

Selecting the Page menu item from the Numbers submenu from the
Display menu brings up the Page Numbers dialog. Here you can change
the way page numbers are displayed in your score.

These page numbers are independent of the page numbers embedded in the
headers and footers using the %P command. If you want to use page
numbers in your headers or footers, you should make sure the box to the
right of Show page numbers is unchecked in this dialog.

Check the box to the left of Show page numbers if you want page numbers
to appear when you print your score. Type in the number at which you
want page numbering to start in the box to the right of Start numbering
at. For example, if you want to insert your piece into a larger document
which already has fifteen pages, start numbering at sixteen.

You can choose to have a page number on your first page or wait until page
two to start showing page numbers. Select this by checking Page 1 or
Page 2 in the Start Page section of the Page Numbers dialog.
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Select the position of your page numbers on the page by choosing Top or
Bottom in the Vertical section and then either Left, Center, Right, or
Alternating Left/Right in the Horizontal section.

Bar

Selecting the Bar menu item from the Numbers submenu from the Display
menu brings up the Bar Numbers dialog. Here you can change the way bar
numbers are displayed in your score.

Choose to never display bar numbers, display them every line or every bar
by selecting Never, Every line, or Every bar in the Show Bar Numbers
section of the dialog. You can start numbering from the first bar or the
second bar (do this if your first bar is a pickup bar) by selecting First bar or
Second bar in the Start Numbering From section. Finally, you can
position the bar numbers above or below the staff by selecting Above Staff
or Below Staff in the Position section.
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Space Music

QuickScore Elite will automatically space your music for you, choosing the
bars per line and the positioning of bar lines throughout your entire piece or
in just a section of your piece when you use the Space Music dialog. The
bars per line and the positioning of bar lines are calculated automatically
based on the changing density of your music.

There are three sections in this dialog, the Bars per line section, the Bar
line positions section and the Music spacing section.

Bars per line

In the Bars per line section, you can set the bars per line, reset the bars per
line (get rid of all bars per line changes) or not change any bars per line
settings you have already set. (Choose this option if have already set your
bars per line the way you want them and you just want to change the bar
line positions at this time.) Do this by choosing Set bars per line, Reset
bars per line, or Keep the same in the left side of this section.
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In the upper right of the section, choose the track(s) where you want to
calculate your bars per line. If you are in Score mode you can choose the full
score or all the tracks and the full score. If you are in Single Track mode
you can choose the current track or all the tracks and the full score. To
choose the current track (the score display in the Score Editor must be in
Single Track mode), select Track n (where n is the current track number).
To choose the full score (the Score display in the Score Editor must be in
Score mode), select Score. You can select All tracks and score when the
Score Display in the Score Editor is in either Single Track mode or Score
mode.

You can choose to affect all the bars in your piece or a range or bars by
clicking on All bars or Bar in the lower right part of this section. If you
select Bar, make sure you set the range of bars you want to affect by
typing in the appropriate bar numbers or by setting them using the spin
controls to the right of the numbers.

Bar line positions

In the Bar line positions section, you can position bar lines, reset bar lines
(get rid of all bar line settings) or not change any bar line settings you have
already set. (Choose this option if have already set your barlines the way
you want them and you just want to change the bar line positions at this
time.) Do this by choosing Position bar lines, Reset bar lines, or Keep the
same in the left side of this section.

In the upper right of the section, choose the track(s) where you want to
position your bar lines. If you are in Score mode you can choose the full
score or all the tracks and the full score. If you are in Single Track mode
you can choose the current track or all the tracks and the full score. To
choose the current track (the score display in the Score Editor must be in
Single Track mode), select Track n (where n is the current track number).
To choose the full score (the Score display in the Score Editor must be in
Score mode), select Score. You can select All tracks and score when the
Score Display in the Score Editor in either Single Track mode or Score
mode.

You can choose to affect all bars or a range or bars by clicking on All bars
or Bar in the lower right part of this section. If you select Bar, make sure
you set the range of bars you want to affect by typing in the appropriate
bar numbers or by setting them using the spin controls to the right of the
numbers.
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Music spacing

In the Music spacing section, you choose how dense you want each line of
music to be. This will affect the bars per line settings. The denser you set
the music spacing, the more bars you will tend to have on each line. For
example, a setting of 16 will put 32 sixteenths on average on each line.
Choose the density setting by moving the scroll box to the left or right in
the horizontal scroll bar, or set a number in the box to the right of the scroll
bar.

When you click on the OK button, QuickScore Elite will set the bars per
line and bar line positions using the density you have selected for the tracks
and bars you have chosen.

Bars of Rest

The Bars of Rest dialog lets you explicitly consolidate a number of bars of
rest, or have QuickScore Elite automatically find and consolidate the bars of
rest for all or part of your piece. Consolidated bars of rest are displayed with
a bars of rest sign with the number of resting bars above it. Select Set or
Calculate on the left side of the dialog to either consolidate bars of rest
explicitly or have QuickScore Elite do it.

If you choose Set, the two boxes on the top left part of the dialog will be
enabled for input. Choose Compress to compress a number of resting bars
into a single bar with a bars of rest sign. Choose Decompress to take a
single bar with a bars of rest sign and expand it into its component resting
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bars. Next, select the bars you want to explicitly compress or decompress by
typing in the bar numbers or setting them with the spin controls.

If you choose Calculate, the three boxes on the bottom left part of the
dialog will be enabled for input. You can choose the current track or all
your tracks by selecting Track n (where n is the current track number) or
All Tracks. You can choose to affect all bars or a range or bars by clicking
on All bars or From Bar in the lower right part of this section. If you select
From Bar, make sure you set the range of bars you want to affect by
typing in the appropriate bar numbers or by setting them using the spin
controls to the right of the numbers. Choose the minimum number of empty
bars that will be consolidated into a single bar containing a bars of rest sign
by typing in a number or setting it with the spin controls in the Compress n
bars of rest or more section of the dialog. Now every time QuickScore
Elite finds a number of empty bars that is equal to or greater than the
number you set,  these empty bars will be consolidated into a single bar. If a
number of empty bars is encountered that is smaller than this number, they
will not be consolidated.

Score Paper

The Score Paper dialog lets you create score paper. Score paper is drawn
without rests or bar lines. You can set up various aspects of the format for
your score paper (braces, indentation, etc.) by loading a template or using
the Display Page dialog.

Select Score Paper mode by putting a check in the Score Paper mode
section. Then check Clefs, Key Signatures, Time Signatures, and/or
Right Barline if you want any of these to show up on your score paper. You
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can preview your score paper by selecting Print Preview mode and then
print out as many pages as you want.
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Options Menu

MIDI Setup
Select the MIDI Setup menu item to change the MIDI in and MIDI out
port that QuickScore Elite will be using.
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Select a MIDI input driver from the MIDI in list box. The MIDI input
drivers listed are the ones that are installed in your system. Select a MIDI
output driver from the MIDI out list box. The MIDI output drivers listed
are the ones that are installed in your system. For more information about
installing MIDI drivers, see your Windows User's Guide.

Metronome

Select the Metronome menu item when you want to change the settings for
the audible metronome. The metronome can be used when you are playing
or when you are recording. Normally it is used when you recording.
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The Metronome dialog appears when you select Metronome from the
Options Menu. The Channel, Pitch, and Velocity fields and Audition
Metronome button refer to the note you will be using for the metronome.
Select a note you like (usually a drum sound with a well-defined attack is
good) and make sure it is as loud as you like it. The downbeat of each bar
will be louder than the other beats and the velocity number you are setting
refers to this note. The other beats are a little softer. Click on Audition
Metronome to hear the note you have selected. Click on Audition
Metronome again to silence it. The Count-in Beats field is used when you
are recording. This is the number of beats you will hear before recording
starts. Usually you will want to set this to a multiple of the number of beats
in your bar.

Check the Metronome on Record option if you want to hear the
metronome when you are recording. Normally this option is checked. Keep
this option unchecked if you don't want to hear the metronome when you
are recording. Click on the check box to check or uncheck the Metronome
on Record option.

Check the Metronome on Play option if you want to hear the metronome
when you are playing. Normally this option is not checked. Keep this option
unchecked if you don't want to hear the metronome when you are playing.
Click on the check box to check or uncheck the Metronome on Play option.

Once you have set the metronome the way you like, you should never have
to set it again as long as you use QuickScore Elite. Your metronome
settings are saved in the file QSD.INI. For more information, see
“QSD.INI” on page 216.
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Record Options

Select Record Options to set up the source of the beat you will be using
when recording. Normally you will record in real time, that is, the
metronome beats at the tempo specified in your song. But you can also tap
the beat yourself by playing a note on your keyboard, or have it come from
some other MIDI source, such as a foot switch which might send out pedal
on and pedal off messages.

If you want to tap the beat yourself, select Tap Beat in the upper left hand
box in the Record Options dialog. Then select the MIDI note or controller
you want to use to trigger the beat. If you aren't sure of the actual MIDI
numbers to plug in, click on Listen to MIDI and then press the key on your
keyboard you will use to tap the beat, or tap on your pedal until a MIDI
event is registered. When QuickScore Elite hears a note or controller, the
Listen to MIDI button will uncheck itself and the note or controller will be
displayed for you.
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File Input and Record Filters

You can select the kind of MIDI events that you want to record  or read from
MIDI files using the Filters dialog, available by selecting File Input and
Record Filters from the Options Menu. This is useful if you know there is
some kind of data you don't want to put in your composition. For example,
you can make sure that you don't receive any aftertouch messages, even if
your keyboard always sends them, or you know they are in a MIDI file  that
you are reading.

Simply uncheck any MIDI data items that you do not want to read from
MIDI files or that you don't want to record.
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MIDI Thru

Select MIDI Thru if you want to change the routing of MIDI channels
received from your MIDI input driver. This can be useful if you have an
inexpensive or older controller that cannot send data on more than one
channel. For example, if your controller only sends data on channel  1 and
you want to hear or record your drums that are on channel  10 on your drum
machine, reroute Channel 1 to Channel 10 by setting Channel 10 in the list
box of Channel 1.

Modern synths and keyboards are pretty flexible, but if you can't set up your
channels any other way you can use QuickScore Elite's MIDI thru feature
to help you out.
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Patch Lists

This is where you set up the patch names and patch numbering for your
instrument(s). The patch names and patch numbers are displayed in the
Track Sheet and the Controller Editor when you are editing program
changes. Using patch names instead of program change numbers makes
keeping track of your sounds a lot easier. (Patches are another name for
programs changes.)

For each instrument in your MIDI setup, select all the channels this
instrument uses in the Channel list box. You can select channels here by
dragging over several channels and by control-clicking on individual
channels.

For example, if you want to select channels  1, 2, 3, 4, 7, and 9, you can
click on channel 1, keep the mouse down and move it to channel  4,
highlighting channels 1, 2, 3, and 4 and then pressing and holding down
the CTRL key and clicking on channel 7 and channel 9, highlighting these
as well. If you want to select all the channels, drag from channel  1 to
channel 16, highlighting all of them.

When you have selected the channels you want, select a patch list name
from the list of patch list names. Now select a numbering scheme for your
patches from the Numbering list box.

QuickScore Elite comes with several predefined patch lists. You can add
your own patch lists or you can modify the patch lists that are already there,
by making changes to the file PATCHES.INI in the directory where you
installed QuickScore Elite. For details on making changes to your patch
lists, see “PATCHES.INI” on page 217.
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Step/Mouse Entry Velocities

Selecting Step/Mouse Entry Velocities  from the Options menu  brings up
the Note Input Velocities dialog. Select this item when you want to change
the velocity of notes (usually this translates to dynamic level) entered using
step entry or the mouse. You have the choice of setting the step entry
velocity to a constant or keeping the velocity that you used when you
entered your notes from the keyboard.

Change the mouse entry velocity by editing the Mouse Entry number field
or by using the up and down arrows in the spin box to the right of the
number.

Take the step entry velocity from MIDI by selecting the From Midi option
in the Step Entry box. Select a constant step entry velocity by selecting
Constant in the Step Entry box and then change the step entry velocity by
editing the Constant number field or by using the up and down arrows in
the spin box to the right of the number.
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SMPTE

Select SMPTE to change the SMPTE format you will be using and to
change the SMPTE offset of the beginning of your piece (Bars:Beats:Steps
time of 0:0:0).

Engraver Spacing

Engraver spacing is used by the Score Editor to space music so that it
looks good visually. Without engraver spacing, spacing occurs by time,
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rather than appearance. Crowding of music sometimes occurs, because you
always put music occupying the same amount of time in the same amount of
space. For example, eight thirty-second notes take up the same amount of
space as one quarter note. The thirty-second notes are crowded together and
the quarter note is all by itself. When you use engraver spacing, you assign
the amount of space notes of each duration take up. For example, you can
have thirty-second notes taking up only half as much as quarter notes if you
want to.

You set up the way music will be spaced using spacing tables. Each
spacing table has fifteen entries, one for each note of a certain duration. The
amount of space allotted to each note is relative. For example, if you look at
the default spacing list, the spacing for a 16th note is 42, which is half of
the spacing for a quarter note, which is 84.

Select the Engraver Spacing dialog to change the spacing table you are
using. When you select a spacing table from the list of spacings, its values
are displayed to the right of the dialog. Note that you have to select Use
Engraver Spacing on the Display Score dialog (available by selecting
Score from the Display menu).

You can add or change the available spacing tables by editing the file
ALLOT.INI in the directory where QuickScore Elite is installed. For details
on adding to or changing spacing tables, see “ALLOT.INI” on page 218.
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Drum Notation

The Drum Notation dialog is used to set up the display of your drum
tracks in the Score Editor. Your drum tracks are the ones which have a
single-line or five-line drum clef. The top of the Drum Notation dialog
shows the drum notes as they will appear when they are displayed. Below
this are the MIDI note numbers for the drum notes. Below the note
numbers is another display of the drum notes in music notation, so that you
can more easily see what pitch your drum notes correspond to.

You can change the display of any drum note you want. Select the note you
want to change by clicking on the note or on its MIDI note number. The
note will be highlighted in red. If the note you want to change is to the left
or right of the screen, move the slider on the bottom of the dialog until the
note appears and then select it. Now move the note to the line or space you
want it to be displayed in the Note Display window by dragging it with the
mouse. Select the note head you want by clicking on the diamond beside
the note head you want in the Note Head area of the dialog. Select the
accent you want by clicking on the diamond beside the accent you want in
the Accent area of the dialog. You can reset the drum display to the defaults
by clicking on the Reset button.
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Note: If you have a single-line drum staff, all drum notes are drawn on the
line, so the position you set in the Drum Notation dialog is not important.

Once you set your drum notation, you will not have to set it again unless
you want to. Drum notation parameters are stored in the file DRUMS.INI  in
the directory where QuickScore Elite is installed.

Scroll Children

Select Scroll Children when you want to have only certain windows scroll
as you play. You can improve display performance when playing by
limiting the windows that scroll. Select Active to have only the active
window scroll, or select any group of the scrolling windows. Put a check
next to the window name if you want the window to scroll or have the
window name unchecked if you want that window not to scroll.

The remaining entries in the Options menu are options that are turned
either on or off. Options are on if there is a check mark beside them and off
if there is no check mark. To change the status of an option, just select it.
If the option was previously checked now it will be unchecked. If it was
previously unchecked, now it will be checked.

Save Settings on Exit
If checked, all the settings you changed while you were working, including
the position of your windows, will be saved for you and will be the same the
next time you load QuickScore Elite. If not checked, your settings will be
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the same as the last time you set them and checked Save Settings on Exit
before leaving QuickScore Elite.

Chase Controllers
If Chase Controllers is checked, controllers, pitch bend, aftertouch, and
program changes will be chased every time you play. This means that if
there were any of these events in your piece before the time you started to
play, the last one of each of them will be sent out before you start playing.
This way your music will sound the way you expect even if you start in the
middle. You can turn this off if you don't want this to happen or if you think
chasing controllers is taking too much time. Chase Controllers is on by
default.

MIDI Enabled
You can turn MIDI on or off easily using this menu option. Sometimes this
is useful if you are using a MIDI driver that does not support more than one
simultaneous user and you are using another MIDI program (like the Media
Player for example) with QuickScore Elite. It is also possible to turn off
MIDI from the MIDI setup dialog, but it is faster to do it here. MIDI is
enabled by default.

External Clock
You can switch from the internal clock to an external clock. The external
clocking signal can be either MIDI time code or MIDI clock. QuickScore
Elite will automatically sense which external clocking signal is being sent.
Normally if you are synching to a VCR or tape deck you will be sent MIDI
time code, but if you are being driven by another sequencer you will be sent
MIDI clock. External Clock is off by default because you are normally
being driven by an internal clock.

Send MIDI Clock
If you are linked to another sequencer and you want to drive it (you are the
master), set this option to on. You will then send MIDI clock and the other
device can follow you. This option is off by default.

When Send MIDI Clock is checked and you start playing, QuickScore Elite
first sends a song position pointer message to let the slave device chase to
the correct time. A dialog appears, forcing you to click on OK before
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anything else is sent out. This is to make sure that the device receiving
MIDI clock has chased to the correct time before it must start playing.

Scroll While Playing
Normally you will want to scroll your windows when you play  so you can
see what is going on. You can turn this off if your computer is too slow or
your music is too dense for this to happen efficiently. Also look at the Scroll
Children item in the Options menu for another way to limit the scrolling of
windows while you are playing.

Legato Entry
When Legato Entry is checked, entering a note in the Score Editor will
cause the note that precedes it to lengthen or shorten its duration so that it
ends where the new note starts. This is sometimes very useful, because you
can enter a lot of music with different rhythmic values without changing the
duration value from the main control area. Of course you have to remember
to turn Legato Entry off when you want to avoid filling up space between
notes you are entering.

Cache Patches
Some sound cards work best if you tell them what patches they need to use
before you start to play. This is because they only hold a few of their patches
in their internal memory at any time. The rest of the patches are on disk and
have to be loaded before they can be used. Sound cards from Advanced
Gravis and IBM work this way. Check Cache Patches if you have a card
like this that uses patch caching.
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Window Menu

Lock Cursors
When Lock Cursors is set, all windows move their cursors whenever the
cursor in the active window is moved. It is often useful to lock cursors and
lock tracks to make sure that what you are looking at in all editors is the
same. On the other hand, setting these options can slow things down when
looking at very dense scores, especially on older machines.

Lock Tracks
When Lock Tracks is set, all windows change tracks whenever the track is
changed in the active window. It is often useful to lock cursors and lock
tracks to make sure that what you are looking at in all editors is the same.
On the other hand, setting these options can slow things down when
looking at very dense scores, especially on older machines.

Lock Controllers
When Lock Controllers is set, any changes in the controller being viewed
in the Controller Editor or mixed in the Mixer will cause the other to
display or mix that controller as well. If Lock [Include Event List]  is



Menus   213

selected from the submenu, the Event List also participates in these
changes to the controller being viewed.

Cascade
Select Cascade to neatly cascade your open windows one after the other.

Tile
Select Tile to cause your open windows to be displayed on the main window
so that they do not overlap and so that each takes up an equal amount of
space. When the windows are tiled there is still enough space to show your
iconized windows at the bottom of the main window.

Arrange Icons
Select Arrange Icons to arrange your iconized windows neatly in a row at
the bottom of the main window. You might use this if the icons are spread
out and you can't find the one you want.

QuickScore Elite Windows
The remaining menu items in the Window menu are the eight windows
available in QuickScore Elite. These are:

• Score Editor.

• Controller Editor.

• Piano Roll Editor.

• Track Sheet.

• Mixer.

• Event List.

• Song Editor.

• Comments Window.

Selecting the name of a window makes it the active window. When you
drop down the Window menu, the currently active window has a check
beside it.
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Help Menu

Contents
Selecting Contents (or pressing F1) lets you get help on any aspect of
QuickScore Elite. Navigate through Help by clicking on green text or by
using the Help buttons and menus. For more information on using Help,
see your Windows User's Guide.

About

Selecting About brings up QuickScore Elite's About box, with credits for
the program and the version number of your copy of QuickScore Elite.
This is important to know if you are calling technical support  about
QuickScore Elite.
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Appendices

Appendix 1: Template Files
When you enter a new file, a template can be selected that will set up the
initial format for your piece. QuickScore Elite comes with a number of
standard templates.

To make a new template, you must create a file and set it up the way you
want your initial format to appear. In the Comments Window of the
template file, write a description of the template. You then save the file in
the TEMPLS directory. The TEMPLS directory is a subdirectory of
QuickScore Elite's program directory.

The first line of the description that you wrote in the Comments Window
will appear in the Templates dialog when you choose Use Template after
selecting New from the File menu. You select the description in the
Templates dialog to load the template file.

You can modify existing template files. There is no limit to the number of
template files you can have.
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Appendix 2: System Files
This appendix describes the various system files that QuickScore Elite uses
and explains how you can change them. The system files are in QuickScore
Elite’s program directory. Make sure you make a copy of any system file
before you make changes to it.

QSD.INI

The initial settings for QuickScore Elite are stored in the file QSD.INI.
You should not change this file yourself, as QuickScore Elite will manage
this file itself.

DRUMS.INI

The settings for drums set in the Drum Notation dialog  are stored in the
file DRUMS.INI. You should not change this file yourself, as QuickScore
Elite will manage this file itself.
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PATCHES.INI

Patch lists are stored in a file called PATCHES.INI. Patch lists can be
added or modified as follows:

• Add your instrument to the [List of Lists] section. An equal sign must
immediately follow the name. Example:

MT32=

• Then create a section with your instrument name in it. Example:

[MT32]

• Add all 128 patch names that you want to use for your instrument in
your section, as in the [General MIDI] section of the PATCHES.INI
file.

At the end of the PATCHES.INI file are two sections that you should not
change. These are the [Channels] section and the [Channel Patch
Numbering] section.

Note: The file format of PATCHES.INI is compatible with that of the
PATCHES.INI files used by Cakewalk for Windows.

RANGES.INI

RANGES.INI contains the names and ranges for the instruments that you
have defined for range checking. You can add to or modify this file if you
like.

This file has three sections:

• The first section is [Instrument Count].

There is only one entry here, the number of instruments you have
defined for range checking. The number of entries in the next two
sections must have exactly the number of entries you have entered
here. This section looks like this:

[Instrument Count]
Count=2

• The second section is [Instruments].

Each entry consists of a number followed by an equal sign and a
text string that is the name of the instrument. Make sure the
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number of entries here is the same as the number in the
[Instrument Count] field. This section looks like this:

[Instruments]
1=Piccolo
2=Flute

• The third and last section is [Ranges].

Each entry here consists of a number followed by an equal sign and
four numbers. The first two numbers represent the lower and upper
full range of the instrument in MIDI notes. The next two numbers
represent the lower and upper practical range of the instrument in
MIDI notes. This section looks like this:

[Ranges]
1=74 108 79 93 ; Piccolo
2=60 110 62 106 ; Flute

Any text after the four range numbers is ignored. It is a good idea
to write down what instrument each range belongs to.

ALLOT.INI

Changing new engraver spacing tables is done by editing a file called
ALLOT.INI. The file consists of a list of spacing names and then a list of
spacing (one for each name). Each engraver spacing table has 15 entries,
each with a note value. The number for each note value is a relative
number, showing how much horizontal space a note of that duration should
have relative to a note of another duration. For example, if a quarter
note = 16 and an eighth note = 12, an eighth note is given 12/16 or 3/4 the
space of a quarter note.

To add a new engraver spacing table:

• Add your table name to the [ListOfAllotments] section. An equal sign
must immediately follow the name. Example:

MyName=

• Create a section with your table name in it. Example:

[MyName]



Appendix 2: System Files   219

• Add all 15 allotment entries in your section. (You can copy the
allotment entries from the [Default] section of the ALLOT.INI file and
substitute your own note values.) Example:

32nd=25
Triplet 16th=30
Dotted 32nd=30
16th=30
Triplet 8th=35
Dotted 16th=40
8th=40
Triplet Quarter=50
Dotted 8th=60
Quarter=60
Triplet Half=70
Dotted Quarter=80
Half=80
Dotted Half=100
Whole=120
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Appendix 3: MIDI Basics

Why MIDI Was Invented

Computers just love to work with numbers, and since music and
mathematics are intimately related (consider tempos, rhythmic divisions
such as quarter notes, vibrato rates, the frequency of middle C, etc.), it’s
probably not surprising that most current electronic musical instruments
contain an internal computer to do the number crunching.

In 1983, the MIDI (Musical Instrument Digital Interface) specification was
introduced to better exploit the computers inside these new musical
instruments and primarily to allow equipment from various manufacturers
to work together. MIDI expresses musical events (notes played, vibrato,
dynamics, etc.) as a common language consisting of standardized digital
data. This data can be understood by MIDI compatible computers and
computer-based musical instruments.

Before electronics, music was expressed exclusively as written symbols. By
translating musical parameters into digital data, MIDI can express not only
the types of musical events written into sheet music, but other parameters as
well (such as the amount of pitch bend or degree of vibrato).

MIDI Hardware

MIDI compatible devices usually include both MIDI in and MIDI out jacks.
These terminate in 5-pin DIN connectors. The MIDI out jack transmits
MIDI data to another MIDI device. As you play a MIDI controller such as a
keyboard, data corresponding to what you play comes out the MIDI out
jack. For example, if you play middle C, the MIDI out jack transmits a piece
of data that says middle C is down. If you let go of the middle C key, the
MIDI out transmits a message that says middle C has been released. If the
keyboard responds to dynamics, the note data will include dynamics
information as well. Moving the modulation wheels and pedals attached to
many synthesizers will also generate data that is unique to the wheel or
pedal being used.

The MIDI in jack receives MIDI data from another device. In addition to
the type of performance data described above, rhythmically oriented MIDI
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devices (e.g., drum machines) can often transmit and/or receive additional
MIDI timing messages that keep other rhythmically-oriented units in a
system synchronized with each other.

An optional MIDI thru jack provides a duplicate of the signal at the
MIDI in jack. This is handy if you want to send data to more than one
device.

For example, suppose a MIDI keyboard’s MIDI  out feeds the MIDI in of a
second tone module (called MIDI Device  1). Patching Device 1’s MIDI thru
to Device 2’s MIDI in sends the keyboard signal through to MIDI Device 2.
Thus, playing on the master keyboard can trigger both MIDI device  1 and
MIDI device 2.

About Sequencing

Sequencing, the computerized equivalent of tape recording, is a very
common and popular MIDI application. Only a few computers have a
built-in MIDI connection. Other computers, such as your PC, can hook up
to a device called a MIDI interface. This converts the MIDI data into a
format the computer can understand and allows the computer to control
MIDI instruments.

Sequencing takes advantage of the fact that MIDI data can correlate exactly
to a performance on a MIDI instrument. Suppose we feed this performance
data to a computer’s MIDI in jack, and load a program that instructs the
computer to remember the order in which the data appears at the MIDI in
jack. The computer acts like a recorder, but instead of recording audio, it
stores the digital data that represents the notes you played, and the exact
order in which you played them.

If you play a chord, each note in the chord results in a discrete piece of data.
These pieces of data, like all MIDI data, are sent one after the other
(serially). Fortunately, this happens at a very high rate so that notes played
at the same time appear to occur simultaneously, even if a few milliseconds
elapse between the first and last notes of the chord.

Once stored in memory, connecting the computer’s MIDI out to the
instrument’s MIDI in recreates the performance. The principle is the same
as a player piano, but instead of having keys triggered by holes in a roll of
paper, electronic sounds within the instrument are triggered by data
contained in the computer’s memory. This underscores the importance of
the MIDI standard specification. If the computer says play middle C, the
sound generator will play middle C, regardless of the manufacturer.
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Like a word processor, once the data is in the computer, it can be edited.
Notes, phrases, or measures can be erased, altered, transposed, and much
more. You can edit as little as the dynamics of one note, or as much as all of
the notes in an entire tune.

Each of MIDI’s 16 available channels can carry a unique set of MIDI data.
Since all of this data travels over one cable, each piece of data includes its
appropriate channel ID so that the MIDI receivers can tune in to a
particular channel and accept only that data.

A keyboard transmitting over channel  2 will stamp its data as belonging to
channel 2. This is particularly useful when sequencing, since each recorded
track can be assigned to a unique MIDI channel, and the associated piece of
gear can tune into a particular track. For example, if track  1 (set to MIDI
channel 1) carries bass and track 2 (set to MIDI channel 2) carries drum
data, you would set a bass sound generator to tune in to channel  1 and a
drum generator to tune in to channel 2.

MIDI Messages

There are two main types of MIDI messages. Channel  messages, which are
channel specific, consist of Voice and Mode messages. System  messages,
which do not have a channel number, and are received by all units in a
system, include Common, Real Time, and Exclusive.

The information about various types of MIDI messages and the data
structures associated with it is somewhat complex. For more information
about this topic, we refer you to the various books and magazines. See
“More Information about MIDI” on page 224 and “Magazines” on
page 225.

About Standard MIDI Files

The MIDI specification allows for sequence files to be stored in a consistent
format, thus allowing those files generated by one sequencer to be used by
another. For example, you could use a music composition program like
Band-in-a-Box to generate a sequence, then import it into QuickScore Elite
for editing and printing.

There are different types of MIDI files; the most common are type 0, where
all information is contained in a single multi-channel track; and type 1,
which puts each channel of MIDI data on its own track. Type  2 contains
multiple patterns which are arranged as a song. QuickScore Elite imports
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all three types. However, it only imports the first pattern of a type  2 MIDI
file . When music is imported from a type 0 file, the program will give you
the option to put each channel on a separate track.  QuickScore Elite exports
only type 1 MIDI files.

There are many MIDI files available commercially and in the public domain
on various bulletin boards like CompuServe or GEnie.

General MIDI

General MIDI is a set of rules within the MIDI specification that has been
developed with the hobbyist and casual user in mind. It establishes a
classification of instruments, appropriately enough known as General MIDI
instruments, which subscribe to a minimum set of operating standards and
which also standardize the way their sounds are organized. For example, all
General MIDI instruments provide an acoustic piano sound in patch  #0 and
a fretless bass sound in patch #36, etc. In addition, these instruments
standardize their drum key map organization and always use MIDI
channel 10 for the reception of drum sounds. There are many MIDI
sequence files available commercially and in the public domain which have
been created specifically for these kinds of instruments. Most sound cards
follow the General MIDI standard (at least loosely) and there are also a
number of high quality but inexpensive General MIDI instruments on the
market.

Windows and MIDI

The introduction of Microsoft Windows Multimedia Extensions (included
in Windows 3.1 and higher versions) provides a good deal of built-in MIDI
support. For one thing, it allows you to play MIDI files created in
QuickScore Elite through the Windows Multimedia Player. For another, it
provides a basic interface into which various manufacturers can plug in
software modules called drivers. These small applications are what allow
your computer to interface with various peripheral hardware devices such as
sound cards and MIDI interfaces (not to mention printers and hard disks).
This means that virtually all Windows programs , including QuickScore
Elite, can access virtually any hardware device (sound card, MIDI interface,
etc.) supported by Windows. For this to work successfully, however, you
must make sure that the drivers you require for your particular system are
correctly installed, using the Drivers applet in the Windows Control Panel.
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For more information, refer to your hardware owners manual as well as to
your Windows documentation.

Windows 3.1 and higher versions also provides another important MIDI
addition, the MIDI Mapper. This applet (also found in the Windows
Control Panel) allows you to create various setups that enable your system
to be optimized for your particular sound card or other MIDI devices. The
MIDI Setup option in QuickScore Elite’s Options menu allows the MIDI
Mapper to be used as a MIDI output device, thus enabling you to tap into its
power and flexibility. For more information on using the MIDI Mapper,
refer to your Windows documentation.

More Information about MIDI

The preceding does not substitute for reading a good book about MIDI. For
further information, refer to the following:

Taking The Mystery Out Of MIDI by Howard Massey; National Association
of Music Merchants. A 28 page booklet that acts as a MIDI primer.
Endorsed by the MIDI Manufacturers Association and International MIDI
Association, this publication is available free of charge from your local
music retailer.

MIDI For Musicians and The Electronic Musician’s Dictionary by Craig
Anderton; AMSCO Publications. The former was written specifically for
musicians with no background in MIDI, and the latter defines 1,000  terms
related to musical electronics. Highly recommended!

Music Through MIDI by Michael Boom; Microsoft Press. An excellent text
for those just getting started with MIDI, synthesis, and other related topics.

The Murphy’s Law MIDI Book by Jeff Burger; Alexander Publishing.
Emphasizes applications and problem solving.

Using MIDI by Helen Casabona and David Fredrick; Alfred Publishing. A
general guide to MIDI with an emphasis on applications.

Understanding MIDI and Understanding MIDI 2 by various authors;
Amordian Press. A collection of MIDI oriented articles from Musician
Magazine.

These are available from many music and book stores as well as from Mix
Bookshelf. Call them at 1-800-233-9604 for more information.
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Magazines

The following magazines often publish articles that relate to MIDI, as well
as related subjects such as synthesizers, etc.

Electronic Musician (6400 Hollis #12, Emeryville, CA 94608)

IMA Bulletin (5316 W. 57th Street, Los Angeles, CA 90056)

Keyboard Magazine (20085 Stevens Creek Blvd., Cupertino, CA 95014)

Roland User’s Group Magazine (c/o RolandCorp US, 7200 Dominion
Circle, Los Angeles, CA 90040)
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Appendix 4: General MIDI Programs
The following chart lists the sounds associated with MIDI program change
numbers 1 to 128.

Many manufacturers of electronic musical instruments and sound cards use
this list to assign program numbers to their sounds. This is done to create
uniformity in the selection of sounds. Regardless of the sound card you’re
using, you can be reasonably confident that you’ll hear a piano sound, for
example, if you assign Program 1 to a track in your score. Additionally, if
you save scores as MIDI files to be played by sequencers on other
instruments, your program assignments will remain reasonably consistent
regardless of the instruments on which the MIDI files are played. This
assumes, of course, that the manufacturers of those instruments adhere to
the General MIDI program change list. Most newer instruments will
conform to this list.

# Name

1 Piano 1

2 Piano 2

3 Piano 3

4 Honky-Tonk

5 Electric Piano 1

6 Electric Piano 2

7 Harpsichord

8 Clavinet

9 Celeste

10 Glockenspiel

11 Music Box

12 Vibraphone

13 Marimba

14 Xylophone

# Name

15 Tubular Bell

16 Santur

17 Organ 1

18 Organ 2

19 Organ 3

20 Church Organ 1

21 Reed Organ

22 Accordion

23 Harmonica

24 Bandneon

25 Nylon-String Guitar

26 Steel-String Guitar

27 Jazz Guitar

28 Clean Guitar
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# Name

29 Muted Guitar

30 Overdriven Guitar

31 Distorted Guitar

32 Guitar Harmonics

33 Acoustic Bass

34 Fingered Bass

35 Picked Bass

36 Fretless Bass

37 Slap Bass 1

38 Slap Bass 2

39 Synth Bass 1

49 Synth Bass 2

41 Violin

42 Viola

43 Cello

44 Contrabass

45 Tremolo Strings

46 Pizzicato Strings

47 Harp

48 Timpani

49 Strings

50 Slow Strings

51 Synth Strings 1

52 Synth Strings 2

53 Choral Ahs

54 Choral Oohs

# Name

55 SynVox

56 Orchestra Hit

57 Trumpet

58 Trombone

59 Tuba

60 Muted Trumpet

61 French Horn

62 Brass

63 Synth Brass 1

64 Synth Brass 2

65 Soprano Sax

66 Alto Sax

67 Tenor Sax

68 Baritone Sax

69 Oboe

70 English Horn

71 Bassoon

72 Clarinet

73 Piccolo

74 Flute

75 Recorder

76 Pan Flute

77 Bottle Blow

78 Shakuhachi

79 Whistle

80 Ocarina
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# Name

81 Square Wave

82 Sawtooth Wave

83 Synth Calliope

84 Chiffy Lead

85 Charang

86 Solo Vox

87 Saw Wave Fifths

88 Bass & Lead

89 Fantasia

90 Warm Pad

91 Polysynth

92 Space Voice

93 Bowed Glass

94 Metal Pad

95 Halo Pad

96 Sweep Pad

97 Ice Rain

98 Soundtrack

99 Crystal

100 Atmosphere

101 Brightness

102 Goblin

103 Echo Drops

104 Star Theme

# Name

105 Sitar

106 Banjo

107 Shamisen

108 Koto

109 Kalimba

110 Bagpipe

111 Kokyu

112 Shanai

113 Tinkle Bell

114 Agogo

115 Steel Drums

116 Woodblock

117 Taiko

118 Mellow Tom

119 Synth Drum

120 Reverse Cymbal

121 Guitar Fret Noise

122 Flanged Keyclick

123 Seashore

124 Bird

125 Telephone

126 Helicopter

127 Applause

128 Gun Shot
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Appendix 5: General MIDI
Percussion
The following chart indicates the note numbers normally associated with
specific percussion sounds. Many manufacturers adhere to this convention,
so you can be reasonably certain that your percussion tracks will play as
expected regardless of the sound device which plays them.

Note # Sound

B1 35 Kick Drum 2

C2 36 Kick Drum 1

C#2 37 Snare (Side Stick)

D2 38 Snare Drum 1

D#2 39 Hand Clap

E2 40 Snare Drum 2

F2 41 Low Tom 2

F#2 42 Closed Hi-Hat

G2 43 Low Tom 1

G#2 44 Pedal Hi-Hat

A2 45 Mid Tom 2

A#2 46 Open Hi-Hat

B2 47 Mid Tom 1

C3 48 High Tom 2

C#3 49 Crash Cymbal 1

D3 50 High Tom 1

D#3 51 Ride Cymbal 1

E3 52 Chinese Cymbal

F3 53 Ride Bell

Note # Sound

F#3 54 Tambourine

G3 55 Splash Cymbal

G#3 56 Cowbell

A3 57 Crash Cymbal 2

A#3 58 Vibra-Slap

B3 59 Ride Cymbal 2

C4 60 High Bongo

C#4 61 Low Bongo

D4 62 Mute High Conga

D#4 63 Open High Conga

E4 64 Low Conga

F4 65 High Timbale

F#4 66 Low Timbale

G4 67 High Agogo

G#4 68 Low Agogo

A4 69 Cabasa

A#4 70 Maracas

B4 71 Short High Whistle

C5 72 Long Low Whistle
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Note # Sound

C#5 73 Short Guiro

D5 74 Long Guiro

D#5 75 Claves

E5 76 High Wood Block

F5 77 Low Wood Block

F#5 78 Mute Cuica

G5 79 Open Cuica

G#5 80 Mute Triangle

A5 81 Open Triangle
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Appendix 6: Service and Support

Warranty

This program and the associated documentation are Copyright 1995 by Sion
Software Ltd. This program is licensed to be used on a single machine. It
may not be copied without explicit written permission. If the program is
transferred to another party, all backup copies must be transferred at the
same time, or destroyed. This notice of copyright must be transferred if you
transfer the program, and your license to use the program is terminated on
transfer.

The diskette on which the program is furnished is warranted for a period of
ninety (90) days from the date of delivery. The program is not guaranteed to
meet your requirements, and operation of the program is not guaranteed to
be interruption or error free. In no event will Sion Software or its employees
be liable for any damages, including any lost savings, lost profits, or other
incidental or consequential damages arising out of the use of or inability to
use this program, even if we have been advised of the possibility of
damages. Sion Software shall not be responsible for any damages claimed
by any other party, resulting from the use or attempted use of this program.
All warranties implied are with Sion Software, not your local dealer. If
problems arise, please call Sion Software directly.

The various products mentioned in this manual are registered or pending
trademarks of their respective manufacturers.

Upgrades And Replacements

Sion Software reserves the right to make improvements to the program
without notice, and to make what Sion Software considers to be reasonable
charges for updates and upgrades.

There is a $19.95 charge for the replacement of program disks that become
defective more than 90 days after the date of purchase.

When returning the disks for replacement or updates, please send them by
UPS, Federal Express, Express Mail, or some other service that will allow
you to trace the shipment. We’re sorry, but we cannot be responsible for
packages sent via regular US mail.
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Service And Support

Extensive efforts have been made to ensure that the information contained
in this manual is accurate and that the program is error  free. This is,
however, an imperfect world. Should you discover any bugs, errors, or
portions of the manual that are not clear, kindly send your comments to
Sion Software so that they may be considered for inclusion in future
revisions of QuickScore Elite.

Please take the time to fill in the registration card that’s in the package.
There are at least two good reasons for becoming a registered owner:

1. As a registered owner, you will be notified automatically of any updates
to QuickScore Elite.

2. As a registered owner, you will be entitled to free technical support for
QuickScore Elite.

What To Do If Problems Arise

If you have problems with QuickScore Elite that you are unable to resolve
after a careful reading of the manual, Sion Software maintains both
customer service and technical support  lines. We are happy to help you with
questions regarding QuickScore Elite, but due to the extraordinary variety
of music related products available today and the number of possible system
configurations, we cannot answer questions regarding hardware or software
from other manufacturers. This includes questions on the basic operation of
the IBM PC or other computers or musical instruments.

Customer Service

Customer Service is for owners who need replacement disks, upgrade or
update information, or who wish to purchase software. The telephone line
for customer service is the main number for Sion Software: (604) 222-2454.
Customer service personnel are unable to help you with technical questions.
If you have questions concerning technical matters, please phone the
technical support line.
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Technical Support

Technical support is for owners who are having difficulties with the
installation or operation of QuickScore Elite. When calling Sion Software
for technical support, there are a number of things that you can do to help
us help you (which can also save you money on your phone bill!). Here is a
checklist of things to have ready before calling:

1. Your diskette registration number.

2. Your manual.

3. Your computer turned on and QuickScore Elite running.

4. Any information that can help us solve the problem, especially
information about how to repeat your problem. If you cannot duplicate
a problem, it is very difficult for a technician to figure out what is
wrong!

5. Information on your computer’s make, model, disk configuration,
memory installed, sound source, monitor type, MIDI interface type if
installed, and so on.

6. Paper and pencil for taking notes.

When you call us, we’ll walk you through the program and ask you
questions about what happens. It is very important that you have the above
materials at hand when calling. If you don’t have this ready, we will ask
you to call back later with the required information.

After you have completed the checklist, call us at (604) 222-2455 between
10 AM and 2 PM Pacific Time, Monday through Friday. We’ll do
everything we can to get you on the road to making music with QuickScore
Elite.

You may also email technical support questions to: sionsoft@infoserve.net
or take a look at our web site at: http://www.infoserve.net/quickscore for
answers to your questions .
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Appendix 7: Troubleshooting
In this section, we’ll describe a few common problems that may occur
during the use of QuickScore Elite. If you’re having difficulties, review this
section for possible solutions. If you don’t find an answer here, please feel
free to call Sion Software technical support for assistance.

No Sound When Playing a QuickScore Elite Score
This can result from any number of causes. First, make sure you have
selected the appropriate MIDI output driver in the MIDI Setup dialog,
available from the Options menu. Also make sure that the MIDI Enabled
option is checked in the Options menu.

If the MIDI output driver you have selected in the MIDI Setup dialog does
not produce sound, try selecting the Midi Mapper. If QuickScore Elite now
plays, the output driver you first selected or the hardware it controls is not
set up correctly. If you can not get sound with the Midi Mapper, close
QuickScore Elite and open the Media Player (available in the accessories
folder under the Windows Program Manager). Select Open from the File
menu and open a MIDI file (try canyon.mid which comes with Windows.)
Click on the Play button to play the file. If you hear no sound, you do not
have a MIDI driver or its hardware correctly set up yet.

In the Windows Drivers applet (in the Control Panel), make sure the proper
drivers for your equipment are installed. Make sure that any special
parameters that may be required when the driver is loaded are set. For
example, if the default settings for your sound device's I/O address, IRQ
number, or DMA channel have been changed, the driver may not load
properly.

Next, make sure all your connections are in place. If you’re using an
internal sound card, make sure that it’s installed properly. It may not be
seated firmly in its card slot, and the audio connection may not be in place.

If you’re using a MIDI interface and an external sound source, check the
audio connections. Make sure the audio output from the sound source is
connected to the input of your sound system, whether it’s a home stereo or a
professional PA system. If you’re using a mixing board or amplifier, check
whether everything is turned on and whether the levels are at an audible
setting. Make sure your audio cables are functioning properly by connecting
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them to a sound source you know is working, and verify that the sound
source itself is functioning properly.

If you’re using a MIDI interface and an external sound source, check your
MIDI connections. You should have MIDI cables connected from the
MIDI out port of your MIDI interface to the MIDI in port of your sound
source. Check the MIDI cables with another MIDI controller and sound
source to make sure they’re not defective.

No Sounds with Patch Caching Sound Cards
If you are using a sound card that uses patch caching such as the Gravis
Ultrasound, you may not get any sounds when you first enter notes into
QuickScore Elite. The easiest way to remedy this is to make sure Patch
Caching is checked in the Options menu and that you have selected a
program for each of your tracks in the Program section in the Track Sheet.

Keyboard Commands Do Not Work Properly
You probably have Caps Lock on. This will interfere with some of the
keyboard commands. Turning Caps Lock off will probably take care of the
problem.

Musical Symbols Appear as Text on the Screen
This will happen if the Mozart font is not properly installed. To remedy
this, you must install the Mozart font. From the Windows Program
Manager, double click on the Control Panel icon, and then on the Fonts
icon. Click on the Add button. Go to the \WINDOWS\SYSTEM directory
in the Directories list box and find the Mozart font in the List of Fonts list
box. Click on the Mozart font and then click on OK. You will have to
reboot Windows before you can use the Mozart font in QuickScore Elite.
For more information about installing fonts see your Windows User’s
Guide.

Triplets and Other Durations Don’t Display Properly
If your display quantization is not set to a triplet value, triplets won’t be
properly displayed. Similarly, if your display quantization is set to a value
greater than the durations you are trying to display, these smaller durations
won’t be displayed properly. You can set the display quantization from the
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Display Bar, Display Track or Display Score dialogs. See “Quantization
Amount” on page 177, page 182, and page 187 for more information.

Eighth Notes Display as Quarter Notes and/or Rests
do not Appear
This will occur when the Extend Isolated Notes display option is set to
Yes. When this is the case, all notes will extend in duration to the
beginning of the next note, or to the beginning of the next beat, whichever
is first. This makes notes appear longer than they actually are and
eliminates rests. Generally this leads to a more attractive score. This is the
default. To make notes display exactly as written, set Extend Isolated
Notes to No in the Display Score, Display Track or Display Bar dialog.

When Selecting Objects No Menu Appears or Only the
Stretch Time Dialog Appears
This can occur in the Score Editor if you are trying to select one type of
object and the object type palette is set to something else. To fix this, make
sure you select the proper object in the object type palette. It can also
happen in the Score Editor or other editors if there are no objects included
in your selection.

Incorrect Objects are Entered
This can occur in the Score Editor if you are trying to enter one type of
object and the object type palette is set to something else. For example, if
you try to enter text and symbols are entered instead, you have the wrong
object selected in the object type palette. To fix this, make sure you select
the proper object in the object type palette.

Lyrics Don’t Align With Notes
If you are getting unexpected results trying to align lyrics with notes, it may
be because your notes are not quantized. Lyrics are not quantized when they
are displayed, so they won't line up with unquantized notes that are
displayed quantized on the screen. To remedy this, make sure the notes you
are trying to match with lyrics are physically quantized to the same value as
the display quantization.
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Notes or other Objects Don't Erase In the Score Editor
First make sure that the correct object palette is selected. Try to select the
object by double clicking on it. If this does not work, try selecting the object
by dragging a box around it with the mouse. If the object is still not
selected, the object may have been entered on a different track from the one
you are editing. To check this, select single track mode and see if the object
still appears. If the object has disappeared, it means it is on a different track.
Look at your other tracks in single track mode until you see the object you
want to erase. (It will appear either above or below the staff, so that in full
score mode it appears on a different track.) Now select the object and erase
it.

Fader Motions are Jerky in the Mixer
When you are using the Mixer, it is a good idea to disable scrolling the
display while playing. Otherwise the fader motions may become jerky while
the windows are being redrawn. To disable scrolling, you can set the
Options menu item Scroll While Playing to off.
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Appendix 8: Tips
The following tips may save a lot of time or even a technical support call.

How to Make Sure Triplets Display Correctly
Make sure you set the display quantization to a triplet value. You can set the
display quantization from the Display Bar, Display Track or Display Score
dialogs. If your display quantization is not set to a triplet value, triplets
won't be properly displayed. Similarly, if your display quantization is set to
a value greater than the durations you are trying to display, these smaller
durations won't be displayed properly.

How to Make Sure Notes Display With Their Entered
Durations
To make notes display exactly as entered, set Extend Isolated Notes to No in
the Display Score, Display Track or Display Bar dialog. If you set the
Extend Isolated Notes display option to Yes, all notes will extend in
duration to the beginning of the next note, or to the beginning of the next
beat, whichever is first. This makes notes appear longer than they actually
are and eliminates rests. Generally this leads to a more attractive, less
cluttered score. This is the default. You must also make sure your display
quantization is set to a value equal or smaller than the durations you are
trying to display. Otherwise, durations smaller than the display quantization
won't be displayed properly.

How to Change a Note's Pitch by One or More
Semitones
There are two ways to change the pitch of a note by semitones using the
Score Editor. The first is to select the note (by double-clicking, control-
clicking or dragging the mouse - see The Mouse on page 10) and then
choosing Transpose from the Edit menu. The second is to choose the NS
tool, select the note to be transposed by clicking and holding down the
mouse over the note, and then, instead of dragging the note up and down
with the mouse, which moves the note in key, press the Up or Down arrow
keys. Do not try to transpose a note by selecting the note and choosing
Accidental from the Edit menu - this will only change the enharmonic
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spelling of the selected note. You can also change the pitch of a note by
semitones using the NS tool in the Piano Roll Editor.

How to Change the Enharmonic Spelling of a Note
Select the note (by double-clicking, control-clicking or dragging the
mouse - see The Mouse on page 10) and then choosing Accidental from the
Edit menu. Select the accidental you wish for the note. For example, if you
want to change a B flat to an A sharp, choose Sharp. If you want to change
an E flat to an F double flat, choose Double Flat.

How to Display Quarter Note Triplets
To display quarter note triplets, you must first set the display quantization
to a triplet value. By default, quarter note triplets display the first triplet as a
quarter note, the second triplet as an eighth note tied over the beat to
another eighth note and the third triplet as a quarter note.

To display as three quarter notes, set the beat for the measure containing the
quarter note triplet to a half note. This will ensure that notes are placed in
the measure in half-note groupings. To do this, put the cursor in the bar
containing the quarter note triplet, choose Display Bar from the Display
menu and then change the Beat option to Half. To change the grouping
back to quarter notes (or whatever value you were using) in the next
measure, you must move the cursor to the next bar and from the Display
Bar dialog change the Beat option to Quarter (or the value you were
previously using).

If you don't want to change the beat value, you can do the following: Set the
Display Rests option to Off in the Display Bar dialog. Enter the first and
second triplet quarter note at the beginning of the first beat and enter the
third triplet quarter note in its regular place. Now select the spacing tool
and drag the second quarter note triplet over until it is equidistant from the
first and the third triplet.

If your bars per line setting is set to two or less, you will not be able to drag
the second triplet far enough over. You will have to adjust the bar line or
other notes in your bar with the spacing tool or else set the bars per line for
that line to a value greater than two.

If you have any rests in the bar you will have to enter them from the
symbols palette, since you have disabled the display of rests for that bar.
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How to Adjust Ties and Rests
Rests, ties and tied notes are generated automatically by QuickScore Elite.
For this reason it is usually futile to try to edit rests and tied notes. The
exception is when you have explicitly entered rests or tied notes yourself.

The level of rests and ties can be adjusted so that they don't overwrite notes
or other symbols. This is done from the Display Bar dialog. You can also
choose not to generate rests at all in a given section of your music and put
them in yourself. You can do this for a given bar using the Display Bar
dialog or, for an entire track, using the Display Track dialog. Now you can
enter the rests yourself as symbols using the Notes palette.

If you really must have a tied figure displayed in a manner that you can't
seem to get any other way, you can enter the note, the ties, and the tied
notes by hand. Use a slur to simulate the tie. You can set the velocity of the
tied notes to zero if you like.

For more information on how QuickScore Elite transcribes music, see Notes
on Transcription on page 94.

How to Display Independent Voices in a Bar on the
Same Staff
Select voice 1 from the voice palette at the far right of the Score Editor
control area and enter the notes for the top voice as you would normally. All
the stems for these notes are up. Rests appear by default at the top of the
staff, not in the middle, as they do when notes are entered with the default
voice. Now select voice 2 from the voice palette and enter the notes for the
bottom voice. For this voice, rests appear by default at the bottom of the
staff.

You can change the level of the display of rests for a particular voice in a
bar by changing the Rest Level option for that voice from the Display Bar
dialog, available by selecting Bar from the Display menu.

How to Display Grace Notes
The best way to enter grace notes is to select Grace from the voice palette at
the far right of the Score Editor and then enter the grace notes where you
like. This way the timing of the grace notes will not interfere with the
timing of the rest of the notes in the measure. Grace notes entered this way
do not generate any rests.
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If you want to enter grace notes before the first note of the measure, you can
enter the grace notes at the beginning of the measure, and then with the
spacing tool move the non-grace notes on the first beat over a bit so they are
not obscured by the grace note.

How to Display Cue Notes
Cue notes should be entered on a voice separate from the voice of the notes
for the main instrument. For example, if the main voice is the default voice,
you should choose voice 1 or voice 2 for the cue notes. Cue notes should be
small notes, so when you have entered the cue notes, select them and set the
size for the notes by choosing Group, then Small Notes and then Default
Group.

How to Force the Direction of Stems
If you want all the notes in a track to go up or down, you can set Use
Ascending or Descending Stems to the direction you want from the Display
Track dialog.

If you want to enter two voices, one with stems up and one with stems
down, proceed as explained in the section above on displaying independent
voices in a bar on the same staff.

If you want only a selected group of notes to have stems a certain direction,
select these notes, and set the stem direction by choosing Group, then either
Big Notes or Small Notes and then the stem direction you want. Doing this
will also group together the notes that you have selected, so make sure that
you select the notes in beam groupings that you want. If you want to set the
beam groupings back to the default (grouped by beat) select Default Group.

How to Effectively Space Music
There are three basic ways to space music, which can be used in
combination with each other.

The first is to use engraver spacing. Select Engraver Spacing from the
Display Score dialog. When engraver spacing is used, notes are spaced by
their appearance, not by their durations. With engraver spacing, a whole
note will take up much less space than four groups of thirty-second notes.
Engraver spacing does not affect the placement of bar lines or the number
of bars in a line.

The next is to adjust the placement of bar lines and the number of bars in
each line.
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The simplest way to adjust the placement of bar lines and the number of
bars in each line is to let QuickScore Elite do the job. Choose the Space
Music dialog from the Display menu, set the density you want (the number
of 16th notes that would appear on a line at the density you have selected
will be shown) and click on OK. The placement of bar lines and the number
of bars in each line will be adjusted based on the density of music in each
bar and each line. You can choose to only space bar lines or bars per line,
and you can select a range of bars instead of your whole piece, but it is
worth having QuickScore do everything, at least the first time.

The adjustment of bar lines can be done by hand using the spacing tool (on
the far right in the tool bar). The number of bars in a line can be changed
line by line by putting the cursor in the first bar of the line and selecting the
Display Bar dialog and setting the Bars per Line value. You can also set the
number of bars per line globally by setting it in the Display Score dialog.

Finally, you can move individual notes around without affecting their
timing using the spacing tool. Use this technique to adjust the few notes that
still aren't in the right place. (The second method of drawing quarter note
triplets described earlier is an example of using the spacing tool to adjust
note spacing.)

How to Create a Pickup Measure
The first thing to do is to get rid of the rests in the pickup measure. With
the cursor in the first measure, set Display Rests to No in the Display Bar
dialog. You will have to do this for each track you have. (Move the cursor to
the first measure in each track and set Display Rests to No in the Display
Bar dialog.)

Now set the bar numbers to start numbering at the second bar. Select the
Bar Numbers dialog by selecting Numbers from the Display Menu and Bar
from the submenu that appears.

Enter the pickup notes you need in your pickup bar. If you need to enter
rests in the pickup bar, use the rest symbols in the Notes and Rests palette to
do so. Remember pickup measures usually don't have rests.

To minimize the physical size of the pickup bar, drag the first barline to the
left using the spacing tool.

How to Effectively Enter Lyrics
Lyrics can be entered all at the same time once you have entered your notes.
Select the Lyric object in the objects palette and the Pen tool from the
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toolbar. Click on the first note and enter the syllable for that note. Now
press the TAB key to move the cursor to the next note. Continue typing and
going from note to note using the TAB key (and SHIFT+TAB key to go
backwards). If you want to enter a single hyphen between two syllables,
enter CTRL+-(dash) instead of TAB. If you want to enter a double hyphen
between two syllables, enter CTRL+SHIFT+-(dash). You do not have to
click on each note individually to enter its lyric syllable.

You can enter four levels of lyrics. To select the lyric level you want, select
the lyric number from the lyric list box at the right of the Score Editor
control area.

To adjust the level of lyrics, select the Lyric Positioning dialog by clicking
on the Lyrics button in the Display Page dialog, available under the Display
menu.

Importing EPS files from QuickScore Elite into other
Windows programs
It is possible to import from QuickScore Elite into other Windows programs
using Encapsulated PostScript (EPS) files. To create an EPS file using
QuickScore Elite, you must use the Windows PostScript printer driver.
When you print, select Printer, then Options and select Encapsulated
Postscript File. Write the name of the EPS file you will create.

The EPS file you create can be imported into any program that imports EPS
files. Microsoft Word for Windows is an example of such a program. To
print these files you need a PostScript printer and the Mozart TrueType font
installed in Windows. (If you have installed QuickScore Elite on your
system, this will be the case.)
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Glossary

aftertouch

Aftertouch is a MIDI message that tells you how hard a key is being held
down (or, if we are talking about a non-keyboard controller, how much
pressure is applied to a note) after it has been initially played.

block text

In QuickScore Elite, block text is distinguished from lyrics and expressions.
Blocks of text can be any size and font.

channel

MIDI messages can be sent and received over sixteen channels. This allows
you to have several instruments hooked up together, or instruments with
more than one voice, each playing notes sent on separate channels. For
example, a sequencer like QuickScore Elite can send notes on channel  1 to
a drum machine, notes on channel  2 to a guitar synthesizer and notes on
channel 3 to an electronic piano, which are all hooked together on the same
MIDI network.

clipboard

The clipboard is where Windows stores temporary data. This data can be of
just about any type and can be used by any Windows program that
recognizes it. When QuickScore Elite cuts notes or other events, they are
copied to the clipboard. You could exchange data between two copies of
QuickScore Elite running at the same time using the clipboard.

control area

The control area refers to the gray area at the top of a window which
contains palettes, buttons and controls. The main window, the Score Editor,
the Piano Roll Editor, the Controller Editor, the Mixer, the Event List and
the Song Editor all have control areas.
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Control Panel

The Windows Control Panel lets you change the way you have set up your
Windows system. You can set up fonts, printers, MIDI drivers, the MIDI
Mapper and other things that affect your system. The settings you choose in
the control panel affect all Windows programs, including QuickScore Elite.

control points

Control points are used when you enter or edit adjustable symbols such as
slurs or crescendos. Control points for slurs are shaped like little triangles.
Control points for other symbols are shaped like little diamonds. There is
one control point on the left edge of the symbol, one in the middle and one
at the right edge. You click on a control point to select it. You can drag a
control point around on the screen, which will cause the symbol to adjust its
shape.

controller

Controllers are MIDI messages that control some aspect of the sound made
by the receiving instrument. There are 127  controller messages. Two of the
common controllers are volume and pan.

A controller also refers to any device that sends MIDI commands, such as a
keyboard, a breath controller or a MIDI guitar.

count-in

When you record you use a count-in. The count-in is a number of beats,
which is typically three or four. You set the count -in beat count in the
Metronome dialog under the Options menu.

cursor

There are cursors in the Score Editor, the Piano Roll Editor, the Controller
Editor and the Song Editor. In the Score Editor the cursor is a vertical line
over a staff with ledger lines above and below it. In the Piano Roll and the
Controller Editors the cursor appears as a vertical magenta line across the
display. In the Song Editor, the cursor appears as a box around the current
bar. The time of the cursor is displayed in the Time Display, in the middle
of the main control area. Step entry with the mouse or the keyboard takes
place at the cursor point, as well as pasting of data that has previously been
cut or copied.
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duration value

The duration value is the duration of notes that are entered with the mouse
or in step time from the keyboard. It is also the amount the cursor will move
forward when you press the arrow keys. When you position the cursor with
the mouse in the Score Editor, it will always move to a multiple of the step
value. This is the same for the Piano Roll Editor, except when the
Snap/Free button is set to Free. In this case, the cursor will move to the
exact point the mouse is clicked.

You set the duration value using the durations palette and the duration
value qualifier button in the main control area.

engraver spacing

Engraver spacing is used to space music so that it looks good visually.
When you use engraver spacing, you assign the amount of space notes of
each duration take up. For example, you can have thirty-second notes taking
up only half as much as quarter notes if you want to. Your music will
generally look better if you use engraver spacing.

Without engraver spacing, spacing occurs by time, rather than by
appearance. Crowding of music sometimes occurs, because you always put
music occupying the same amount of time in the same amount of space. For
example, eight thirty-second notes take up the same amount of space as one
quarter note. The thirty-second notes are crowded together and the quarter
note is all by itself.

event

An event is a single piece of data used by QuickScore Elite. An event is also
called an object. An event can be a note, a lyric, an expression, a piece of
text, a symbol, a clef, a MIDI event (like a controller or pitch bend), or a
tempo change.

expression

An expression is a type of text used in QuickScore Elite to denote the
expression or the nature of the music. Typical expressions are allegro, a
tempo, agitato, or cantabile.

fader

Faders are used in mixing boards to change the value of certain parameters
(such as volume or pan). They are sliding switches which move up and
down. In QuickScore Elite you grab a fader with the mouse and drag it up
and down to do exactly the same thing you would on a real mixing board.
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General MIDI

General MIDI provides a standard list of MIDI instruments and drum
sounds. For example, a General MIDI instrument always provides a piano
sound for patch 0 and a fretless bass for patch 36. All General MIDI
instruments use MIDI channel 10 for drum sounds. The mapping of pitches
to drum sounds on channel 10 is standardized. See “Appendix 4: General
MIDI Programs” on page 226 and Appendix 5: General MIDI Percussion
on page 229.

icon

An icon is a button with a picture on it representing an object or an action.

loop

When you play in QuickScore Elite, you can have the music loop. You set
up the loop using the Loop control in the main control area. You can edit
while you loop. This allows you to make a lot of experimental changes and
immediately hear what they sound like.

lyric

Lyrics are words set to music. In QuickScore Elite, lyrics are attached to
notes. When you enter lyrics, the text is centered under the note.

Media Player

The Media Player is an application that comes with Windows. It allows you
to play wave and MIDI files. It is useful for testing your MIDI setup.
Normally if the Media Player can play a MIDI file, QuickScore Elite should
be able to as well.

metronome

In QuickScore Elite, you are provided with an audible metronome which
sounds once a beat at the current tempo. It can be set up to sound when you
record or play.

MIDI

MIDI is a protocol for transferring musical data between synthesizers and
computers. See “Appendix 3: MIDI Basics” starting on page 220 for a
discussion of MIDI.
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MIDI clock

MIDI clock is a MIDI message sent twenty-four times per quarter note. It is
used to synchronize two MIDI devices. It can also be used to synchronize a
sequencer to tape, but it is usually easier to use MIDI time code for this
purpose instead.

MIDI file

MIDI files are files in a standard format containing MIDI data, usually
songs. They can be read and written by most sequencers, including
QuickScore Elite. There are three types of MIDI files, type  0, type 1 and
type 2. Type 0 MIDI files contain data in a single track. Type  1 MIDI files
contain data in multiple tracks. Type 2 MIDI files contain data in multiple
tracks and are broken up into multiple sections (or patterns). Type  2 MIDI
files are uncommon. MIDI files have the extension .MID.

QuickScore Elite reads type 0 and type 1 MIDI files and writes type 1 MIDI
files. It can also read the first pattern of a type 2 MIDI file.

MIDI in

Each MIDI device including your computer has a MIDI  in and a MIDI out
port. MIDI in is where MIDI data comes into the device. In QuickScore
Elite, the MIDI in is used for recording.

MIDI interface

Your computer needs a MIDI interface to be connected to other MIDI
devices. A common MIDI interface is the Roland MPU-401. A MIDI
interface will have at least a MIDI in and a MIDI out port.

MIDI Mapper

The MIDI Mapper is a Windows application that comes with Windows. It
lets you specify MIDI settings for your system. You can select the MIDI
Mapper as your MIDI output device instead of a regular driver in the MIDI
Setup dialog in QuickScore Elite.

MIDI out

Each MIDI device including your computer has a MIDI  in and a MIDI out
port. MIDI out is where MIDI data leaves the device. In QuickScore Elite,
the MIDI out is used for playing.
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MIDI time code

MIDI time code is used to synchronize a sequencer to tape. MIDI time code
(or MTC) messages are sent four times per SMPTE frame, that is from  96
to 120 times a second, depending on the SMPTE format. The SMPTE
format is encoded in the message. This allows synchronization which is
independent of tempo, which distinguishes it from MIDI clock.

object

An object is a single piece of data used by QuickScore Elite. An object is
also called an event. An object can be a note, a lyric, an expression, a piece
of text, a symbol, a clef, a MIDI event (like a controller or pitch bend), or a
tempo change.

palette

A palette is a group of icons, one of which is usually selected. You click on
an icon to select it. QuickScore Elite's toolbars are palettes, as is the
durations palette and the object type palette.

patch

A patch (also called a program) is the sound stored in an instrument. You
choose a patch by sending the instrument a program change command.

patch list

A patch list is a list of the names of all the patches contained in an
instrument. There are 127 patches in a patch list.

piano roll notation

Piano roll notation emulates the piano rolls used in player pianos. Time is
represented horizontally and pitch is represented vertically. At the top of the
display are the bar numbers. To the left is a vertical piano keyboard
showing the pitches of the notes in the display. Notes appear in the note
area as horizontal bars. The vertical position of the bar indicates the pitch of
the note. The beginning of the bar shows the note's start time and the length
of the bar shows the note's duration.

print preview

In the Score Editor you can view your music in normal (or Edit  mode) or
Print Preview mode. Print Preview mode lets you see your music as it will
be printed out. You can see the whole page in your window in Print Preview
mode by clicking on the 100% button. You can't edit in Print Preview mode.
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program change

Program changes are MIDI commands that tell the receiving instrument to
change its internal sound to the one specified by the program change
number associated with the program change command.

punch-in and punch-out

Punch recording is used to record over a certain section of music without
disturbing the music before and after the section. The punch -in point is the
point where the section starts and the punch -out point is the point where the
section ends.

quantization

Quantization is used to make sure notes start and end on exact boundaries.
For example, if a quantization setting of sixteenth notes is used, all notes
will start and end on 16th note boundaries. In QuickScore Elite, notes can
be physically quantized or the display of the notes can be quantized without
affecting the real timing of the notes.

QSD file

QSD files are the native files of QuickScore Elite. They are more elaborate
than MIDI files, because they contain a good deal of formatting information
as well as all the types of objects QuickScore Elite supports. QSD files have
the extension .QSD.

sequencer

A sequencer is a device that controls (or sequences) the MIDI data that is
sent to a MIDI setup. There are hardware and software sequencers.
QuickScore Elite performs the function of a sequencer.

SMPTE

SMPTE is a time-based synchronization protocol developed by the Society
of Motion Picture and Television Engineers. It is the most widely used
protocol for synchronization of video and audio devices. SMPTE devices
can be linked to MIDI devices using special hardware, which typically
converts SMPTE to MIDI time code.

sound card

Sound cards are the most cost-effective way to provide a computer system
with MIDI sound. A sound card plugs into your computer and lets you play
MIDI and often wave audio.
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step entry

Step entry allows you to enter notes or chords of a given duration from your
keyboard. You set the duration value in the durations palette and then enter
the notes from the keyboard. The notes are entered at the cursor point.
Every time a note or chord is entered, the cursor advances by the duration
value, setting up to enter a new note or chord after the last one.

symbol

Symbols in QuickScore Elite include dynamics, articulation marks, slurs,
guitar chords, figured bass and a great variety of other musical symbols.

tape transport

QuickScore Elite's tape transport is where the play, record, pause and stop
button are. It is in the middle of the main transport.

time display

The time display in QuickScore Elite shows the time of the cursor in the
current window. The time is displayed in Bars:Beats:Steps format on the top
and in SMPTE format below that. The time display appears in the middle of
the main control area.

toolbar

A toolbar is a palette of tools. You select tools to perform different
operations upon objects. In QuickScore Elite the Score Editor, the Piano
Roll Editor and the Controller Editor have toolbars, located at the far left on
their control areas.

track

In QuickScore Elite, events or objects are organized into tracks. In the Score
Editor, each track is shown as either a single staff or as two staves bound
together with a curly brace, the top staff having a treble clef and the bottom
staff having a bass clef.

TrueType font

TrueType fonts are Windows fonts that can be resized and appear on the
screen exactly as they appear when printed. The Mozart font  used by
QuickScore Elite is a TrueType font.
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velocity

MIDI note messages all contain a velocity. This generally refers to the
velocity with which a key is depressed, which translates into a dynamic
level, but this is not explicitly defined. Some MIDI instruments allow you to
assign velocity to different attributes of the note.

wave file

Wave files contain audio data. These can be sound effects or even musical
compositions. Wave files provide a fairly exact representation of sounds,
depending on their resolution and the hardware they are played on, but they
are a lot bigger than MIDI files. Wave files have the extension .WAV.
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—A—
About command (Help menu), 212
accidental, 95, 145
Accidental command (Note block

editing menu), 145
adjustable symbol, 153
aftertouch, 243
ALLOT.INI file, 205, 216
Arrange dialog, 160
Arrange Icons command (Window

menu), 211
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—B—
Bar command

(Display menu), 173
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menu), 191
bar numbers, 31
Bar Numbers dialog, 191
barline, 169, 176

spacing, 30
bars

copying and pasting, 62
erasing, 65
inserting, 66

Bars of Rest command (Display
menu, 194

bars per line, 175, 180, 184
beaming

cross-staff, 96
groups, 95
join stems, 177, 180, 185
stem direction, 95, 177, 180, 185

beat, 175, 184
bibliography, 222

Bitmap, 131
block editing menus, 139, 158

Clef, 155
Controller, 156–58
Expression, 150
Lyric, 148–49
Note, 140–48
Song Edtor, 159–61
Symbol, 152–54
Text, 151–52

Block End command (Edit menu),
136

Block Start command (Edit menu),
136

block text, 85, 243
entering, 40
moving, 41

block text font list box, 85
Block Text mode, 85
braces, 33, 169, 170

—C—
Cache Patches command (Options

menu), 209
Cascade command (Window menu),

211
change note list box, 110
channel, 243
Channel command (Note block

editing menu), 143
channel selector, 104, 109
Chase Controllers command

(Options menu), 208
chord, 90, 153
Clear All button, 120
clef, 86, 96, 181

editing, 155
entering, 45
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Clef block editing menu, 155
Clef mode, 86
clef palette, 86
clipboard, 135, 243
clock, 208, 247
Comments Window, 127
composer, 189
Contents command (Help menu),

212
control area, 72–78, 243
Control Panel, 244
control points, 88, 153, 244
controller, 208, 210, 244

editing, 57, 156–58
entering, 57
erasing, 57
selecting, 111

Controller block editing menu, 156–
58

Controller Editor, 55–58, 108–14
conventions

keyboard, 3
menus, 9
mouse, 10
typographical, 3–4
windows, 8
Windows programs, 8–11

copy, 135
Copy command

(Clef block editing menu), 155
(Controller block editing menu),

156
(Event List block editing menu),

159
(Expression block editing menu),

150
(Lyric block editing menu), 149
(Note block editing menu), 141
(Song Editor block editing menu),

160
(Symbol block editing menu), 152
(Text block editing menu), 151

Copyist, 131
count-in, 244
crescendo

entering, 43
Crop command (Controller block

editing menu), 158

cross-staff beaming, 96
cursor, 13, 210, 244

moving, 93, 105
customer service, 230
cut, 135
Cut command

(Clef block editing menu), 155
(Controller block editing menu),

156
(Event List block editng menu),

159
(Expression block editing menu),

150
(Lyric block editing menu), 149
(Note block editing menu), 141
(Song Editor block editing menu),

160
(Symbol block editing menu), 152
(Text block editing menu), 151

—D—
data type list box, 109, 119
defective disks

replacement, 229
Delete command (Track menu), 166
Display Bar dialog, 173
Display menu, 166–95
display note list box, 110
Display Page dialog, 167
display rests, 176, 182
Display Score dialog, 183
Display Track dialog, 179
drivers, 221
drum clef, 96
drum notation, 206
Drum Notation command (Options

menu), 206
drum note heads, 86, 206
DRUMS.INI file, 207, 214
Duration command (Note block

editing menu), 142
duration qualifier, 72
duration tool, 103
duration value, 13, 245
durations palette, 72
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—E—
Edit command

(Lyric block editing menu), 149
(Symbol block editing menu), 153
(Text block editing menu), 151
(Track menu), 165

Edit menu, 135–39
Edit Notes/Edit Waves indicator,

105
editing

block text, 151–52
symbols, 152–54

ending, 89, 154
engraver spacing, 33, 187, 204, 245
Engraver Spacing command (Options

menu), 204
enharmonic spelling, 95, 145
eraser tool, 82, 102, 111
event, 245

editing, 65, 121, 158
erasing, 64
selecting, 122

event colors
Event List, 122
Song Editor, 125

Event List, 61–66, 121–23
Event List block editing menu, 158–

59
event position locator, 113
EW tool, 82, 103, 112
Exit command (File menu), 134
Explode command (Note block

editing menu), 146
Export Picture command (File

menu), 131
Expression block editing menu, 150
Expression mode, 85
expression text, 245

editing, 39, 150
entering, 85

extend isolated notes, 94, 177, 181,
185

External Clock command (Options
menu), 208

—F—
fader, 118, 245
fader channel, 116, 119
figured bass, 93, 153
file

BMP, 131
Copyist, 131
MIDI, 23, 129, 131, 220, 247
new, 128
opening, 21, 135
QSD, 131, 249
saving, 20, 130
TIFF, 131
wave, 50, 101, 105, 251

File Input and Record Filters
command (Options menu), 200

File menu, 128–35
Filters dialog, 200
Find Event command (Goto menu),

163
Find Next command (Goto menu),

163
font

changing, 41, 85, 86, 172, 188
TrueType, 250

footer, 189
further reading, 222

—G—
General MIDI, 22, 221, 246

percussion mapping, 227
program change numbers, 224

Goto menu, 162–64
grace notes, 28, 84, 143
Group All button, 119
Group command (Note block editing

menu), 144
grouping

notes, 95
guitar chord, 92, 153

entering, 44
spacing vertically, 44, 169

—H—
header, 189
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Help menu, 212
Hide Notes/Show Notes button, 113
Hide Waves/Show Waves button,

105

—I—
icon, 246
Implode command (Note block

editing menu), 147
include bar lines, 185
indentation, 32
Insert command (Track menu), 166
Insert Space command (Song Editor

block editing menu), 161
installation, 5
Instrument Range command (Track

menu), 165
Interpolate command (Controller

block editing menu), 156

—J—
join stems, 177, 180, 185

—K—
key signature, 174, 186
keyboard commands don't work, 233
keys

Controller Editor, 114
conventions, 3
Event List, 123
main control area, 78
Mixer, 120
Piano Roll Editor, 107
Score Editor, 98
Song Editor, 126

—L—
legato, 145, 209
legato entry, 98
Legato Entry command (Options

menu), 209
lock controllers, 210
Lock Controllers command (Window

menu), 210

lock cursors, 13, 47, 210
Lock Cursors command (Window

menu), 210
lock tracks, 13, 47, 210
Lock Tracks command (Window

menu), 210
loop control, 75
looping, 50, 75, 246
lyric, 246

deleting, 36
editing, 148–49
entering, 37, 85
spacing vertically, 38
vertical positioning, 171

Lyric block editing menu, 148–49
lyric filter, 36, 138
Lyric Filter command (Edit menu),

138
Lyric mode, 84
lyric number, 84
Lyric Number command(Lyric block

editing menu), 149

—M—
magnifying glasses, 106
Make Legato command (Note block

editing menu), 145
Marker command (Goto menu), 164
Media Player, 246
menu conventions, 9
metronome, 16, 67, 73, 197, 246
Metronome command (Options

menu), 197
metronome marking, 153
MIDI, 246

basics, 218
file. See file, MIDI
in, out, 247
reference material, 222
setup, testing, 7

MIDI clock, 208, 247
MIDI Enabled command (Options

menu), 208
MIDI interface, 247
MIDI Mapper, 221, 247
MIDI Setup command (Options

menu), 196
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MIDI time code, 208, 248
MIDI thru, 68, 201
MIDI Thru command (Options

menu), 201
Mixer, 59–60, 118–20
mouse channel, 116
mouse conventions, 10
mouse position locator, 113
mouse time locator, 84, 104
Move command

(Expression block editing menu),
150

(Lyric block editing menu), 149
(Symbol block editing menu), 152
(Text block editing menu), 151

Mozart font, 250
multi tool, 103

—N—
New command

(File menu), 128
(Track menu), 166

note
deleting, 27
editing, 29, 51, 52, 56, 140–48
editing non-contiguous, 53
entering, 18, 52
extending, 94
grace, 28, 84, 143
grouping, 95
moving, 20, 51
selecting, 81
size, 96
spacing, 30
tied, 96

Note block editing menu, 140–48
note filter, 137
Note Filter command (Edit menu),

137
Note Input Velocities dialog, 203
Note mode, 84
NS tool, 82, 103, 112
NSEW tool, 82, 103, 111
Numbers command (Dispaly Menu),

190

—O—
object, 11, 248

entering, 12
selecting, 12

object type palette, 84
octava, 89, 154, 187
Octave command (Note block editing

menu), 142
Open command (File menu), 129
Options menu, 196–209
owner registration, 230

—P—
Page button, 87
Page command

(Display menu), 167
(Numbers submenu, Display

menu), 190
page numbers, 32
Page Numbers dialog, 190
palette, 248
Panic button, 77
Paste command (Edit menu), 135
patch, 248
patch caching, 209, 233
patch list, 22, 202, 248
Patch Lists command (Options

menu), 202
PATCHES.INI file, 215
pencil tool, 82, 102, 111
Piano Roll Editor, 49–54, 100–107
piano roll notation, 248
pitch locator, 104
Play command

(Note block editing menu), 145
(Play menu), 164

play menu, 164–65
Play Score button, 76
Play Screen command (Play menu),

165
Play Without Scrolling command

(Play menu), 164
playing, 15, 21, 73, 145
Print File command (File menu), 132
Print Line command (File menu),

133
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Print Part command (File menu),
133

Print Preview command (File menu),
134

Print Preview mode, 24, 87, 174,
248

Print Setup command (File menu),
134

printing, 97, 132
landscape, scaling, 97, 98
parts, 97, 133

product support, 230, 231
program change, 22, 116, 249
punch recording, 70, 75
punch-in and punch-out, 249
punch-in and punch-out control, 75

—Q—
QSD.INI file, 214
quantization, 14, 33, 73, 94, 176,

181, 186, 249
quantize, 143
Quantize command (Note block

editing menu), 143

—R—
range, 136
RANGES.INI file, 215
Recall button, 120
Record Options command (Options

menu), 199
recording, 15, 69, 73, 198, 199, 200

tapping the beat, 71
using the Mixer, 60, 119

registration, 6, 230
rehearsal mark, 177
replacements, 229
rest levels, 178
rests, 30, 96, 176, 182, 194

—S—
Save As command (File menu), 130
Save button, 77
Save command (File menu), 130

Save Settings on Exit command
(Options menu), 207

saving your work, 20, 130
Scale command (Controller block

editing menu), 157
scaling

controllers, 157
printing, 132, 134

Score button, 87
Score command (Display menu), 183
score doesn't play, 232
Score Editor, 24–46, 80–99
Score Paper command (Display

menu, 195
Score Titles dialog, 188
Scroll Children command (Options

menu), 207
Scroll While Playing command

(Options menu), 209
Scrolling Play dialog, 207
Select Last Range command (Edit

menu), 136
Send MIDI Clock command (Options

menu), 208
sequencer, 249
sequencing, 219
service, 230
Set Marker command (Goto menu),

164
Shift command (Note block editing

menu), 142
show tempo changes, 187
slur, 88, 153

entering, 43
SMPTE, 204, 249
SMPTE command (Options menu),

204
Snap/Free button, 51, 105
Snapshot button, 120
Song Editor, 61–66, 124–26
Song Editor block editing menu,

159–61
sound card, 249
Space Music command (Display

menu), 192
spacing, 204

barlines, 34, 83, 192
bars per line, 34, 192
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notes, 83
staff, 32, 168

spacing tables, 205
spacing tool, 83
split track. See track, split
Staff command (Note block editing

menu), 144
standard MIDI file. See file, MIDI
status line, 79
staves per page, 185
stem direction, 95, 177, 180, 185
step entry, 15, 19, 28, 76, 203, 250
Step Entry button, 76
step list box, 110
step time entry. See step entry
Step/Mouse Entry Velocities

command (Options menu), 203
steps per quarter, 184
Stretch Time command

(Clef block editing menu), 155
(Controller block editing menu),

158
(Expression block editing menu),

150
(Lyric block editing menu), 149
(Note block editing menu), 148
(Symbol block editing menu), 154
(Text block editing menu), 152

symbol, 86, 250
adjustable, 88
entering, 42, 87

Symbol block editing menu, 152–54
Symbol mode, 86
symbol palette, 86
system requirements, 5

—T—
tab key, 19
tape transport, 73, 250
tapping the beat, 71
technical support, 212, 230, 231
template files, 213
templates, 128
tempo, 184

displaying, 187
Tempo button, 75
tempo symbol, 91

text. See block text
Text block editing menu, 151–52
text filter, 139
Text Filter command (Edit menu),

139
Text Number command (Text block

editing menu), 151
Thicken command (Controller block

editing menu), 157
Thin command (Controller block

editing menu), 157
tie offsets, 178
ties, 30, 96, 178
TIFF, 131
Tile command (Window menu), 211
Time command

(Goto menu), 162
(Note block editing menu), 142

time display, 74, 250
time signature, 175, 186
title, 189
titles, 32
Titles command (Display menu), 188
toolbar, 11, 81, 101, 110, 250
track, 250

creating, 69
deleting, 166
editing, 165
inserting, 166
mute, 116
name, 115
new, 166
solo, 116
split, 95, 182

Track command (Display menu), 179
track menu, 165–66
track selector, 83, 109
Track Sheet, 22, 115–17
Track Titles dialog, 188
transcription, 94
Transpose command (Note block

editing menu), 141
tremolo, 89
triplets, 14, 28, 176, 181, 186
troubleshooting, 232, 236
TrueType fonts, 250
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—U—
undo, 27, 135
Undo command (Edit menu), 135
upgrades, 229
use ascending or descending stems,

177, 180, 185
use engraver spacing, 187

—V—
velocity, 203, 251
Velocity command (Note block

editing menu), 143

version number, 212
voice, 28, 29, 95, 143
Voice command (Note block editing

menu), 143
voice palette, 84
volume, 23, 117

—W—
warranty, 229
window conventions, 8
Window menu, 210–11


